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About this book

IBM® Tivoli® Storage Manager is a client-server licensed product that provides
storage management services in a multi-platform computer environment. The
backup-archive client program permits users to back up and archive files from
their workstations or file servers to storage, and restore and retrieve backup
versions and archived copies of files to their local file systems.

In addition to the backup-archive client, Tivoli Storage Manager includes the
following components available on a variety of platforms:
v A server program that permits systems to perform as a backup and archive server

for distributed workstations and file servers. See “Related publications” on
page xi for available server publications.

v An administrative client program that you can access from a Web browser or the
command line. The program permits an administrator to control and monitor
server activities, define storage management policies for backup, archive and
space management services, and set up schedules to perform those services at
regular intervals. For more information about the Administrative client, see
“Related publications” on page xi for available Tivoli Storage Manager
Administrator’s Reference publications.

v An application program interface (API) that permits you to enhance an existing
application with storage management services. When an application is registered
with a server as a client node, the application can back up, restore, archive, and
retrieve objects from storage. For more information about the Tivoli Storage
Manager API, see IBM Tivoli Storage Manager Using the Application Programming
Interface, GC32-0793.

v A Web backup-archive client that permits an authorized administrator, help desk
person, or end user to perform backup, restore, archive, and retrieve services
using a Web browser on a remote machine.

Who should read this manual
This manual provides instructions for an end-user to install, configure, and use the
Tivoli Storage Manager client. For installation information and supported operating
system levels, see Chapter 1, “Installing Tivoli Storage Manager”, on page 1. For
configuration information, see Chapter 2, “Configuring Tivoli Storage Manager”, on
page 7.

This manual assumes that you are familiar with your workstation, your operating
system, and your basic system administration.

Technical changes to the text are indicated by vertical lines to the left of the
change.

IBM Tivoli Storage Manager Web Site
Technical support information and publications are available at the following
address:
http://www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html
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By accessing the Tivoli Storage Manager home page, you can access subjects that
interest you. You can also access current Tivoli Storage Manager product
information.

Conventions used in this book
This book uses the following typographical conventions:

Table 1. Typographical conventions

Example Description

dsmc.nlm A series of lowercase letters with an extension indicates Tivoli
Storage Manager program file names.

archive Boldface type indicates a command that you type at a
workstation, such as a command you type on a command line.

dateformat Boldface italic type indicates a Tivoli Storage Manager option.
The bold type is used to introduce the option, or used in an
example.

Occasionally, file names are entered in boldface italic for
emphasis.

filespec Italicized type indicates either the name of a parameter, a new
term, or a placeholder for information that you provide.

Italics are also used for emphasis in the text.

maxcmdretries Monospaced type represents fragments of a program or
information as it would display on a screen.

plus sign (+) A plus sign between two keys indicates you should press both
keys at the same time.

Reading syntax diagrams
This section describes how to read the syntax diagrams used in this manual. To
read a syntax diagram, follow the path of the line. Read from left to right, and top
to bottom.
v The ��─── symbol indicates the beginning of a syntax diagram.
v The ───� symbol at the end of a line indicates the syntax diagram continues on

the next line.
v The �─── symbol at the beginning of a line indicates a syntax diagram continues

from the previous line.
v The ───�! symbol indicates the end of a syntax diagram.

Syntax items, such as a keyword or variable, can be:
v On the line (required element)
v Above the line (default element)
v Below the line (optional element).
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Syntax diagram description Example

Abbreviations:

Uppercase letters denote the shortest
acceptable truncation. If an item appears
entirely in uppercase letters, it cannot be
truncated.

You can type the item in any combination of
uppercase or lowercase letters.

In this example, you can enter KEYWO,
KEYWORD, or KEYWOrd.

�� KEYWOrd �!

Symbols:

Enter these symbols exactly as they appear in
the syntax diagram.

* Asterisk
{ } Braces
: Colon
, Comma
= Equal Sign
- Hyphen
() Parentheses
. Period

Space

Variables:

Italicized lowercase items (var_name) denote
variables.

In this example, you can specify a var_name
when you enter the KEYWORD command.

�� KEYWOrd var_name �!

Repetition:

An arrow returning to the left means you can
repeat the item.

A character or space within the arrow means
you must separate repeated items with that
character or space.

A footnote by the arrow references the
number of times you can repeat the item.

�� ' repeat �!

�� '

,

repeat �!

�� '
(1)

repeat �!

Notes:

1 Specify repeat as many as 5 times.
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Syntax diagram description Example

Required choices:

When two or more items are in a stack and
one of them is on the line, you must specify
one item.

In this example, you must choose A, B, or C.

�� A
B
C

�!

Optional choice:

When an item is below the line, that item is
optional. In the first example, you can choose
A or nothing at all.

When two or more items are in a stack below
the line, all of them are optional. In the
second example, you can choose A, B, C, or
nothing at all.

��
A

�!

��
A
B
C

�!

Defaults:

Defaults are above the line. The default is
selected unless you override it. You can
override the default by including an option
from the stack below the line.

In this example, A is the default. You can
override A by choosing B or C. You can also
specify the default explicitly.

��
A

B
C

�!

Repeatable choices:

A stack of items followed by an arrow
returning to the left means you can select
more than one item or, in some cases, repeat
a single item.

In this example, you can choose any
combination of A, B, or C.

�� ' A
B
C

�!

Syntax fragments:

Some diagrams, because of their length, must
fragment the syntax. The fragment name
appears between vertical bars in the diagram.
The expanded fragment appears between
vertical bars in the diagram after a heading
with the same fragment name.

�� The fragment name �!

The fragment name:

A

B
C
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Related publications
Table 2 lists the IBM Tivoli Storage Manager client and server publications that are
referred to in this manual.

Table 2. IBM Tivoli Storage Manager client and server publications

Publication title Order number

Client publications

IBM Tivoli Storage Manager Messages GC32-0767

IBM Tivoli Storage Manager for Windows Backup-Archive Clients
Installation and User’s Guide

GC32-0788

IBM Tivoli Storage Manager for NetWare Backup-Archive Clients
Installation and User’s Guide

GC32-0786

IBM Tivoli Storage Manager for UNIX Backup-Archive Clients
Installation and User’s Guide

GC32-0789

Server publications

IBM Tivoli Storage Manager for AIX Quick Start GC32-0770

IBM Tivoli Storage Manager for HP-UX Quick Start GC32-0774

IBM Tivoli Storage Manager for Linux Quick Start GC23-4692

IBM Tivoli Storage Manager for OS/390 and z/OS Quick Start GC32-0777

IBM Tivoli Storage Manager for OS/400 PASE Quick Start GC23-4696

IBM Tivoli Storage Manager for Sun Solaris Quick Start GC32-0780

IBM Tivoli Storage Manager for Windows Quick Start GC32-0784

Downloading or ordering publications
All Tivoli publications are available for electronic download or order from the IBM
Publications Center: http://www.ibm.com/shop/publications/order/.

The Tivoli Storage Manager publications are available on the following CD-ROM:

Tivoli Storage Manager Publications Version 5.2, SK3T-8176

The format of the publications is PDF and HTML.

The International Technical Support Center (ITSC) publishes Redbooks, which are
books on specialized topics such as using Tivoli Storage Manager to back up
databases. You can order publications through your IBM representative or the IBM
branch office serving your locality. You can also search for and order books of
interest to you at the IBM Redbooks Web site at this address:
http://www.ibm.com/redbooks/

Contacting customer support
For support for this or any Tivoli product, you can contact Tivoli Customer
Support in one of the following ways:
v Visit the Tivoli Storage Manager technical support Web site at:

http://www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html
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v Submit a problem management record (PMR) electronically at
IBMSERV/IBMLINK. You can access the IBMLINK from the IBM Web site at:
http://www.ibm.com/ibmlink/

v Submit a problem management record (PMR) electronically from the Tivoli Web
site at:
http://www.ibm.com/software/support/probsub.html.

Customers in the United States can also call 1-800-IBM-SERV (1-800-426-7378).

International customers should consult the Web site for customer support
telephone numbers.

Hearing-impaired customers should visit the TDD/TTY Voice Relay Services and
Accessibility Center Web site at:http://www.ibm.com/able/voicerelay.html.

You can also review the IBM Software Support Guide, which is available on our Web
site at http://techsupport.services.ibm.com/guides/handbook.html.

When you contact IBM Software Support, be prepared to provide identification
information for your company so that support personnel can readily assist you.
Company identification information is needed to register for online support
available on the Web site.

The support Web site offers extensive information, including a guide to support
services (IBM Software Support Guide); frequently asked questions (FAQs); and
documentation for all IBM Software products, including Release Notes, Redbooks,
and white papers, defects (APARs), and solutions. The documentation for some
product releases is available in both PDF and HTML formats. Translated
documents are also available for some product releases.

We are very interested in hearing about your experience with Tivoli products and
documentation. We also welcome your suggestions for improvements. If you have
comments or suggestions about our documentation, please complete our customer
feedback survey at:
http://www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html

by selecting the Feedback link in the left navigation bar.

Reporting a problem
Please have the following information ready when you report a problem:
v The Tivoli Storage Manager server version, release, modification, and service

level number. You can get this information by entering the query status
command at the Tivoli Storage Manager command line.

v The Tivoli Storage Manager client version, release, modification, and service
level number. You can get this information by entering dsmc at the command
line.

v The communication protocol (for example, TCP/IP), version, and release number
you are using.

v The activity you were doing when the problem occurred, listing the steps you
followed before the problem occurred.

v The exact text of any error messages.
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Internet
You can get additional information through an anonymous FTP server,
ftp://ftp.software.ibm.com. IBM Tivoli Storage Manager information is in the
/storage/tivoli-storage-management directory.

A newsgroup, listserv@marist.edu, is implemented by a third party. IBM supports
this newsgroup on a best-effort basis only. See “Online forum” on page 23 for more
information.
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Chapter 1. Installing Tivoli Storage Manager

The Tivoli Storage Manager backup-archive client helps you protect information on
your workstation. Using Tivoli Storage Manager, you can maintain backup versions
of your workstation files that you can restore if the original files are damaged or
lost. You can also archive workstation files that you do not currently need, or
preserve them in their current state, and retrieve them when necessary.

Attention: On Macintosh OS X, you must have a system administrator ID and
password to perform Tivoli Storage Manager tasks.

You can use the Tivoli Storage Manager graphical user interface (GUI) to perform
tasks. The main window displays buttons labeled: Backup, Restore, Archive, and
Retrieve. To initiate a task, click on the appropriate button.

This chapter provides migration, environment, and installation information for the Tivoli
Storage Manager client. After installation, see Chapter 2, “Configuring Tivoli Storage
Manager”, on page 7 for required configuration tasks to perform before using Tivoli Storage
Manager.

Migrating from earlier versions

Upgrade path for clients and servers
As part of a migration plan from Tivoli Storage Manager version 5.1 to Tivoli
Storage Manager version 5.2, Tivoli Storage Manager clients and servers can be
upgraded at different times. To help prevent disruption to your backup and
archive activities during the migration, note the following:
v A Tivoli Storage Manager version 5.1 client can perform backup, restore, archive,

and retrieve functions to a Tivoli Storage Manager version 5.2 server.
v A Tivoli Storage Manager version 5.2 client can perform backup, restore, archive,

retrieve, and query functions to a Tivoli Storage Manager version 5.1 server.
v A Tivoli Storage Manager V5.1 client can perform V3.1 functional level backup,

restore, archive and retrieve functions to a Tivoli Storage Manager Version 3.1
server on VM.

v Data that has been backed up or archived from a Tivoli Storage Manager version
5.2 client to any Tivoli Storage Manager server can be restored or retrieved using
a Tivoli Storage Manager version 5.1 client, except for Unicode file systems
backed up or queried by the version 5.2 Macintosh client.

v Data that has been backed up or archived from a Tivoli Storage Manager version
5.1 client to any Tivoli Storage Manager server can be restored or retrieved using
a Tivoli Storage Manager version 5.2 client.

Migrating to the Unicode-enabled client
Unicode is a universal character encoding standard that supports the interchange,
processing, and display of text that is written in any of the languages of the
modern world. Unicode-enabled file spaces provide support for multi-lingual
workstations without regard for the current locale. Beginning with Tivoli Storage
Manager version 5.2, the Macintosh client is Unicode enabled. The
Unicode-enabled client supports Unicode for file, directory, and file space names.
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Benefits of using the Unicode-enabled client
v If you back up or archive objects with a Unicode-enabled client, you can restore

or retrieve these objects with a Unicode-enabled client in any other supported
language environment. For example, a Japanese Unicode-enabled client can
restore files backed up by German Unicode-enabled client.

v The Unicode-enabled client is cross language, meaning that it works with files
using different code pages. The Unicode-enabled client can handle a mixture of
files from different code pages or locales in the same file space.

v Without the support for storing Unicode-enabled file spaces, some earlier
Macintosh clients have experienced backup failures. This occurs when file spaces
contain names of directories or files in multiple languages or have names that
cannot be converted to the client’s current code page.

How to migrate to the Unicode-enabled client
To migrate to the Unicode-enabled version 5.2 client, the server must be a version
4.2.0 or later level. New clients storing data on the server for the first time require
no special set up. In this case, the server automatically stores data in
Unicode-enabled file spaces. However, if your client already stores data on the
server, you need to plan for the migration of your file spaces to Unicode-enabled
file spaces. This involves renaming your file spaces on the server and creating new
Unicode-enabled file spaces on the server using the autofsrename option.

The administrator can specify three possible values using the server autofsrename
option: yes, no, or client. Note that the server setting for this option overrides the
setting on the client.
v If the server specifies no, the existing file spaces for your node are not renamed

or Unicode enabled, even if you have a Unicode-enabled client installed.
v If the server specifies yes, and the client performs an incremental backup with

domain=all-local, all file spaces specified in the current operation that are not
Unicode enabled are renamed. The Unicode-enabled client then creates new
Unicode-enabled file spaces.
If the client performs a selective backup, only the file spaces you specify in the
current operation are renamed and Unicode enabled.

v If the server specifies client, the client can set the autofsrename option in the
TSM System Preferences file to prompt, yes, or no. If the client sets the option to
no, the file spaces that are not Unicode enabled are not renamed and are not
Unicode enabled. If the client specifies prompt, the client prompts you whether to
rename file spaces. The client prompts you only once to rename a particular file
space.

Optionally, your administrator can rename the file spaces on the server that are not
Unicode enabled.

For options and results when using the autofsrename option, see the table below.

Server option Client option Result

Yes Prompt, Yes, No Renamed

No Prompt, Yes, No Not Renamed

Client No Not Renamed

Client Yes Renamed

Client Prompt Based on User Response

2 IBM Tivoli Storage Manager for Macintosh: Backup-Archive Clients Installation and User’s Guide

|
|
|
|
|

|
|
|

|
|
|
|

|
|
|
|
|
|
|
|

|
|
|

|
|

|
|
|
|

|
|

|
|
|
|
|
|

|
|

|

||||

|||

|||

|||

|||

|||
|



For detailed information about the autofsrename option, see “Autofsrename” on
page 67. For additional information about working with the Macintosh clients, see:
v “Considerations for Unicode-enabled clients” on page 13
v “Inclexcl” on page 85

Considerations for migrating to the Unicode-enabled client
When migrating to the Tivoli Storage Manager Macintosh OS X client, please
consider the following:
1. To support Unicode functionality, the Macintosh OS X Unicode-enabled client

must connect to a version 4.2.0 or higher server.
2. Ensure that you install the fonts for the languages you want to display. If you

do not have the necessary fonts installed, the file names and archive
descriptions may not display properly. However, the Unicode-enabled clients
can still back up, restore, archive, and retrieve the files and directories.

3. The name of the Unicode-enabled file space may be unreadable if the server
cannot display the Unicode name. In this case, use the file space identifier
(fsID) of the file space to identify these file spaces on the server. On the GUI
main window, select the File details option from the View menu to display
the fsID of a file space.

4. After installing a Unicode-enabled client, we recommend that you perform a
full incremental backup to rename all existing file spaces that are not Unicode
enabled and back up the files and directories within them under the new
Unicode-enabled file spaces.

5. Renamed file spaces remain on the server and managed as stabilized file
spaces. These file spaces contain all the original data, which can still be restored until
the file spaces are deleted.

6. When an existing file space is renamed during Unicode conversion, any access
rules defined for the file space remain applicable to the original file space.
However, new access rules must be defined to apply to the new Unicode file
space, if necessary.

7. The server stores information about each node, and once a node logs onto the
server using a Unicode-enabled client, the node cannot log on with a version
of the client that does not support Unicode. The server allows only a
Unicode-enabled client to restore files from a Unicode-enabled file space.

8. When backing up files to a file space that is not Unicode enabled, the
Unicode-enabled client skips the files and directories with names containing
characters from a code page other than the current locale.

9. If files and directories with names containing characters from a code page
other than the current locale were previously backed up with a client that was
not Unicode enabled, Tivoli Storage Manager will expire them in the file space
that is not Unicode enabled. However, the Unicode-enabled client can back up
or archive these files to a Unicode-enabled file space.

10. When migrating from a client that is not Unicode enabled to a Unicode client,
file names with double-byte characters mixed with single-byte characters may
be restored in mixed single-byte character set (SBCS) format. This is only a
display issue.

11. When a client performs a selective backup of an object and the original file
space is renamed, the new Unicode-enabled file space contains only that
object. Tivoli Storage Manager will back up all other directories and file spaces
during the next full incremental backup.
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Macintosh client environment requirements
This section contains client environment information, Tivoli Storage Manager client
components, and hardware and software requirements for the Macintosh client.

Attention: For current information concerning the client environment
prerequisites for all Tivoli Storage Manager supported client platforms, refer to the
README file that is shipped on the product installation media or go to the Web site
at:
http://www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html

Client components
v Backup-archive client (GUI)

Hardware requirements
v Any PowerBook or Power Macintosh personal computer (G3 or higher)
v Disk space: see the README file that is shipped on the product installation

media.
v Memory: 128 MB for Macintosh OS X.1.5 or higher

Software requirements
v Macintosh OS X.1.5 or higher

Communications method

To use this
communication
method:

Install this software: To connect to these
Tivoli Storage
Manager servers:

TCP/IP Sockets for Mac X, which comes standard
with the OS.

AIX, HP-UX, Linux,
OS/390, OS/400
PASE, Solaris, VM,
Windows, z/OS

Installing the Macintosh client program (required)
The Tivoli Storage Manager Macintosh client is included on the desktop client
installation CD-ROM in the tsmcli/mac directory structure.

You can display online startup information, product manuals, and README files.
On a Web browser:
1. Click File and then click Open File.
2. Select the CD-ROM drive.
3. Select the START.HTM file.

To install the Tivoli Storage Manager Macintosh client, you must be a system
administrator. During the installation, TSM Backup Help is added to the Mac Help
Center. The first time Tivoli Storage Manager is run, the preference folder: <Startup
Disk>:Library:Preferences:Tivoli Storage Manager (where <Startup Disk> is the
name of the current startup disk) is created.

Preparing for installation from the client CD-ROM
To prepare for installation from the client CD-ROM, follow these steps:
1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click on the CD-ROM icon.
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3. Go to the clients:mac folder.
4. Drag the file tsminst.hqx directly from the CD-ROM to your hard drive. If you

FTP the file from another workstation that has mounted the CD-ROM, ensure it
is transferred in ASCII mode.

5. Locate a BinHex converter. The Tivoli Storage Manager Macintosh installation
file is stored in BinHex format. You must convert this file before installation by
using a BinHex translator. Programs such as Stuffit Deluxe and Compact Pro
can convert the files. Also, a freeware program called BinHex 4.0 can be found
at most major FTP sites (including ftp.apple.com) and from online services,
such as CompuServe and America Online.

6. Use the BinHex translator and choose the HQX file located on your hard drive.
Save the converted file to your hard drive. An installation program called TSM
Installer is created on your hard drive after you finish the BinHex conversion.

Installing the program
To install the program, follow these steps:
1. Double-click on the TSM Installer program icon.
2. When the Tivoli Storage Manager installation window appears, click on the

Continue button.
3. When the README file appears, read through the file to learn about recent

updates and product changes. You can print this file for later reference by
clicking on the Print button. When you have finished reading this file, click on
the Continue button.

4. The TSM Backup Standard Install window displays:
a. Select Install to install the standard installation package which includes the

Tivoli Storage Manager Backup Program.
b. Select Custom if you want to customize the standard installation package.

5. Decide where you want to store the Tivoli Storage Manager files, and type the
desired folder name in the installation folder field in the installation window.
Tivoli Storage Manager is the default folder. If you choose a folder name that
is not already listed, a new folder is created for you. Click on the Install button
to begin the installation process.

6. You are asked whether you want the Tivoli Storage Manager scheduler daemon
to start automatically when you start your system:
v If you select Yes, Tivoli Storage Manager automatically places an alias

scheduler daemon in your startup folder.
v If you select No, see Chapter 7, “Automating tasks”, on page 45 for more

information about starting the Tivoli Storage Manager scheduler after
installation.

Note: You will not be prompted to set up the daemon to start automatically.
See Chapter 7, “Automating tasks”, on page 45 for instructions on how to
start the daemon automatically at login time

7. After installation completes, you are asked if you want to quit, restart if you
are finished, or perform further installations. After installation, see Chapter 2,
“Configuring Tivoli Storage Manager”, on page 7 for required configuration
tasks to perform before using Tivoli Storage Manager.

Notes:

1. During the installation TSM Backup Help is added to the Mac Help Center.
2. The first time you run Tivoli Storage Manager, the preference folder is placed in

the following path:
<Startup Disk>:Library:Preferences:Tivoli Storage Manager
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where <Startup Disk> is the name of the current startup disk. The permissions
on this folder are set to 775. To edit this file, you may need to change the file
permissions in a terminal window using the following command:
sudo chmod 774 <filename>

Updating a previously installed version of Tivoli Storage
Manager
To update a previously installed version of Tivoli Storage Manager, navigate to the
folder that contains the Tivoli Storage Manager folder, then enter the name of the
folder where the Tivoli Storage Manager files reside in the installation folder field
in the installation window. The installer installs the updated files into this folder
and overwrites the old Tivoli Storage Manager files, but does not replace any
existing preferences files. Click on the Install button to begin the automatic
installation update process.

Note: There is no automated process to assist with importing your options from a
previous version of Tivoli Storage Manager. It might be easier to open the
old option file in a text editor, then use the Configuration Assistant and the
Preference editor to set the options to the values in the old preference file.

Tivoli Storage Manager server installation and configuration
The Tivoli Storage Manager clients work in conjunction with the Tivoli Storage
Manager server. Contact your Tivoli Storage Manager administrator to obtain client
access to the Tivoli Storage Manager server, or refer to the following publications
to install and configure a Tivoli Storage Manager server:

Table 3. Tivoli Storage Manager server Quick Start publications

Publication title Order number

IBM Tivoli Storage Manager for AIX Quick Start GC32-0770

IBM Tivoli Storage Manager for HP-UX Quick Start GC32-0774

IBM Tivoli Storage Manager for Linux Quick Start GC23-4692

IBM Tivoli Storage Manager for OS/390 and z/OS Quick Start GC32-0777

IBM Tivoli Storage Manager for OS/400 PASE Quick Start GC23-4696

IBM Tivoli Storage Manager for Sun Solaris Quick Start GC32-0780

IBM Tivoli Storage Manager for Windows Quick Start GC32-0784
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Chapter 2. Configuring Tivoli Storage Manager

After installation, required configuration tasks include the following:

Task Page

Creating and modifying the system preferences file (required) 7

Creating and modifying a user preferences file (required) 8

Registering your workstation with a server (required) 11

Optional configuration tasks include the following:

Task Page

Creating an include-exclude list (optional) 11

Creating multiple user preferences files (optional) 19

Attention: For current information concerning the client configuration for all
Tivoli Storage Manager supported client platforms, refer to the README file that is
shipped on the product installation media.

On Macintosh OS X, you must have a system administrator ID and password to perform
Tivoli Storage Manager tasks.

Creating and modifying the system preferences file (required)
During installation, Tivoli Storage Manager provides a sample System Preferences
file called TSM System Preferences-Sample. Use this file to specify one or more
servers to contact for services, and the communications options for each server.
This file can also include authorization options, backup and archive processing
options, and scheduling options.

By default, Tivoli Storage Manager places the TSM System Preferences-Sample file
in the TSM Application folder (the location where the Tivoli Storage Manager
client was installed). You can copy and rename the TSM System
Preferences-Sample file to TSM System Preferences and leave this file in the TSM
Application folder.

If you use the Tivoli Storage Manager Setup Assistant to create the TSM System
Preferences file, this file is created in the following location:
<Startup Disk>:Library:Preferences:Tivoli Storage Manager

where <Startup Disk> is the name of the current startup disk.

If the TSM System Preferences file exists in both the TSM Application folder and
the path created by the Tivoli Storage Manager Setup Assistant, the TSM System
Preferences file created by the Setup Assistant takes precedence.

If you are a system administrator, you can modify the required options in your
TSM System Preferences file according to your needs. The following options are
required to establish communication with a Tivoli Storage Manager server:
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SErvername server1
COMMMethod TCPip
TCPPort 1500
TCPServeraddress node.domain.company.com

See Chapter 9, “Using processing options”, on page 59 for more information about
these options.

Use one of the following methods to modify the TSM System Preferences file:
v Click Utilities → Setup Assistant from the Tivoli Storage Manager client GUI.
v Click Edit → Preferences from the Tivoli Storage Manager client GUI.
v Use your favorite text editor. Ensure that you save the file as plain text. See

“Setting options in a preferences file” on page 10 for information on how to set
options in the TSM System Preferences file.

Notes:
1. If you want to edit the TSM System Preferences file located in <Startup

Disk>:Library:Preferences:Tivoli Storage Manager, you may need to change
the file permissions in a terminal window using the following command:
sudo chmod 774 <filename>

2. The TSM System Preferences file must be a plain text file. By default,
TextEdit does not save files as plain text. Select Format → Make PlainText to
save the TSM System Preferences file as a plain text file. Do not add the .txt
extension.

3. If you enter an invalid option in a Preferences file, you cannot use the Setup
Assistant or the Preference editor to remove the invalid option. You can
remove the invalid option using a text editor.

If you update the TSM System Preferences file during a session, you must restart
the client to pick up the changes.

See “Setting options in a preferences file” on page 10 for information on how to set
options in the TSM System Preferences file.

Creating and modifying a user preferences file (required)
During installation, Tivoli Storage Manager provides a sample User Preferences file
called TSM User Preferences-Sample. By default, Tivoli Storage Manager places the
TSM User Preferences-Sample file in the TSM Application folder (the location
where the Tivoli Storage Manager client was installed). You can copy and rename
the TSM User Preferences-Sample file to TSM User Preferences and leave this file
in the TSM Application folder.

If you use the TSM Setup Assistant to create the TSM User Preferences file, this file
is created in the following location:
<Startup Disk>:Library:Preferences:Tivoli Storage Manager

where <Startup Disk> is the name of the current startup disk.

If the TSM User Preferences file exists in both the TSM Application folder and the
path created by the Tivoli Storage Manager Setup Assistant, the TSM User
Preferences file created by the Setup Assistant takes precedence.

If you are a system administrator, you can modify the TSM User Preferences file
according to your needs. This file can contain the following options:
v Communication options
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v Backup and archive processing options
v Restore and retrieve processing options
v Scheduling options
v Format and language options
v Authorization options
v Error processing options
v Transaction processing option

See Chapter 9, “Using processing options”, on page 59 for more information about
these options.

Use one of the following methods to modify the TSM User Preferences file:
v Click Utilities → Setup Assistant from the Tivoli Storage Manager client GUI.
v Click Edit → Preferences from the Tivoli Storage Manager client GUI.
v Use your favorite text editor. Ensure that you save the file as plain text. See

“Setting options in a preferences file” on page 10 for information on how to set
options in the TSM User Preferences file.

Notes:
1. If you want to edit the TSM User Preferences file located in <Startup

Disk>:Library:Preferences:Tivoli Storage Manager, you may need to change
the file permissions in a terminal window using the following command:
sudo chmod 774 <filename>

2. The TSM User Preferences file must be a plain text file. By default, TextEdit
does not save files as plain text. Select Format → Make PlainText to save the
TSM User Preferences file as a plain text file. Do not add the .txt extension.

If you update the TSM User Preferences file during a session, you must restart the
client to enable the changes.

Considerations:
v The TSM User Preference file contains type and creator codes which allow Tivoli

Storage Manager to be launched by dragging and dropping the file on the Mac
OS X Backup application.

v Double clicking on the TSM User preference file will start the TSM Backup
application. Tivoli Storage Manager will start, but will respond that you must
use the Mac OS X Backup application. Double clicking will work as expected
only if the root user account is enabled and logged on.

v To maintain the drag-n-drop functionality, the TSM User Preference creator code
must be retained. Using TextEdit to modify the TSM User Preference file will
cause the creator code to be removed. You can use SimpleText successfully edit
the file and retain the creator code. SimpleText is a Classic application. Most
commercially available editors will also preserve the creator code.

v The Developers Tools CD that comes with Mac OS X has a Mac OS X version of
SimpleText. You can use this version of SimpleText to edit the preference files
without converting them to plain text. Unfortunately, this will cause the
drag-n-drop functionality to be lost. To install the Developers Tools, double click
on the Developer.pkg file and follow the on-screen instructions. SimpleText is
installed in the Developer:Examples:Carbon directory.

v TSM User Preference files that you create using the Setup Assistant have the
creator code. If the creator code is ever removed from your preference file,
rename your existing file, use the setup assistant to create a new one, then use a
text editor to replace the contents of the new file with your original preferences.

v From a terminal window, you can use vi or pico to edit the preference files.
Either of these editors will show the line endings as ^m characters. The ^m
character can be replaced by deleting the character and making a new line.

Chapter 2. Configuring Tivoli Storage Manager 9

|

|
|
|

|
|
|
|

|
|
|
|
|

|
|
|
|
|
|

|
|
|
|

|
|
|



However, this will cause the line endings to show up as odd characters in
SimpleText. Tivoli Storage Manager will handle preference files edited with vi or
pico line endings.

See “Setting options in a preferences file” for information on how to set options in
the TSM User Preferences file.

Setting options in a preferences file
This section describes how to set options in your TSM System Preferences file or
TSM User Preferences file.

Notes:

1. If you want to edit the TSM User Preferences file located in <Startup
Disk>:Library:Preferences:Tivoli Storage Manager (where <Startup Disk> is the
name of the current startup disk), you may need to change the file permissions
in a terminal window using the following command:
sudo chmod 774 <filename>

2. The TSM System Preferences file must be a plain text file. By default, TextEdit
does not save files as plain text. Select Format → Make PlainText to save the
TSM System Preferences file as a plain text file. Do not add the .txt extension.

To set an option in this file, enter the option name and one or more blank spaces,
followed by the option value. For example:

compression yes
nodename client_a

Some options consist of only the option name, such as verbose and quiet. You can
enter the entire option name or its abbreviation. For example, you can specify the
verbose option as either of the following:

verbose
ve

Follow these additional rules when entering options in your Preferences file:
v Do not enter comments on the same line as an option.
v Indent options with spaces or tabs.
v Begin each comment with an asterisk (*) as the first character in a line.
v Enter each option on a separate line and enter all parameters for an option on

the same line. For example, to specify two different volumes as your default
client domain, you could enter the following:

domain "La Pomme" "Macintosh HD"
v Enter one or more blank spaces between parameters.
v Use blank lines between options.
v The maximum number of characters in a file name is 255. The maximum

combined length of the file name and path name is 1024 characters. Long file
name support is provided while running Tivoli Storage Manager on Macintosh
X. The maximum length of a file name is limited to 504 bytes (not characters).
Because the Unicode representation of a character may occupy several bytes, the
maximum number of characters that a file name may contain can vary.

If you update the Preferences file while a GUI session is active, you must restart
the client to pick up the changes.
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Registering your workstation with a server (required)
Before you can use Tivoli Storage Manager, your client must be registered with the
server. The process of setting up a node name and password is called registration.
There are two types of registration: open and closed. Your administrator chooses the
type of registration for your site.

Using closed registration
With closed registration, an administrator must register your workstation as a
client node with the server. If your enterprise uses closed registration, you must
provide the following information to your Tivoli Storage Manager administrator:
v Your node name (the name of your workstation or the node name you specified

with the nodename option).
v The initial password you want to use, if required.
v Contact information, such as your name, user ID, and phone number.

In addition to possibly defining certain options in your Preferences file, your
administrator defines the following for you:
v The policy domain to which your client node belongs. A policy domain contains

policy sets and management classes, defined by your administrator, that control
how Tivoli Storage Manager manages the files you back up and archive.

v Whether you can compress files before sending them to the server.
v Whether you can delete backup and archive data from server storage.

Using open registration
With open registration, you can register your workstation as a client node with the
server.

The first time you start a session, Tivoli Storage Manager prompts you for
information necessary to register your workstation with the server identified in
your TSM User Preferences file. You need to supply your node name, a password,
and contact information.

When you use open registration:
v Your client node is assigned to a policy domain named standard.
v You can define whether or not to compress files before sending them to the

server. See “Compression” on page 74 for more information about the
compression option.

v You can delete archived copies of files from server storage, but not backup
versions of files.

If necessary, your administrator can change these defaults later.

Creating an include-exclude list (optional)
This is an optional task but an important one. If you do not create an
include-exclude list, Tivoli Storage Manager considers all files for backup services
and uses the default management class for backup and archive services. For
information on management classes and policy domains, see Chapter 8,
“Understanding storage management policies”, on page 49.

You can create an include-exclude list to exclude a specific file or groups of files
from backup services, and to assign specific management classes to files. Tivoli
Storage Manager backs up any file that is not explicitly excluded. You should
exclude Tivoli Storage Manager client folders from backup services.
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Attention: There are some system files that you should exclude. See “Excluding
system files” on page 15 for more information.

Specify your include-exclude list in your TSM System Preferences file. If you
define more than one server in your TSM System Preferences file, each server must
have its own include-exclude list. The include-exclude list can also go into a
separate file, which is pointed to by the inclexcl option.

The TSM System Preferences file must be in a non-Unicode format. However, if
you are using a separate include-exclude file, it can be in Unicode or non-Unicode
format. If you specify a non-Unicode include-exclude file, the file must be in the
same code page that the client is running. For example, a non-Unicode
include-exclude file on an English Macintosh system cannot contain Japanese
characters.

When the client processes include-exclude statements, the include-exclude
statements within the include-exclude file are placed at the position occupied by
the inclexcl option in TSM System Preferences file, in the same order, and
processed accordingly.

See “Inclexcl” on page 85 for detailed information about specifying an
include-exclude file using the inclexcl option.

You can use the following method to create an include-exclude list or specify an
include-exclude file:
1. From the client GUI, open the Edit menu and select Preferences.
2. In the Preferences dialog, click the Include/Exclude section.

Note: You can specify a Unicode file as an include-exclude file using the
Preferences editor. However, you cannot create the Unicode file using the
Preferences editor. See “Considerations for Unicode-enabled clients” on
page 13 for instructions on creating a Unicode include-exclude file.

You can also create an include-exclude list by performing the following steps:
1. Determine your include and exclude requirements.
2. Open your TSM System Preferences file with SimpleText or another Macintosh

text editor.
3. Locate the server stanza in your TSM System Preferences file.
4. Enter your include and exclude statements using the appropriate

include-exclude options as described in “Using include-exclude options” on
page 13. Because Tivoli Storage Manager processes your include-exclude list
from the bottom of the list up, it is important to enter all your include-exclude
statements in the proper order. For example, in the following include-exclude
list the includefile.cpp file is not backed up:
include "La Pomme:Documents:includefile.cpp"
exclude "La Pomme:Documents:...:*"

However, in the following include-exclude list the includefile.cpp file is
backed up:
exclude "La Pomme:Documents:...:*"
include "La Pomme:Documents:includefile.cpp"

5. Save the file and close it. Ensure that you save the file as plain text. Do not add
the .txt extension.
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6. Restart your Tivoli Storage Manager client to enable your new TSM System
Preferences file.

You can specify a separate include-exclude file using the inclexcl option. The file
can be located in any directory to which all users on your workstation have read
access. See “Inclexcl” on page 85 for more information.

Considerations for Unicode-enabled clients
The include-exclude file can be in Unicode or non-Unicode format. If you specify a
non-Unicode include-exclude file, that file must be in the same code page the client
is running. For example, a non-Unicode include-exclude file on an English
Macintosh system can not contain Japanese characters.

A Unicode include-exclude file provides the following benefits:
v Names with characters from another code page no longer have to be wildcarded.
v File names and directories from any code page can be fully specified for the

Unicode-enabled client to process.

To create an include-exclude file in Unicode format, perform the following steps:
1. Open a text editor.
2. Enter your include and exclude statements using the appropriate

include-exclude options in “Using include-exclude options”.
3. Click File and then click Save As. The Save As window displays.
4. Select the Save as Unicode check box, specify the file and target directory, and

save the file.
5. Place an inclexcl option specifying the include-exclude file you just created in

your TSM System Preferences file.
6. Restart the Tivoli Storage Manager client.

Using include-exclude options
This section provides the following information:
v Brief descriptions of the include and exclude options that you can specify in your

TSM System Preferences file. See table references for more information about
each option.

v A minimum include-exclude list that excludes system files.
v A list of supported wildcard characters that you can use to include or exclude

groups of files for processing.
v Examples of how you might use wildcard characters with include and exclude

patterns.

Excluding directories
Use exclude.fs and exclude.dir statements to exclude all files and sub-directories in
the specified directory from processing. Tivoli Storage Manager evaluates all
exclude.fs and exclude.dir statements first (regardless of their position within the
include-exclude list), and removes the excluded file spaces, directories, and files
from the list of objects available for processing. The exclude.fs and exclude.dir
statements override all include statements that match the pattern.

Chapter 2. Configuring Tivoli Storage Manager 13

|
|
|

|

|
|
|
|

|
|
|
|

|
|
|
|
|
|
|
|
|
|



Table 4. Options for excluding file Spaces and directories

Option Description Page

exclude.fs Excludes file spaces matching the pattern. The client does not
consider the specified file space for processing and the usual
deleted-file expiration process cannot occur. If you exclude a
file space that was previously included, existing backup
versions remain on the server subject to retention rules
specified in the associated management class definition. See
“Exclude options” on page 81 for more information.

81

exclude.dir Excludes a directory, its files, and all its subdirectories and
their files from backup processing. For example, the statement
exclude.dir test:dan:data1 excludes the test:dan:data1 directory,
its files, and all its subdirectories and their files.

81

Controlling backup and archive processing
After Tivoli Storage Manager evaluates all exclude.fs and exclude.dir statements,
the following options are evaluated against the remaining list of objects available
for processing.

If you exclude an object that was previously included, Tivoli Storage Manager
marks existing backup versions inactive during the next incremental backup.

Table 5. Options for controlling backup and archive processing

Option Description Page

Backup processing

exclude
exclude.backup
exclude.file
exclude.file.backup

These options are equivalent. Use these options to exclude
a file or group of files from backup services.

81

include
include.backup
include.file

These options are equivalent. Use these options to include
files or assign management classes for backup
processing.

87

Archive processing

exclude.archive Excludes a file or group of files from archive services. 81

include
include.archive

These options are equivalent. Use these options to include
files or assign management classes for archive
processing.

87

Controlling compression processing
After Tivoli Storage Manager evaluates exclude.fs, exclude.dir and any other
include-exclude options controlling backup and archive processing, it uses the
following options to determine which files undergo compression processing.

Table 6. Options for controlling compression processing

Option Description Page

Compression processing

exclude.compression Excludes files from compression processing if
compression=yes is specified. This option applies to
backups and archives.

81

include.compression Includes files for compression processing if
compression=yes is specified. This option applies to
backups and archives.

87
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Excluding system files
The Tivoli Storage Manager client will add the following exclude statements to the
include-exclude list in your TSM System Preferences file:

exclude.archive "...:Desktop DB"
exclude.backup "...:Desktop DB"
exclude.archive "...:Desktop DF"
exclude.backup "...:Desktop DF"
exclude.backup ":Volumes:...:*"
exclude.archive ":Volumes:...:*"
exclude.archive "<Startup Disk>:.vol"
exclude.backup "<Startup Disk>:.vol"
exclude.archive "<Startup Disk>:automount"
exclude.backup "<Startup Disk>:automount"
exclude.archive "<Startup Disk>:dev"
exclude.backup "<Startup Disk>:dev"
exclude.archive "<Startup Disk>:Network:Servers"
exclude.backup "<Startup Disk>:Network:Servers"
exclude.archive "<Startup Disk>:.vol:...:*"
exclude.backup "<Startup Disk>:.vol:...:*"

where <Startup Disk> will be replaced with the name of the current startup disk.

In addition, we recommend that you have the following minimum include-exclude
list in your TSM System Preferences file:

Exclude ...:.TheInvisiblePropertyStore
Exclude ...:DeskTop
Exclude ...:etc
Exclude ...:OpenFolderListDF
Exclude ...:TheFindByContentIndex
Exclude ...:tmp
Exclude ...:var
Exclude ...:Wastebasket:...:*
Exclude "...:Norton FileSaver Data"
Exclude "...:Norton VolumeSaver Data"
Exclude "...:Norton VolumeSaver Index"
Exclude "...:VM Storage"
Exclude "...:...:TSM Sched*"
Exclude "...:...:TSM Error*"
Exclude.dir "...:System Folder:Preferences:netscape A:Cache A"
Exclude.dir "...:System Folder:Preferences:Explorer:Temporary Files"
Exclude.dir "...:Desktop Folder"
Exclude.dir "...:System Folder:Preferences:netscape users:...:Cache"
Exclude.dir ...:.Trashes
Exclude.dir ...:System Folder:Preferences:cache-cache
Exclude.dir ...:Trash
Exclude.dir ...:TheFindByContentFolder
Exclude.dir ...:TheVolumeSettingsFolder
Exclude.dir ...:Volumes
Exclude.dir ...:Library:Caches

These are system files that cannot be recovered without possibly corrupting the
operating system, or temporary files with data that you can easily recreate.

Including and excluding groups of files
To specify groups of files that you want to include or exclude, use the wildcard
characters listed in Table 7 on page 16. This table applies to include and exclude
statements only.

Note: A very large include-exclude list may decrease backup performance. Use
wildcards and eliminate unnecessary include statements to keep the list as
short as possible.
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Table 7. Wildcard and other special characters

Character Function

? The match one character matches any single character except the folder
separator; it does not match the end of the string. (See “Matchonechar” on
page 93.) For example:

v The pattern ab?, matches abc, but does not match ab, abab, or abzzz.

v The pattern ab?rs, matches abfrs, but does not match abrs, or abllrs.

v The pattern ab?ef?rs, matches abdefjrs, but does not match abefrs, abdefrs,
or abefjrs.

v The pattern ab??rs, matches abcdrs, abzzrs, but does not match abrs, abjrs,
or abkkkrs.

* The match-all character. For example:

v The pattern ab*, matches ab, abb, abxxx, but does not match a, b, aa, bb.

v The pattern ab*rs, matches abrs, abtrs, abrsrs, but does not match ars, or
aabrs, abrss.

v The pattern ab*ef*rs, matches abefrs, abefghrs, but does not match abefr,
abers.

v The pattern abcd.*, matches abcd.c, abcd.txt, but does not match abcd,
abcdc, or abcdtxt.

...: Matches all volumes or folders. For example:

...:...:*

matches any file in any folder on any volume. The first group specifies the
volume and the second group specifies the folder.
Note: This consists of three periods followed by a colon, not an ellipsis
followed by a colon.

: The volume or folder separator. It limits the scope of search for matching all
characters and matching all volumes.

[ The open character-class character begins the enumeration of a character class.
For example:

xxx[abc] matches xxxa, xxxb, or xxxc.

– The character-class range includes characters from the first character to the
last character specified. For example:

xxx[a-z] matches xxxa, xxxb, xxxc, ... xxxz.

Note: For ASCII machines such as the Macintosh, characters represented by
the hexadecimal codes of 61 (a) through 7A (z) will match. If the last character
in the range is less than the first, only the first is used.

\ The literal escape character. When used within a character class, it treats the
next character literally. When used outside of a character class, it is not
specially treated.

] The close character-class character ends the enumeration of a character class.

Examples using wildcards with include and exclude patterns
Table 8 contains examples of ways you might use wildcard characters with include
and exclude patterns.

Table 8. Using wildcard characters with include and exclude patterns

Task Pattern

Exclude all files that end with doc, except
those found on volume La Pomme in the
Documents folder.

exclude ...:...:*doc
include "La Pomme:Documents:*doc"
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Table 8. Using wildcard characters with include and exclude patterns (continued)

Task Pattern

Exclude all files and folders under any
Documents folder that might exist, except for
the file La Pomme:Documents:Current Resume.
Include this file.

exclude ...:...:Documents:...:*
include "La Pomme:Documents:
Current Resume"

Exclude any .cpp file in any folder on the
Vol1, Vol2, Vol3, and Vol4 volumes.

exclude "Vol[1-4]:...:*.cpp"

Exclude the .cpp files found in the root
folder of the Vol2 volume.

exclude Vol2:*.cpp

Exclude any file found on any volume that
resides under the Development folder.

exclude ...:Development:...:*

Exclude a single file system from backup
processing.

exclude.fs home:

Exclude all file systems mounted anywhere
in the HFS+:svt1:fs01 and HFS+:svt1:fs02
directory tree from backup processing.

exclude.fs HFS+:svt1:*
exclude.fs HFS+:svt1:...:*

Processing include and exclude options
The Tivoli Storage Manager server can define include-exclude options using the
inclexcl parameter in a client option set. The include-exclude statements specified
by the server are evaluated along with those in the TSM System Preferences file.
The server include-exclude statements are always enforced and placed at the
bottom of the include-exclude list and evaluated before the client include-exclude
statements.

When performing an incremental backup, Tivoli Storage Manager evaluates all
exclude.fs and exclude.dir statements first, and removes the excluded file spaces,
directories, and files from the list of objects available for processing. See
“Excluding directories” on page 13 and “Exclude options” on page 81 for more
information about the exclude.fs and exclude.dir options.

After evaluating all exclude.fs and exclude.dir statements, Tivoli Storage Manager
evaluates the include-exclude list from the bottom up and stops when it finds an
include or exclude statement that matches the file it is processing. The order in
which the include and exclude options are entered therefore affects which files are
included and excluded. See Chapter 9, “Using processing options”, on page 59 for
more information about the order in which all options are processed.

The client program processes the include and exclude options as follows:
1. Folders are not checked; files are checked. Therefore, if you have a volume

(such as La Pomme) defined using the domain option, all folders of that volume
are backed up regardless of what you defined for your include and exclude
options. This is the case even if the files in those folders are not backed up.

2. File names are compared to the patterns in the include-exclude list from the
bottom up. When a match is found, the processing stops and checks whether
the option is include or exclude. If the option is include, the file is backed up. If
the option is exclude, the file is not backed up.

Note: A very large include-exclude list may decrease backup performance. Use
wildcards and eliminate unnecessary include statements to keep the list
as short as possible.
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3. If a match is not found, files are implicitly included and backed up.
4. When a file is backed up, it is bound to the default management class unless it

matched an include statement that specified a different management class
name, in which case the file is bound to that management class.

The following examples demonstrate bottom up processing.

Example 1
Assume that La Pomme is defined as the domain, and that you defined the
following statements for the include and exclude options.

exclude ...:*.cpp
include "La Pomme:Foo:...:*.cpp"
exclude "La Pomme:Foo:Junk:*.cpp"

The current file being processed is La Pomme:Foo:Dev:test.cpp. The
processing follows these steps:
1. Rule 3 (the last include or exclude statement defined) is checked first

because of bottom up processing. The pattern La Pomme:Foo:Junk:*.cpp
does not match the current file name being processed.

2. Processing moves to Rule 2 and checks. This time, pattern La
Pomme:Foo:...:*.cpp matches the current file name being processed.
Processing stops, the option is checked, and it is include.

3. File La Pomme:Foo:Dev:test.cpp is backed up.

Example 2
Assume that La Pomme is defined as the domain, and that you defined the
following statements for the include and exclude options.

exclude ...:*.cpp
include "La Pomme:Foo:...:*.cpp"
exclude "La Pomme:Foo:Junk:*.cpp"

The current file being processed is La Pomme:Widget:Sample File. The
processing follows these steps:
1. Rule 3 is checked and finds no match.
2. Rule 2 is checked and finds no match.
3. Rule 1 is checked and finds no match.
4. Because a match is not found, file La Pomme:Widget:Sample File is

implicitly included and is backed up.

Example 3
Assume that La Pomme is defined as the domain, and that you defined the
following statements for the include and exclude options.

exclude ...:...:*.cpp
include "La Pomme:Foo:...:*.cpp"
exclude "La Pomme:Foo:Junk:*.cpp"

The current file being processed is La Pomme:Lib:Src:Module1.cpp. The
processing follows these steps:
1. Rule 3 is checked and finds no match.
2. Rule 2 is checked and finds no match.
3. Rule 1 is checked and a match is found.
4. Processing stops, the option is checked, and it is exclude.
5. File La Pomme:Lib:Src:Module1.cpp is not backed up.
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Creating multiple user preferences files (optional)
Some tasks require changes to the User Preferences file. For example, suppose that
you want to back up your files to one server and archive them to another. Or,
suppose you want to retrieve files to a different workstation. Instead of editing
your User Preferences file each time you want to connect to a different server or
use a different workstation, you can create multiple User Preferences files.
Depending on what you want to do, you can launch Tivoli Storage Manager with a
different User Preferences file that suits your needs.

Suppose you have two servers named Alpha and Bravo. Simply create two User
Preferences files that are named, for example, Prefs Alpha and Prefs Bravo. When
you want to connect to Bravo, locate Prefs Bravo on your desktop and drop it onto
the Tivoli Storage Manager icon. Tivoli Storage Manager starts using all options in
Prefs Bravo, including the server address.

Notes:

1. Multiple TSM User Preferences files are supported only for the root user on
Macintosh OS X.

2. Remember to make duplicates of your original User Preferences file and modify
the duplicates. Always keep the original Tivoli Storage Manager Backup
Preferences Sample intact.

3. When you create user preferences files, you can double-click them or drop
them onto the Tivoli Storage Manager icon. The root user can take advantage of
this ability.

4. You can have multiple User Preference files but only one System Preferences
file. If you use more than one server, you must have multiple server stanzas in
the TSM System Preferences file.
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Chapter 3. Getting started

This chapter includes instructions for the following tasks:

Task Page

Starting a GUI session 21

Starting the client scheduler automatically 22

Changing your password 22

Sorting file lists 23

Displaying online help 23

Ending a session 23

Tivoli Storage Manager client authentication
When using the backup-archive GUI you can logon using a nodename and
password or administrative user ID and password. Tivoli Storage Manager prompts
for your user ID and compares it to the configured nodename. If they match, Tivoli
Storage Manager attempts to authenticate the user ID as a nodename. If the
authentication fails or if the user ID does not match the configured nodename, the
client attempts to authenticate the user ID as an administrative user ID.

To use an administrative user ID with any of the backup-archive clients, the user
ID must have one of the following authorities:
v System privilege - Authority over the entire system.
v Policy privilege - Authority over the node’s domain.
v Client owner - Authority over the configured nodename. With client owner

authority, you own the data and have physical access to it.

Client access authority only allows administrators to back up and restore files on
remote machines. They do not have physical access to the data. That is, they
cannot restore the remote machine’s data to their own machines. In order to restore
a remote machine’s data to your own machine, you must possess at least client
owner authority.

You can use the virtualnodename option to temporarily access your node’s data
from another machine. This option differs from the nodename option in that, if the
passwordaccess option is set to generate along with the virtualnodename option,
the password is not stored on the local machine. If you specify the nodename
option, the password is stored on the local machine. See “Virtualnodename” on
page 126 for more information about the virtualnodename option.

Starting a GUI session
Start a GUI session using one of the following methods:
v For the root user on Macintosh OS X:

– Double-click the TSM Backup icon.
– Double-click the TSM User Preferences file.
– Drag and drop a TSM User Preferences file onto the TSM Backup icon

v For Mac OS X non-root users:
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– Double-click the TSM Mac X Backup icon. You will be prompted for a
system administrator ID and password

Tivoli Storage Manager locates the TSM User Preferences file and starts with the
preferences specified in that file. See “Creating and modifying a user preferences
file (required)” on page 8 for more information about the TSM User Preferences
file.

Configuration Assistant
When the GUI client starts, it checks to see whether a TSM System Preferences file
exists. If the TSM System Preferences file does not exist (which usually happens
after you have installed the client for the first time on your machine), the setup
assistant will automatically start and guide you through the configuration process.
You can launch the assistant at any time to modify your client configuration files.
To do this from the main GUI window, select Utilities → Setup Assistant.

The setup wizard is not available through the Web client.

Starting the client scheduler automatically
You can start the client scheduler automatically when you login to your
workstation. If the administrator has defined schedules for your node, starting the
client scheduler permits you to automatically back up your workstation (or
perform other scheduled actions). See Chapter 7, “Automating tasks”, on page 45
for more information about the client scheduler.

Changing your password
Your Tivoli Storage Manager administrator can require you to use a password to
connect to the server. Tivoli Storage Manager prompts you for the password if one
is required. Contact your Tivoli Storage Manager administrator if you do not know
your password.

To change your password from the GUI:
1. From the main window, open the Utilities menu and select Change password.
2. Enter your current and new passwords, and enter your new password again in

the Verify password field.
3. Click Change.

A Tivoli Storage Manager password can be up to 63 characters. Valid characters
are:

Character Description

A–Z Any letter; A through Z, upper or lower case
0–9 Any number; 0 through 9
+ Plus
. Period
_ Underscore
- Hyphen
& Ampersand

A password is not case sensitive. See “Password” on page 98 for additional
password information.
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Sorting file lists
When you select the View menu in the menu bar, options are displayed for sorting
files by name, directory, date, size, modified date, creation date, backup date, or
archive date.

Only one of these options can be in effect at one time. For example, if you select
the Sort by Name item, a bullet displays at its left. If you select another item, the
bullet moves to that item.

Note: When you are viewing a list of files, you can also click the headings above
the listing to sort by that particular attribute.

Select the Edit menu → Select Items or Deselect Items options to select or deselect
several files simultaneously during a backup or archive operation.

Displaying online help
You can display online help by clicking the question mark (?) icon, which displays
online information about the current operation.

The help pages may contain HTML style hyper-links to other topics related to the
current operation you are performing. You can select a topic of interest in the Ask
field and search the online help for matches. Search results will be sorted by
relevance. Use the left and right arrow keys in the lower right-hand corner to
navigate between help pages.

Ending a session
You can end a Tivoli Storage Manager client session in any one of the following
ways:

From the GUI:
v Open the File menu and select Quit.
v Press Command+Q.

Online forum
To participate in user discussions of Tivoli Storage Manager you can subscribe to
the ADSM-L list server. This is a user forum maintained by Marist College. While
not officially supported by IBM, Tivoli Storage Manager developers and other IBM
support staff also participate on an informal, best-effort basis. Because this is not
an official IBM support channel, you should contact IBM Technical Support if you
require a response specifically from IBM. Otherwise there is no guarantee that IBM
will respond to your question on the list server.

You can subscribe by sending a note to the following e-mail address:
listserv@vm.marist.edu

The body of the message must contain the following:
SUBSCRIBE ADSM-L yourfirstname yourlastname
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The list server will send you a response asking you to confirm the subscription
request. Once you confirm your subscription request, the list server will send you
further instructions. You will then be able to post messages to the list server by
sending e-mail to:
ADSM-L@vm.marist.edu

If at a later time you want to unsubscribe from ADSM-L, you can send a note to
the following e-mail address:
listserv@vm.marist.edu

The body of the message must contain the following:
SIGNOFF ADSM-L

You can also read and search the ADSM-L archives at the following URL:
http://www.adsm.org

Other sources of online help
An anonymous FTP server is available where you can find PTF maintenance and
other Tivoli Storage Manager-related materials. Four other anonymous servers are
unofficially maintained by non-IBM volunteers. These servers are:

ftp.software.ibm.com/storage (primary - IBM)
ftp.rz.uni-karlsruhe.de (mirror - Germany)
ftp.wu-wien.ac.at (mirror - Austria)
ftp.cac.psu.edu (mirror - Pennsylvania)

You can get maintenance information from the Tivoli Storage Manager support
page at:

http://www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html

Also see “Contacting customer support” on page xi for product support
information.
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Chapter 4. Backing up your data

Use Tivoli Storage Manager to store copies of your workstation files on a Tivoli
Storage Manager server. These copies are called backup versions or backups. You
can restore these backup versions from the server to your workstation if the
original workstation files are lost or damaged. See Chapter 5, “Restoring your
data”, on page 33 for more information.

As a quick reference, this chapter includes instructions for the following task.

Task Page

Performing a backup 31

Attention: On Macintosh OS X, you must have a system administrator ID and
password to perform Tivoli Storage Manager tasks.

If you are a first-time user, Table 9 is a checklist of preliminary considerations
before performing a backup:

Table 9. Preliminary steps for backing up files

___ Decide whether you want to backup files or archive them. See “Do you want to
back up or archive files?” for more information.

___ Decide what type of backup you want according to your needs. See the following
sections for more information: “Full and partial incremental backup” on page 26,
“Incremental-by-date backup” on page 27, and “Comparing full incremental,
partial incremental, and incremental-by-date backups” on page 28

___ Create an include-exclude list to specify files and folders you want to exclude
from backup services. See “Using the include-exclude list to control processing”
on page 28 for more information.

___ For further backup considerations, see “Backup considerations” on page 31

Do you want to back up or archive files?
When the backup-archive client backs up or archives a file, it sends a copy of the
file and its associated attributes to the server; however, backups and archives have
different goals.

Backups protect against file damage or loss that could occur through accidental
deletion, corruption, disk crashes, and so forth. The server maintains one or more
backup versions for each file that you back up. Older versions are deleted as
newer versions are made. The number of backup versions the server maintains is
set by your administrator.

Note: If you need to frequently create archives for the same data, consider using
instant archives (backup sets) instead. Frequent archive operations can create a
large amount of metadata in the server database increasing database growth and
decreasing performance for operations such as expiration. See “Restoring data from
a backup set” on page 35 for more information on how backup sets can be
generated and restored.
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Archive copies are saved for long-term storage. Your administrator can limit how
long archive copies are kept. The server can store an unlimited number of archive
versions of a file. Archives are useful if you need to go back to a particular version
of your files, or you want to delete a file from your workstation and retrieve it at a
later time, if necessary. For example, you might need to save spreadsheets for tax
purposes, but because you are not using them, you do not want to leave them on
your workstation. See Chapter 6, “Archiving and retrieving data”, on page 41 for
more information about archiving and retrieving files.

Use backups to protect against unforeseen damage to your files, and use archives
for maintaining more permanent versions of your files.

Backing up volumes, folders and files
Your administrator might have set up schedules to back up files on your
workstation automatically. See Chapter 7, “Automating tasks”, on page 45 for
information on checking and running the schedules available to you. The following
sections discuss how to back up files without using a schedule.

Full and partial incremental backup
If you select entire file systems, you are performing a full incremental backup. If
you select a directory tree or individual files, you are performing a partial
incremental backup.

The first time you run a full incremental backup, Tivoli Storage Manager backs up
all the files and folders on the volumes you specify. This process can take a long
time if there are a large number of files, or one or more very large files.
Subsequent full incremental backups will only back up new and changed files.
This allows the backup server to maintain current versions of your workstation
files, without having to waste time or space by backing up files that already exist
in server storage. Depending on your storage management policies, the server may
keep more than one version of your files in storage. The most recently backed up
files are active backup versions. Older copies of your backed up files are inactive
versions. However, if you delete a file from your workstation, the next full
incremental backup will cause the active backup version of the file to become
inactive. If you need to restore a file you have deleted, and if a full incremental
backup has been run since you deleted the file, then you will need to restore an
inactive version of the file (assuming that a version still exists on the server). The
number of inactive versions maintained by the server and how long they are
retained is governed by the management policies defined by your server
administrator. The purpose of the active versions is to represent what files existed
on your file system at the time of the backup. See Chapter 8, “Understanding
storage management policies”, on page 49 for more information about storage
management policies.

To perform a full incremental backup see “Performing a backup” on page 31.

During an incremental backup, the client queries the server to determine the exact
state of your files since the last incremental backup. The client uses this
information to:
v Back up new files
v Back up files whose contents changed since the last backup. Changes include

any of the following:
– File size.
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– Date or time of last modification.
– Access Control List
– If only the following items change, they are updated without causing the

entire file to be backed up to the server:
- Locked attribute
- File owner
- File permissions
- Last access time
- User ID
- Group ID

v Expire backup versions of files on the server that do not have corresponding
files on the workstation. The result is that files which no longer exist on your
workstation will not have active backup versions on the server.

v Rebind backup versions to management classes if you change management class
assignments, even if you do not back up the file.

Attention: Each directory is also backed up if it has not yet been backed up, or if
its permissions or time stamp have changed since the last time it was backed up.

Folders are counted in the number of objects backed up. To exclude directories and
their contents from backup, use the exclude.dir option. For more about exclude.dir,
see “Exclude options” on page 81.

Understanding which files are backed up
When you request a backup, Tivoli Storage Manager backs up a file if all of the
following requirements are met:
v You do not exclude the file from backup in your include-exclude list. If you do

not have an include-exclude list, all files will be candidates for backup.
v The selected management class contains a backup copy group. See Chapter 8,

“Understanding storage management policies”, on page 49 for more information
on management classes and backup copy groups.

v The file meets the serialization requirements defined in the backup copy group.
If serialization is static or shared static, and the file changes during backup, the
file will not be backed up. See “Using management classes and copy groups” on
page 49 for more information.

v The file meets the mode requirements defined in the backup copy group. If the
mode is modified, the file must have changed since the last backup. If the mode
is absolute, the file can be backed up even if it does not change. See “Using
management classes and copy groups” on page 49 for more information.

v The file meets the frequency requirements defined in the backup copy group.
The specified minimum number of days since the last backup must elapse before
a file is backed up. Frequency is ignored for partial incremental backups. See
“Using management classes and copy groups” on page 49 for more information.

Incremental-by-date backup
For a disk or volume to be eligible for incremental-by-date backups, you must have
performed at least one full incremental backup of that entire disk or volume. Running an
incremental backup of only a directory branch or individual file will not make the disk or
volume eligible for incremental-by-date backups.

To perform an incremental-by-date backup, see “Performing a backup” on page 31.
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The client backs up only those files whose modification date and time is later than
the date and time of the last incremental backup of the file system on which the
file resides. Files added by the client after the last incremental backup, but with a
modification date earlier than the last incremental backup, are not backed up. Files
that were renamed after the last incremental backup, but otherwise remain
unchanged, will not be backed up. Renaming a file does not change the
modification date and time. The folders in the path that contain the file are also
backed up, unless they already exist on the server. A directory that already exists
on the server is only backed up again if its modification timestamp changes. The
files under the directory are also backed up even if their modification timestamps
have not changed.

If you run an incremental-by-date backup of the whole file system, the server
updates the date and time of the last incremental backup. If you perform an
incremental-by-date backup on only part of a volume, the server does not update
the date of the last full incremental backup. In that case, the next
incremental-by-date backup will back up these files again.

Comparing full incremental, partial incremental, and
incremental-by-date backups

Full incremental, partial incremental, and incremental-by-date all back up new and
changed files. An incremental-by-date backup takes less time to process than a full
incremental backup and requires less memory. An incremental-by-date backup
might not place exactly the same backup files into server storage because the
incremental-by-date backup:
v Does not expire backup versions of files that you delete from the workstation.
v Does not rebind backup versions to a new management class if you change the

management class.
v Does not back up files with attributes that change, unless the modification dates

and times also change.
v Ignores the copy group frequency attribute of management classes.

Selective backup
Use a selective backup when you want to back up specific files or folders
regardless of whether a current copy of those files exists on the server. Incremental
backups are generally part of an automated system to back up entire file systems.
In contrast, selective backups allow you to manually select a set of files to back up
regardless of whether they have changed since your last incremental backup.

To perform a selective backup, see “Performing a backup” on page 31.

Unlike incremental backups, a selective backup:
v Does not cause the server to update the date and time of the last incremental.
v Backs up directory and file entries even if their modification timestamp or

permissions have not changed.

Using the include-exclude list to control processing
Usually, there are files that you do not want to back up. These files can be
operating system or application files that can be easily recovered by reinstalling the
program, or any other file that you could easily rebuild.

Place the include and exclude options in the TSM System Preferences file to
exclude specific files from backup services. Any file that is not explicitly excluded
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is backed up. You do not need to use an include option to include specific files
unless those files are in a folder you are trying to exclude.

Tivoli Storage Manager uses management classes to determine how to manage your
backups on the server. Every time you back up a file, the file is assigned a
management class. The management class is either a default chosen for you, or one
you assign to the file using the include option in the include-exclude list. If you
assign a management class it must contain a backup copy group for the file to be
backed up. See Chapter 7, “Automating tasks”, on page 45 for more information on
management classes and how to assign them to files.

For more information about creating an include-exclude list in your TSM System
Preferences file, see “Creating an include-exclude list (optional)” on page 11.

Supported file systems
Tivoli Storage Manager supports HFS, HFS+, UFS, UDF, and ISO 9600 file systems,
as defined in Table 10.

Table 10. Supported file systems

File system
Supported
platform Tivoli Storage Manager support

Hierarchical File
System (HFS) and
Hierarchical File
System Plus
(HFS+)

Macintosh OS X v Case-insensitive, but case-preserving
v Supports creation and modification dates as

metadata
v Supports aliases
v 32 character limit for folders and file names.
v Recognized as a local file system.

UNIX File System
(UFS)

Macintosh OS X v UFS is case-sensitive
v Supports modification dates as metadata
v Supports aliases and symbolic links
v 32 character limit for folders and file names
v Recognized as a local file system.

Universal Disk
Format (UDF )

Macintosh OS X The Universal Disk Format for DVD volumes.
Recognized as removable media.

ISO 9660 Macintosh OS X The standard format for CD-ROM volumes.
Recognized as removable media.

UFS file systems are not supported by applications running in the Classic
environment on Macintosh OS X.

The UFS file system is sensitive to case whereas the HFS+ file system is
case-insensitive but is case-preserving. Files that you back up from a UFS file
system (case-sensitive) may not be restored properly to an HFS+ file system
(case-insensitive) file system. On a UFS file system, files Afile and afile are seen
as different files. However, on an HFS+ file system the two files are seen as
identical.

Aliases and symbolic links are backed up. However, Tivoli Storage Manager does
not back up the data the symbolic links point to.

Unicode considerations
The Macintosh OS X client is Unicode enabled. New clients storing data on the
server for the first time require no special set up. The server automatically stores
files and directories as Unicode enabled. However, if your client already stores
data on the server and you upgrade to Unicode-enabled client, you need to plan

Chapter 4. Backing up your data 29



for the migration of file spaces to Unicode. For migration information, see
“Migrating to the Unicode-enabled client” on page 1.

This involves renaming your file spaces on the server and creating new
Unicode-enabled file spaces on the server using the autofsrename option. For
detailed information about this option, see “Autofsrename” on page 67.

Understanding how hard links are handled
When you back up files that are hard-linked, Tivoli Storage Manager backs up
each instance of the linked file. For example, if you back up two files that are
hard-linked, Tivoli Storage Manager will back up the file data twice.

When you restore hard-linked files, Tivoli Storage Manager attempts to reestablish
the links. For example, if you had a hard-linked pair of files, and only one of the
hard-linked files is on your workstation, when you restore both files, they will be
hard-linked. The one exception to this procedure occurs if you back up two files
that are hard-linked and then break the connection between them on your
workstation. If you restore the two files from the server, Tivoli Storage Manager
will respect the current file system and not restore the hard link.

If you do not back up and restore all files that are hard-linked at the same time,
problems will occur. To ensure that hard-linked files remain synchronized, back up
all hard links at the same time and restore those same files together.

Maximum file size for backup and restore
Table 11 specifies the maximum file sizes for backup and restore operations.

Table 11. Maximum file size for backup and restore

Platform Max file size (in bytes)

Macintosh OS X 18,446,744,073,709,551,616 (16EB)

Estimating backup processing time
The first time you perform an incremental backup, Tivoli Storage Manager needs
to back up all of your files, which can take a long time. Subsequent backups
usually do not take as long. The Estimate function is provided on the Backup and
Restore windows to estimate the amount of time it takes to process your files and
folders. The estimated transfer is a rough calculation of the time it takes to transfer
your data, based on previous transfers of data between your workstation and the
current Tivoli Storage Manager server.

The actual transfer time could be longer or shorter than the estimate due to factors
like network traffic, system load on your workstation, or system load on the server.
The estimate function also does not take into account whether or not files are
excluded from backup. The assumption made by the estimation algorithm is that
all the files selected will be sent to the server.

Note: Tivoli Storage Manager creates the TSM GUI Preferences file to record
statistics from the backup-archive client estimate function. This file is stored in the
following locations:

For Macintosh X
Stored in either of the following paths, depending on the Macintosh OS X
version you are using:
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System:Library:Preferences:Tivoli Storage Manager
or
System:Library:PreferencePanes:Tivoli Storage Manager

Performing a backup
When you start Tivoli Storage Manager, it sets your default domain to the volumes
you set with the domain option in the TSM System Preferences file (see “Domain”
on page 78). If you do not have the domain option set, the default domain is all

local volumes. Selecting Backup Domain from the Actions menu incrementally
backs up all volumes in the domain.

You may also exclude volumes in your default domain from backup processing
using the Preferences editor.

To run a backup, perform the following steps:
1. Click on the Backup button from the GUI main window. The Backup window

appears.
2. Expand the folder tree. Select the objects you want to backup. To search or

filter files, click on the Edit menu→ Find item.
3. Select the Type of Backup pull-down menu:

v To run an incremental backup, click on Incremental (complete)
v To run an incremental backup by date, click on Incremental (date only)
v To run a selective backup, click on Always backup

4. To modify specific backup options click the Options button. The options you
select are effective during the current session only.

5. Click on Backup. The Task List window displays the backup processing status.
The Backup Report window displays processing statistics.

Displaying backup processing status
During a backup, by default Tivoli Storage Manager displays the status of each file
it attempts to back up. Tivoli Storage Manager reports the file’s size, path, file
name, total number of bytes transferred, and whether the backup attempt was
successful. These also display in the TSM Schedule Log file for scheduled
commands.

The backup-archive client GUI provides a Task List window that displays
information about files during processing. When a task completes, a Backup
Report window displays processing details.

Backup considerations
This section discusses some advanced considerations for using backup. You do not
need to understand this information to use Tivoli Storage Manager for basic work.

How Tivoli Storage Manager maintains volume names
Tivoli Storage Manager backs up volumes based on the volume name. Tivoli
Storage Manager maintains each volume name as a separate restore or retrieve
volume. These volume names become the names of file spaces on the server.

If you change the name of a volume you have already backed up, Tivoli Storage
Manager sees it as a new volume and does not relate it to the previous one. An
incremental backup on the volume backs up the files under the new name. A
mismatch might occur if you rename your volumes, or if you access Tivoli Storage
Manager from a different workstation than the one from which you backed up the
files.
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Volume naming precautions
Unlike other applications on the Macintosh, Tivoli Storage Manager is not case
sensitive—it sees two volumes called “La Pomme” and “la pomme” as identical.
Therefore, you must assign a different name to each volume to avoid volume
duplications.

If duplicate volumes exist on your desktop, Tivoli Storage Manager cannot
determine which one corresponds to the volume of the same name on the server,
and displays an error message. Remove or rename duplicates as needed.

Tivoli Storage Manager cannot determine if a network or removable media volume
has the same name as a local volume. Do not backup network or removable
volumes that have the same name as a local volume. By default, network and
removable volumes are not included for backup processing.

Backing up opened files
Some files on your system may be in use, or open, when you try backing them up.
Because an open file may change during a backup, the backup may not accurately
reflect the contents of the file. If this is the case, you need to consider the following
options:
v If the file is unimportant, or can be easily rebuilt (for example, a temporary file),

you might not care that the file is not backed up.
v If the file is important:

– If the backup is not scheduled, close the file and the application before you
start the backup.
If the backup is scheduled, use the preschedulecmd option to issue a
command that closes the file before the backup occurs. For example, if the
open file is a database, use the database’s quiesce command to shut down the
database. You can use the postschedulecmd option to restart the application
that uses the file after the backup completes.

– You can back up the file even if it is open and changes during the backup, by
assigning the file a management class with the serialization dynamic or
shared dynamic. This is only useful if the file is usable even if it changes
during the backup. See “Selecting a management class for files” on page 54
for information on assigning management classes, and “Displaying
information about management classes and copy groups” on page 51 for
information on determining which management classes are available to you.

File sharing access privileges
Tivoli Storage Manager also backs up File Sharing Access Privileges, but only if all
backups are done with File Sharing turned on. Also, to restore folders with their
previous access privileges, you must perform the restore while File Sharing is on.
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Chapter 5. Restoring your data

You can use Tivoli Storage Manager to restore backup versions of specific files, a
group of files with similar names, entire folders, or backup sets.

Attention: On Macintosh OS X, you must have a system administrator ID and
password to perform Tivoli Storage Manager tasks.

This chapter includes instructions for the following tasks.

Task Page

Performing a restore 35

Performing point-in-time restores 37

Authorizing another user to restore or retrieve your files 38

Restoring or retrieving another user’s files 38

Restoring or retrieving your files to another workstation 39

No query restore
When you select a file space or directory for restore, the client uses a different
method for restoring files and directories from the server. This method is called no
query restore because instead of querying the server for each object to be restored, a
single restore request is sent to the server. In this case, the server returns the files
and directories to the client without further action by the client. The client merely
accepts the data coming from the server and restores it to the destination.

An example of an unrestricted wildcard command would be to select a folder from
the restore tree window.

An example of a restricted wildcard command would be to select individual files
from a folder.

Standard restore process
The standard restore (also known as classic) process and the no query restore
process are outlined below.
1. The client queries the server for a list of files backed up for the client file space

you want to restore.
2. The server sends a list of backed up files that match the restore criteria. If you

want to restore both active and inactive files, the server sends information
about all backed up files to the client.

3. The list of files returned from the server is sorted in client memory to
determine the file restore order and to minimize tape mounts required to
perform the restore.

4. The client tells the server to restore file data and directory objects.
5. The directories and files you want to restore are sent from the server to the

client.
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No query restore process
1. The client tells the server that a no query restore is going to be performed and

provides the server with details about file spaces, directories, and files.
2. The server sorts the data using an internal sort table which minimizes tape

mounts.
3. The data to be restored is sent to the client. File and directory objects stored on

disk are sent immediately since sorting for such data is not required before
restoring it.

4. You can use multiple sessions to restore the data. If the data resides on multiple
tapes, there are multiple mount points available at the server. The combination
of using the resourceutilization option and MAXNUMMP allows multiple
sessions. See “Resourceutilization” on page 109 for more information.

If the restore process stops because of a power outage or network failure, the
server records the point at which this occurred. This record is known to the client
as a restartable restore. It is possible to have more than one restartable restore
session. Choose restartable restores from the Actions menu to find out if your
client has any restartable restore sessions in the server database.

You must complete a restartable restore before attempting further backups of the
file system. If you attempt to repeat the restore that was interrupted or try to back
up the destination file space, the attempt will fail because you did not complete
the original restore. From the Restartable restores dialog box you can select the
interrupted restore and delete it, or you can choose to restart the restore. If you
restart the interrupted restore, it will restart with the first transaction, which may
consist of one or more files, not completely restored when the interruption
occurred. Because of this, you may receive some replace prompts for files from the
interrupted transaction which were already restored.

To perform restartable restores using the GUI, follow these steps:
1. Click Help from the Restore window.
2. Click Restoring Backup Versions
3. Click Work with restartable restore sessions.

Do you want to restore an active or inactive backup?
Your administrator determines how many backup versions Tivoli Storage Manager
maintains for each file on your workstation. Frequently, the administrator allows
more than one version of each file. Having multiple versions of a file allows you to
restore older versions in case the most recent backup is damaged, or you need a
previous version of the file.

Tivoli Storage Manager considers the most recent backup version to be the active
version. Any other backup version is considered an inactive version.

Every time you back up your files, the new backup version becomes the active
version, and the previous active backup version becomes an inactive version.
When the maximum number of inactive versions is reached, Tivoli Storage
Manager deletes the oldest inactive version.

If you want to restore an inactive backup version, you need to display both active
and inactive versions, by clicking on the View menu→ Show active/inactive files
item. To display only the active versions (the default), click on the View menu→
Show active/inactive files item again.
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Performing a restore
To run a restore, perform the following steps:
1. Click on Restore from the GUI main window. The Restore window appears.
2. Expand the folder tree. Click on the object that you want to restore. To search

or filter files, click on the Edit menu→ Find item. To perform a point-in-time
restore that restores files to the state that existed at a specific date and time,
click the Point-in-Time button.

3. To modify specific restore options click the Options button. The options you
select are effective during the current session only.

4. Click on Restore. The Restore Destination window appears. Enter the
appropriate information.

5. Click on Restore. The Task List window displays the restore processing status.
The Restore Report window displays processing statistics.

Considerations:
v When the client starts up it is running with a UID of zero. This means that if

you create a folder to restore your files to, that folder is owned by root. To
access the files you must change the permissions of the folder. You can change
the folder owner from a terminal window using the sudo chown command.
Please see your operating system documentation for more information on how
to accomplish this.

v When restoring files with the replace option set to no, existing files will not be
overwritten, but existing directories will. To leave existing directories intact
during a restore operation, select the Options button → All selected files and
directories dropdown menu → Files only option.

v When folders are restored from a UFS file system to an HFS file system and they
differ only in case, the client will restore the contents of both folders to one
folder.

Restoring data from a backup set
Your Tivoli Storage Manager administrator can generate a backup set (a collection
of your active files that reside on the server) onto portable media created on a
device using a format that is compatible with the client device.

It is possible to generate a backup set as a number of special files if the device
class the Tivoli Storage Manager administrator specifies when creating it is file.
These files can be stored locally (on the client) to provide more restore flexibility.

Portable media can be used on devices such as a CD-ROM, DVD, and Iomega JAZ
or ZIP drives. Current device support information is available at the following Web
site:
http://www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html

You can restore backup sets from the following locations:
v From portable media on a device attached to your client workstation
v Directly from the server

Backup sets can provide you with instant archive and rapid recovery capability as
described below:

Instant archive
This capability allows an administrator to create an archive collection from
backup versions already stored on the server.
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Rapid recovery
When you are away from your office without a network connection and
you lose data, you can restore the data from the backup set.

Note: If you would like to restore a backup set from portable media on a device
attached to your client workstation, check with your Tivoli Storage Manager
administrator to ensure that the portable media was created on a device
using a format that is compatible with your client device.

Restoring an entire or partial backup set
Tivoli Storage Manager considers a backup set as one object containing the whole
file structure. You can restore the entire backup set or just select portions. The
backup set media is self-describing and contains all the information required to
perform a successful restore.

Use the GUI to restore an entire backup set only.

Restoring backup sets
Attention: Before you begin a restore, be aware that backup sets can contain data
for multiple file spaces. If you specify a destination other than the original location,
data from all file spaces is restored to the location you specify.

To restore a backup set, perform the following steps:
v Click Restore from the GUI main window. The Restore window appears.
v Locate the Backup Sets directory tree object and expand it.

– To restore the backup set from a local device, expand the Local object and the
Specify backup set location dialog is displayed. On the dialog, select File
name: or Tape name: from the dropdown list and then enter the tape or file
name location. You can also click the Browse button to open a file selection
window and select a backup set.

– To restore an entire backup set from the server, expand the Server object.

Your backup sets appear in the tree and are grouped by backup set descriptions.
Expand a backup set description to see the backup sets with that description.

v Click the selection box next to the backup set that you want to restore.
v Click Restore. The Restore Destination window appears. Enter the appropriate

information.
v Click on Restore. The Task List window displays the restore processing status.

Notes:

1. If the object you want to restore is part of a backup set generated on a node,
and the node name is changed on the server, any backup set objects that were
generated prior to the name change will not match the new node name. Ensure
that the node name is the same as the node for which the backup set was
generated.

2. If the backup set is on the server, normal Tivoli Storage Manager security
applies, and you can only restore your own files and files to which you have
been granted access. However, normal Tivoli Storage Manager security does not
apply to backup set data when restored locally because the physical media can
be explored by the person who has access to it.

3. To enable the GUI client to restore a backup set on an attached device on a
Macintosh standalone workstation, without requiring a server connection, use
the localbackupset option. See “Localbackupset” on page 91 for more

36 IBM Tivoli Storage Manager for Macintosh: Backup-Archive Clients Installation and User’s Guide

|
|
|
|
|



information. Also, certain local devices such as tape devices require device
drivers to be set up prior to performing a restore. See the device manual for
assistance with this task. You will also need to know the device address in
order to perform the restore.

Performing point-in-time restores
Use a point-in-time restore to restore files to the state that existed at a specific date
and time. A point-in-time restore can eliminate the effect of data corruption by
restoring data from a time prior to known corruption, or recover a basic
configuration to a prior condition.

You can perform a point-in-time restore of a file space, directory, or file.

Perform incremental backups to support a point-in-time restore. During an
incremental backup, the client notifies the server when files are deleted from a
client file space or directory. Selective and incremental-by-date backups do not
notify the server about deleted files. Run incremental backups at a frequency
consistent with possible restore requirements.

If you request a point-in-time restore with a date and time that is prior to the
oldest version maintained by the Tivoli Storage Manager server, the object is not
restored to your system. Files which were deleted from you workstation prior to
the point-in-time specified will not be restored.

Notes:

1. Your administrator must define copy group settings that maintain enough
inactive versions of a file to guarantee that you can restore that file to a specific
date and time. If enough versions are not maintained, Tivoli Storage Manager
may not be able to restore all objects to the point-in-time you specify.

2. If you delete a file or directory, the next time you run an incremental backup,
the active backup version becomes inactive and the oldest versions that exceed
the number specified by the versions data deleted attribute of the management
class are deleted. See Chapter 8, “Understanding storage management policies”,
on page 49 for more information about the versions data deleted attribute.

When performing a point-in-time restore, consider the following:
v Tivoli Storage Manager restores file versions from the most recent backup before

the specified point-in-time date. Ensure the point-in-time that you specify is not
the same as the date and time this backup was performed.

v If the date and time you specify for the object you are trying to restore is earlier
than the oldest version that exists on the server, Tivoli Storage Manager cannot
restore that object.

v Point-in-time restore will restore files deleted from the client workstation after
the point-in-time date but not files deleted before this date.

v Tivoli Storage Manager cannot restore a file created after the point-in-time date
and time. When a point-in-time restore runs, files that were created on the client
after the point-in-time date are not deleted.

To perform a point-in-time restore using the client GUI, use the following steps:
1. Click the Restore button in the main window. The Restore window appears.
2. Click the Point-in-Time button from the Restore window. The Point in Time

Restore window appears.
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3. Select the Use a Point-in-Time Date selection box. Select the date and time and
click OK. The point in time that you specified appears in the Point in Time
display field in the Restore window.

4. Display the objects you want to restore. You can search for an object by name,
filter the directory tree, or work with the directories in the directory tree.

5. Click the selection boxes next to the objects you want to restore.
6. Click the Restore button. The Restore Destination window displays. Enter the

appropriate information.
7. Click the Restore button to start the restore. The Restore Task List window

displays the restore processing status.

Note: If there are no backup versions of a directory for the point-in-time you
specify, files within that directory are not restoreable from the GUI.

Related tasks and considerations
This section discusses some advanced considerations for restoring files. You do not
need to understand this information to perform basic Tivoli Storage Manager tasks.

Authorizing another user to restore or retrieve your files
You can authorize a user on another node to restore your backup versions or
retrieve your archive copies. This allows you to share files with other people or
with other workstations that you use with a different Tivoli Storage Manager node
name.

To authorize another node to restore or retrieve your files:
1. From theTivoli Storage Manager main window select the Utilities menu → User

Access List item. The User Access List window displays.
2. Enter the node name of the user you want to authorize, and the directory and

file name to which you want the user to have access. You can give the user
access to backups or archives. You must add separate authorizations for backup
and archive access, even if you want to give the same node access to the same
files for both. You can authorize all users by using an asterisk (*) for the node
name.

3. Click on Add to add the node. While you are in the User Access List window,
you can add several nodes at once, delete nodes, or change your existing
authorizations. All additions, deletions, and changes are processed when you
click on OK. If you make a mistake, click on Cancel to exit the user access list
and start again.

4. Click on OK to add the node to the user access list.

Restoring or retrieving another user’s files
After users grant you access to their files on the server, you can restore or retrieve
those files to your local system. You can display another user’s file spaces on the
Tivoli Storage Manager server, restore the other user’s backup versions, or retrieve
the other user’s archive copies to your local drives.
1. From the Tivoli Storage Manager main window select the Utilities menu→

Access Another User item. The Access Another User window displays.
2. Enter the user’s node name in the Node name field.
3. Click on Set.
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Restoring or retrieving your files to another workstation
Tivoli Storage Manager lets you restore or retrieve files you back up from your
own workstation, when you are using a different workstation. You just need to
specify your node name, because your backups and archives are stored according
to your node, not your specific machine. Your Tivoli Storage Manager password
protects your data.

To restore or retrieve files to another workstation, either change the nodename
option in your TSM System Preferences file to match the current workstation, or
type it in when prompted for the nodename and password. You can then restore or
retrieve files as if you were working on your original workstation.

If you do not want to restore or retrieve the files to the same folder name on the
alternate workstation, use a different destination.

You can have only one TSM System Preferences file containing one or more server
stanzas. Each server stanza can have a nodename option. See “Nodename” on
page 96 for more information.

Restoring a disk in case of disk loss
Tivoli Storage Manager can only recover your files if you can run the client. If the
disk that contains the client is lost (from theft or hardware failure, for example),
you must reinstall the client before you can recover your files. If you also lose the
disk that contains the operating system and communication software, you must
recover them before you can connect to the Tivoli Storage Manager server.

To protect yourself against these kinds of losses, perform the following steps:
1. Record the IP address, subnet mask, default router, and name servers in the

TCP/IP Control Panel. You can use this information to reconfigure TCP/IP
when you re-install MacOS.

2. Record your nodename, TCP Server address, and TCP Port number from the
Communications panel of the Preferences editor. The nodename information
comes from the General panel in the Preferences editor. You will need this
information to configure Tivoli Storage Manager so you can restore your data.

3. Re-install the MacOS from your Macintosh installation CD to access the
network.

4. Install the Tivoli Storage Manager for Macintosh installation program. You can
either get this from the following Web site:
www.ibm.com/software/sysmgmt/products/support/IBMTivoliStorageManager.html

Deleting restore or retrieve volumes
If your Tivoli Storage Manager administrator gives you backdelete and
archivedelete authority, you can delete entire restore/retrieve volumes from
storage. This deletes all the files, both backup versions and archive copies, that are
associated with a particular volume. You can select the File menu→ Connection
Information item to see your permissions.

For example, if you delete the Macintosh HD restore/retrieve volume, you are
deleting all associated backup versions and archive copies. The original files still
exist on your hard disk. Consider this carefully before you delete a restore or
retrieve volume. You cannot delete individual backup versions kept on the server.

If you decide you do not need a restore/retrieve volume, delete it by clicking on
the Utilities menu→ Delete Filespaces.
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Note: Restore and Retrieve volumes can also be referred to as file spaces.

Overlapping files
Tivoli Storage Manager remembers a file’s position on your desktop when it backs
up the file and tries to restore it back to its original position. If a file is in the top,
left corner of your desktop when you back it up, Tivoli Storage Manager tries to
put it there when you restore it.

But if something else is in that same position when you restore, it is possible that
folders and icons can overlap. If this occurs, select the View menu→ View Options
item → by Name item, to list objects alphabetically, with no overlapping.

Rebuilding the desktop
If a file you restore does not have the icon it should, you probably need to rebuild
the Desktop. Folders with icons pasted onto the Get Info dialog box always require
the Desktop to be rebuilt. Do this by restarting your Macintosh with the Option
and Command keys held down.
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Chapter 6. Archiving and retrieving data

Archiving and retrieving files is similar to backing up and restoring them; many of
the windows and concepts are the same. See Chapter 4, “Backing up your data”, on
page 25 for more information. See “Do you want to back up or archive files?” on
page 25 for a discussion of the differences between backups and archives.

As a quick reference, this chapter includes instructions for the following tasks:

Task Page

Performing an archive 42

Deleting archived files 43

Performing a retrieve 43

Attention: On Macintosh OS X, you must have a system administrator ID and
password to perform Tivoli Storage Manager tasks.

Archiving files
Your administrator might have set up schedules to automatically archive certain
files on your workstation. See Chapter 7, “Automating tasks”, on page 45 for
information on checking and running the schedules available to you. The following
sections discuss how to archive files without using a schedule.

Maximum file size for archive and retrieve operations
Table 12 specifies the maximum file sizes for archive and retrieve operations.

Table 12. Maximum file size for archive and retrieve

Platform Max file size (in bytes)

Macintosh OS X 18,446,744,073,709,551,616 (16EB)

Understanding how hardlinks are handled
When you archive files that are hard-linked, Tivoli Storage Manager archives each
instance of the linked file. For example, if you archive two files that are
hard-linked, Tivoli Storage Manager will archive the file data twice.

When you retrieve hard-linked files, Tivoli Storage Manager attempts to reestablish
the links. For example, if you had a hard-linked pair of files, and only one of the
hard-linked files is on your workstation, when you retrieve both files, they will be
hard-linked. The one exception to this procedure occurs if you back up two files
that are hard-linked and then break the connection between them on your
workstation. If you retrieve the two files from the server, Tivoli Storage Manager
will respect the current file system and not retrieve the hard link.

If you do not archive and retrieve all files that are hard-linked at the same time,
problems will occur. To ensure that hard-linked files remain synchronized, archive
all hard links at the same time and retrieve those same files together.
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Understanding how your archives are managed
As with backing up files, Tivoli Storage Manager checks the include options in
your include-exclude list to determine which management class to assign to your
archived files. If you do not specifically assign a management class to a file with
an include option, Tivoli Storage Manager assigns the file the default management
class.

Tivoli Storage Manager can only archive a file if the selected management class
contains an archive copy group.

For information on the various management class attributes used to manage your
archives, see “Displaying information about management classes and copy groups”
on page 51. For information on assigning management classes, see “Assigning a
management class to files” on page 54.

Estimating archive processing time
An Estimate function is provided on the Archive and Retrieve windows. Use this
function if you want to estimate the amount of time it takes to process your files
and folders. The estimated transfer is a rough calculation of the time it takes to
transfer your data. It is based on previous transfers of data between your
workstation and the current Tivoli Storage Manager server. The actual transfer time
can differ from the estimate due to network traffic, system load on your
workstation, or system load on the server.

Performing an archive
You can use Tivoli Storage Manager to archive specific files, a group of files with
similar names, or entire folders. You can locate the files you want to archive by
searching or filtering. Filtering displays only the files that match the filter criteria
for your archive operation.

To perform an archive, do the following:
1. Click on Archive from the GUI main window. The Archive window appears.
2. Expand the folder tree. Click on the object you want to archive. To search or

filter files, click on the Edit menu→ Find item.
3. In the Description field, do one of the following:

v Enter a description. The maximum length of a description is 254 characters.
v Accept the default description
v Select an existing description from the drop-down list.

4. To modify specific archive options click the Options button. The options you
select are effective during the current session only.

5. Click on Archive. The Task List window displays the archive processing status.
The Archive Report window displays processing statistics.

Displaying archive status
During an archive operation the Task List window to display statistics on various
items, and to notify you when your archive completes. The Task List window does
not appear during scheduled archives.

Transfer statistics, such as bytes transferred, may not match the file statistics, such
as file size, if the archive or retrieve command is retried due to a communications
failure or session loss. The transfer statistics will show the bytes attempted to be
transferred across all command attempts.

42 IBM Tivoli Storage Manager for Macintosh: Backup-Archive Clients Installation and User’s Guide



Deleting archived files
You can delete archives if you decide you no longer need them. Unlike backup
versions, you can delete individual archives without deleting the entire
restore/retrieve volume.

To delete an archive copy:
1. Click on Utilities from the GUI main window and click on Delete Archive

Data. The Archive Delete window appears.
2. Expand the folder tree. The folder tree contains groups of files identified by a

description and archived to the server.
3. Click on the selection boxes next to the archives you want to delete.
4. Click on Delete. The Archive Delete Status window displays the archive

deletion processing status.

Retrieving archives
Many of the advanced considerations for retrieving files are the same as they are
for restoring files. See these sections for more information:
v “Authorizing another user to restore or retrieve your files” on page 38
v “Restoring or retrieving another user’s files” on page 38
v “Restoring or retrieving your files to another workstation” on page 39

Performing a retrieve
Retrieve a file when you want to return an archive copy from the server to your
workstation. To retrieve an archived file using the GUI:
1. Click on Retrieve from the GUI main window. The Retrieve window appears.
2. Expand the folder tree. Select the object you want to retrieve. To search or filter

files, click on the Edit menu→ Find item.
3. To modify specific retrieve options click the Options button. The options you

select are effective during the current session only.
4. Click the Retrieve button. The Retrieve Destination window appears. Enter the

appropriate information.
5. Click on Retrieve. The Task List window displays the retrieve processing

status. The Retrieve Report window displays processing statistics.

Considerations:
v When the client starts up it is running with a UID of zero. This means that if

you create a folder to retrieve your files to, that folder is owned by root. To
access the files you must change the permissions of the folder. You can change
the folder owner from a terminal window using the sudo chown command.
Please see your operating system documentation for more information on how
to accomplish this.

v When retrieving files with the replace option set to no, existing files will not be
overwritten, but existing directories will. To leave existing directories intact
during a retrieve operation, select the Options button → All selected files and
directories dropdown menu → Files only option.

v When folders are retrieved from a UFS file system to an HFS file system and
they differ only in case, the client will retrieve the contents of both folders to
one folder.
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Chapter 7. Automating tasks

Your administrator can schedule Tivoli Storage Manager to perform tasks
automatically. For example, you can automatically back up files at the end of each
day or archive some of your files every Friday. This procedure, known as central
scheduling, is a cooperative effort between the server and your client node. Your
administrator associates clients with one or more schedules that are part of the
policy domain maintained in the server database. The administrator defines central
scheduling on the server and you start the client scheduler on your workstation.
Once you start the client scheduler, further intervention is not necessary.

With client scheduling, you can also:
v Display information about available schedules.
v Display information about work that the schedule has completed.
v Modify scheduling options in the preferences file.

Specifying scheduling options
You can modify scheduling options in the TSM System Preferences or in the
Preference editor. However, if your administrator specifies a value for these
options, that value overrides what you have in the client Preferences file.

For more information about scheduling options, changing the scheduling mode, or
specifying the TCP/IP address or port number, see “Scheduling options” on page
63.

Starting the client scheduler
You can run scheduling services in either the daemon mode or the standalone mode.
The daemon mode permits two programs to work together to provide the
scheduling service, while the standalone mode uses only the Scheduler program.

Starting in daemon mode
The scheduler daemon, a background application that operates in sleep mode until
it is time to run a schedule, starts the Scheduler program. The Scheduler program
then queries the server for the next schedule to run and performs the scheduled
action, such as a backup or restore, at the scheduled time. Using the scheduler
daemon during sleep mode requires very little memory.

To start the scheduler in daemon mode, follow these steps:
For Macintosh OS X:
1. Open the Login Preferences Panel.
2. Drag and drop the TSM Mac X Schedule Deamon into the Login Items

window.

Depending upon when your administrator has set your schedules to run, the
scheduler might run while you work. Clicking on another running application
places the scheduler in the background.

To stop the scheduler daemon or prevent it from starting after login, follow these
steps:
For Macintosh OS X:

© Copyright IBM Corp. 1993, 2003 45



1. Use the Force Quit command to stop the scheduler daemon.
2. To prevent the daemon from starting after login, remove the item from your

Login Preferences Panel.

Starting in standalone mode
When using the scheduler in standalone mode, it continues to run until you stop
it. This provides more control but requires more memory.

To use the standalone mode, follow these steps:
For Macintosh OS X:
1. Open the Login Preferences Panel.
2. Drag and drop the TSM Mac X Schedule into the Login Items window.

Notes:

1. You can also double-click the Scheduler icon, but it will not start up
automatically the next time you restart your workstation.

2. When the scheduler starts, the following message is added to the TSM
Schedule Log:

The Scheduler is under the control of the TSM Scheduler Daemon.

The daemon and the scheduler use a temporary file called TSMTimer.txt. On
Mac OS X, this file resides in the /private/tmp/0/Temporary Items directory. If
the scheduler is started in standalone mode and this file exists, the scheduler
will not work as expected. If the temporary file exists and the daemon is not
being used, remove the TSMTimer.txt file. You cannot use the scheduler in the
standalone mode and daemon mode at the same time.

The scheduler runs in the background. When you bring it to the foreground, the
Scheduler window displays either the amount of time remaining before the
schedule runs or the status of a backup or archive process. To quit the scheduler,
select Quit from the File menu.

Displaying information about completed work
After scheduled work is performed, check the schedule log to verify that all work
completed successfully. The schedule log continues to grow unless you prune it
using the schedlogretention option. See “Specifying scheduling options” on page 45
for more information.

Understanding the scheduler log
The scheduler log file provides information about which schedule runs next and
which files are processed. The default file name, TSM Scheduler Log, is created in
the application folder. Use the schedlogname option to change the location and
name of this file.

The schedule log continues to grow in size unless you prune it with the
schedlogretention option.

When the scheduler queries the server for the next schedule, it sends the schedule
information to the log file. The following information is logged:
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Table 13. Schedule log information

Category Description

Schedule name Specifies the name the administrator assigns to the schedule.

Action Specifies the type of task to perform on the files listed in the
Objects field:
v Incremental. Incrementally backs up the files.
v Selective. Backs up the files.
v Archive. Archives the files.
v Restore. Restores the files.
v Retrieve. Retrieves the files.
v Command. Runs the command shown in the Objects field.

Objects Names the volumes or files to process. If this field is empty for
an incremental backup, then the default domain is used.

Options Overrides options that you set for scheduling in your
Preferences file. See “Specifying scheduling options” on page 45
for more information about scheduling options.

Server window start Specifies the date and time when the next schedule will run. If
the server uses randomization for schedules, the schedule then
runs after the specified time.

Output from scheduled commands is sent to the log file. After scheduled work is
performed, check the log to ensure the work completed successfully.

When a scheduled command is processed the schedule log contains the following
entry:

Scheduled event eventname completed successfully

This is merely an indication that Tivoli Storage Manager successfully issued the
scheduled command associated with the eventname. No attempt is made to
determine the success or failure of the command. You should assess the success or
failure of the command by evaluating the return code from the scheduled
command in the schedule log. The schedule log entry for the command’s return
code is prefaced with the following text:

Finished command. Return code is:

You can modify the scheduling options in your Preferences file if you do not like
the current values. For more information about scheduling options, see
“Scheduling options” on page 63.
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Chapter 8. Understanding storage management policies

Storage management policies are rules your administrator defines in order to
manage your backups and archives on the server. You can associate (or bind) your
data to these policies; then when the data is backed up or archived, it is managed
according to policy criteria. Policy criteria include a policy domain, a policy set, a
copy group, and a management class.

Policies determine:
v Whether a file is eligible for backup or archive services.
v How many backup versions to keep.
v How long to keep inactive backup versions and archive copies.
v Where to place the copies in storage.
v For incremental backup, policies also determine:

– How frequently a file can be backed up.
– Whether a file must change before it is backed up again.

This chapter explains:
v Policy criteria (policy domains, policy sets, copy groups, and management

classes).
v How to display policies.
v How Tivoli Storage Manager associates your data with policies.

Using policy domains and policy sets
A policy domain is a group of clients with similar requirements for backing up and
archiving data. Policy domains contain one or more policy sets. An administrator
uses policy domains to manage a group of client nodes in a logical way. For
example, a policy domain might include:
v A department, such as Accounting.
v A physical location, such as a particular building or floor.
v A local area network, such as all clients associated with a particular file server.

Tivoli Storage Manager includes a default policy domain named Standard. At first,
your client node might be associated with the default policy domain. However,
your administrator can define additional policy domains if there are groups of
users with unique backup and archive requirements.

A policy set is a group of one or more management classes. Each policy domain can
hold many policy sets. The administrator uses a policy set to implement different
management classes based on business and user needs. Only one of these policy
sets can be active at a time. This is called the active policy set. Each policy set
contains a default management class and any number of additional management
classes.

Using management classes and copy groups
A management class is a collection of backup and archive copy groups that
establishes and contains specific storage management requirements for backing up
and archiving data. An administrator can establish separate management classes to
meet the backup and archive requirements for different kinds of data, such as:
v System data that is critical for the business.
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v Application data that changes frequently.
v Report data that Management reviews monthly.
v Legal information that must be retained indefinitely, requiring a large amount of

disk space.

Most of the work you do with storage management policies is with management
classes. You must associate (or bind) each file and folder that you back up and each
file that you archive with a management class. If you do not associate a file with a
management class, Tivoli Storage Manager uses the default management class in
the active policy set. If you do not specify a management class for folders, Tivoli
Storage Manager uses the management class in the active policy set with the
largest retain only setting.

You can use include statements in your include-exclude list to associate files with
management classes. See “Selecting a management class for files” on page 54 for
more information. In your Preferences file, you can associate folders with a
management class, using the dirmc option. See “Selecting a management class for
folders” on page 55 for more information.

Within a management class, the specific backup and archive requirements are in
copy groups. Copy groups define the specific storage management attributes that
describe how the server manages backed up or archived data. Copy groups
include both backup copy groups and archive copy groups. A management class can
have one backup copy group, one archive copy group, both, or neither.

A backup copy group contains attributes that are used during the backup process to
determine:
v Whether a file that has changed since the last backup is backed up again.
v How many days must elapse before a file is backed up again.
v How a file is processed during a backup if it is in use.

It also contains attributes to manage the backup versions of your files on the
server. These attributes control:
v Where the server stores backup versions of your files and folders.
v How many backup versions the server keeps of your files and folders.
v How long the server keeps backup versions of your files and folders.
v How long the server keeps inactive backup versions.
v How long the last version of a file is kept.

An archive copy group contains attributes that control:
v Whether a file is archived if it is in use
v Where the server stores archived copies of your files
v How long the server keeps archived copies of your files

When the server is unable to rebind a file to an appropriate management class, the
server uses one of two values to determine the number of days to retain the file. If
it is a backup version, the server uses backup grace period retention. If it is an
archive copy, the server uses archive grace period retention. For more information
about grace periods, see “Using a retention grace period” on page 56.
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Displaying information about management classes and copy groups
Before you select the management classes you want to use, click View policy
information from the Utilities menu. The Policy Information window is displayed.
You can then determine which management classes are available.

The Display policy information window provides the following information:
v The name of the default management class.
v The name of the policy domain to which the management class belongs.
v The policy set that is currently active.
v The date and time that this policy set became active.
v The number of backup versions which are maintained for files which still exist

on your workstation.
v The number of backup versions which are maintained for files which have been

deleted from your workstation.
v The number of days to keep inactive backup versions.
v The number of days to keep the last backup version.
v The management class name and a description.

Table 14 shows the default values for the backup and archive copy groups in the
standard management class. Each attribute is discussed in more detail immediately
following the table.

Table 14. Default values in the standard management class

Attribute Backup default Archive default

Copy group name Standard Standard

Copy type Backup Archive

Copy frequency 0 days CMD (Command)

Versions data exists Two versions Does not apply

Versions data deleted One version Does not apply

Retain extra versions 30 days Does not apply

Retain only version 60 days Does not apply

Copy serialization Shared static Shared static

Copy mode Modified Absolute

Copy destination Backuppool Archivepool

Retain versions Does not apply 365 days

Copy group name
The name of the copy group. The default value for both backup and archive is
Standard.

Copy type
The type of copy group. The value for backup is always Backup, and the value for
archive is always Archive.

Copy frequency
Copy frequency is the minimum number of days that must elapse between
successive incremental backups. Use this attribute during a full incremental
backup.
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Copy frequency works with the mode parameter. For example, if frequency is zero
(0) and mode is modified, a file or folder is backed up only if it changed since the
last incremental backup. If frequency is zero (0) and mode is absolute, a file is
backed up every time you run an incremental backup against it. This attribute is
not checked for selective backups.

For archive copy groups, copy frequency is always CMD (command). There is no
restriction on how often you archive a file.

Versions data exists
The Versions Data Exists attribute specifies the maximum number of different
backup versions retained for files and folders currently on your volume. If you
select a management class that permits more than one backup version, the most
recent version is called the active version. All other versions are called inactive
versions. If the maximum number of versions permitted is five, and you run a
backup that creates a sixth version, the oldest version is deleted from server
storage.

Versions data deleted
The Versions Data Deleted attribute specifies the maximum number of different
backup versions retained for files and folders that you erased from your volume.
This parameter is ignored as long as the file or folder remains on your volume.

If you erase the file or folder, the next time you run an incremental backup, the
active backup version is changed to inactive and the oldest versions are erased that
exceed the number specified by this parameter.

The expiration date for the remaining versions is based on the retain extra versions
and retain only version parameters.

Retain extra versions
The Retain Extra Versions attribute specifies how many days all but the most recent
backup version is retained. The most recent version is the active version, and
active versions are never erased. If Nolimit is specified, then extra versions are kept
until the number of backup versions exceeds the versions data exists or versions data
deleted parameter settings. In this case, the oldest extra version is deleted
immediately.

Retain only version
The Retain Only Version attribute specifies the number of days the last remaining
inactive version of a file or folder is retained. If Nolimit is specified, the last version
is retained indefinitely.

This parameter goes into effect during the next incremental backup after a file is
deleted from the client machine. Any subsequent updates to this parameter will
not affect files that are already inactive. For example: If this parameter is set to 10
days when a file is inactivated during an incremental backup, the file will be
expired in 10 days.

Copy serialization
The Copy Serialization attribute determines whether a file can be in use during a
backup or archive, and what to do if it is. The value for this attribute can be one of
the following:
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v Static. A file or folder must not be modified during a backup or archive. If the
object is changed during a backup or archive attempt, it is not backed up or
archived.

v Shared static. A file or folder must not be modified during backup or archive.
Tivoli Storage Manager attempts to perform a backup or archive as many as four
additional times, depending on the value specified on the changingretries option
in your Preferences file. If the object is changed during every backup or archive
attempt, it is not backed up or archived.

v Dynamic. A file or folder is backed up or archived on the first attempt
regardless of whether it changes during a backup or archive.

v Shared dynamic. A file or folder is backed up or archived regardless of whether
it changes during a backup or archive. Tivoli Storage Manager attempts to
perform a back up or archive as many as four additional times, depending on
the value specified on the changingretries option in your Preferences file without
the file changing during the attempt. The file is backed up or archived on the
last try even if it has changed.
Attention: Be careful when you select a management class containing a copy
group that specifies shared dynamic or dynamic for serialization backup. If you
select a management class that permits a file to be backed up or archived while
it is in use, the backup version or archived copy stored on the server might be a
fuzzy copy. A fuzzy copy is a backup version or archived copy that does not
accurately reflect what is currently in the file. It might contain some, but not all,
of the changes. If that is not acceptable, select a management class that creates a
backup version or archive copy only if the file does not change during a backup
or archive.

If you restore or retrieve a file that contains a fuzzy copy, the file might not be
usable. You should not use dynamic or shared dymamic serialization to back up
files, unless you are absolutely certain that a restore of a fuzzy copy will be
usable.

Copy mode
The Copy Mode attribute determines whether a file or folder is considered for
incremental backup regardless of whether it changed or not since the last backup.
Tivoli Storage Manager does not check the mode for selective backups. The value
for this parameter can be one of the following:
v Modified.The file is considered for incremental backup only if it has changed

since the last backup. A file is considered changed if any of the following are
true:
– The date or time of the last modification is different.
– The file size is different.
– The file attributes, with the exception of archive, are different. However, if

only the file meta-data changes (such as access permissions), but the file data
does not change, Tivoli Storage Manager may back up only the meta-data.

v Absolute. The file is considered for incremental backup regardless of whether it
changed since the last backup. For archive copy groups, the mode is always
absolute, indicating that a file is archived regardless of whether it changed since
the last archive request.

Copy destination
Names the destination where backups or archives are stored. The destination can
be either a storage pool of disk devices or a storage pool of devices that support
removable media, such as tape.
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Retain versions
Specifies the number of days an archived file remains in storage. When the
specified number of days elapse for an archived copy of a file, it is deleted from
server storage.

Selecting a management class for files
If the default management class meets the backup and archive requirements for all
the files on your workstation, it is not necessary to take any action to associate
your files with that management class. This is done automatically when you back
up or archive your files.

When selecting a different management class for your files, consider these
questions:
v Does the management class contain a backup copy group?

If you attempt to back up a file associated with a management class that does
not contain a backup copy group, the file is not backed up.

v Does the management class contain an archive copy group?
You cannot archive a file associated with a management class that does not
contain an archive copy group.

v Does the backup copy group contain attributes that back up your files often
enough?
Mode and frequency work together to control how often a file is backed up
when you use incremental backup. Tivoli Storage Manager does not check those
attributes for selective backup.

v Do the copy groups specify either static or shared static for serialization?
If serialization is shared dynamic or dynamic, you might get fuzzy backups or
archive copies. Verify that this is acceptable. For example, you might want to use
shared dynamic or dynamic serialization for a file to which log records are
continuously added. If you used static or shared static serialization, the file
might never back up because it is constantly in use. With shared dynamic or
dynamic serialization, the file is backed up, but the backup version of the file
might contain a truncated message. Do not use shared dynamic or dynamic
serialization for a file if it is very important that the backup version or archive
copy contain all changes.

v Does the backup copy group specify an adequate number of backup versions to
keep, along with an adequate length of time to keep them?

v Does the archive copy group specify an adequate length of time to keep
archived copies of files?

Assigning a management class to files
A management class defines when your files are included in a backup, how long
they are kept on the server, and how many versions of the file the server should
keep. The server administrator selects a default management class. You can specify
your own management class to override the default management class.

You can assign a management class for a file or file group by using an include
statement in your Preferences file. Management class names are not case-sensitive.
For example, to associate all the files in the costs folder with a management class
named budget, enter:

include"...:Costs:*" budget
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To specify a management class named managall to use for all files to which you
do not explicitly assign a management class, enter:

include * managall

The example below demonstrates how to use a management class:
exclude "...:...:*sno"
include "la pomme:winter:...:*Ice" mcweekly
include "la pomme:winter:december:*Ice" mcdaily
include "la pomme:winter:january:*Ice" mcmonthly
include "la pomme:winter:winter:white sno"

Processing follows these steps:
1. The file named white sno is backed up following bottom-up processing rules.

Because you did not specify a management class, the file is assigned to the
default management class.

2. Any file with an extension of ice in the la pomme:winter:january folder is
assigned to the management class, mcmonthly.

3. Any file with an extension of ice in the la pomme:winter:december folder is
assigned to the management class, mcdaily.

4. Any other files with an extension of ice in any directory under la
pomme:winter:december are assigned to the management class, mcweekly.

5. Any file with an extension of sno (except la pomme:winter:winter:white sno) in
any directory is excluded from backup.

To specify your own default management class for files that are not explicitly
included, specify:

include "...:*" mgmt_class_name

as the first include or exclude option defined.

Overriding the management class for archived files
When you archive a file, you can override the assigned management class using
the graphical user interface (GUI). To use the GUI, press the Options button on the
archive tree and select a different management class.

Selecting a management class for folders
If the management class in your active policy set containing the longest retention
period meets your backup requirements for folders, it is not necessary to associate
folders with that management class. Tivoli Storage Manager does it automatically
when it backs up your folders.

If the default management class does not meet your requirements, select a
management class with an adequate retention period specified on the retain only
version parameter. You should keep folders at least as long as you keep the files
associated with those folders.

Assigning a management class to folders
To assign a management class other than the default to folders, use the dirmc
option in your Preferences file. For example, to assign a management class named
folder1 to your folders, you would enter:

dirmc folder1
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Binding and rebinding management classes to files
Binding associates a file with a management class. When you back up a file for the
first time, Tivoli Storage Manager binds it to either the default management class
or the management class specified in your include-exclude list. In later full
incremental backups of the same file, if you change the management class, both
active and inactive versions are bound again to the new management class.
However, with selective backup and incremental-by-date backups, the new
backups are bound to the new management class, but previous backup versions
remain bound to the original management class.

If the backup copy group for the management class specifies keeping multiple
backup versions of the file, and you request multiple backups, the server always
has one active backup version (the current version) and one or more inactive
backup versions of the file. All backup versions of a file are bound to the same
management class and are managed based on the attributes in the backup copy
group.

When you archive a file for the first time, Tivoli Storage Manager binds it to the
default management class, to the management class specified in your
include-exclude list, or to a management class you specify when modifying your
archive options during an archive.

Archived files are never rebound to a different management class. If you change
the management class for a file, any previous copies of the file that you archived
remain bound to the management class specified when you archived them.

Rebinding backup versions of files
Backups of files are bound again to a different management class in the following
conditions. In each condition, the files (active and inactive) are not bound again
until the next backup.
v You specify a different management class in an Include statement to change the

management class for the file. The backups are managed based on the old
management class until you run another backup.

v Your administrator deletes the management class from your active policy set.
The default management class is used to manage the backup versions when you
back up the file again.

v Your administrator assigns your client node to a different policy domain and the
active policy set in that domain does not have a management class with the
same name. The default management class for the new policy domain is used to
manage the backup versions.

Using a retention grace period
Tivoli Storage Manager also provides a backup retention grace period and an archive
retention grace period to help protect your backup and archive data when it is
unable to rebind a file to an appropriate management class. The backup retention
grace period is used when:
v You change the management class for a file, but neither the default management

class nor the new management class contain a backup copy group.
v The management class to which a file is bound no longer exists, and the default

management class does not contain a backup copy group.
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The backup retention grace period, defined in your policy domain, starts when you
run an incremental backup. The default is 30 days. However, your administrator
can lengthen or shorten this period.

When Tivoli Storage Manager manages a file using the backup retention grace
period, it does not create any new backup versions of the file. All existing backup
versions of the file expire 30 days (or the number of days specified in your policy
domain) from the day they are marked inactive.

For archived files, if the management class to which a file is bound no longer
exists, and the default management class does not contain an archive copy group,
the archive retention grace period defined in your policy domain is used. The
default retention period is 60 days. However, your administrator can lengthen or
shorten this period.
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Chapter 9. Using processing options

You can use defaults for processing options or you can tailor the processing
options to meet your specific needs. This chapter:
v Provides an overview of processing options.
v Includes an options reference section that provides detailed information about

each option.

Overview of processing options
Tivoli Storage Manager uses processing options that you specify in your TSM System
Preferences or TSM User Preferences to control communications, backup-archive
processing, and other types of processing.

This section provides an overview of the following types of options that you can
use:
v Communication options
v Server and Node options
v Backup and archive processing options
v Restore and retrieve processing options
v Scheduling options
v Format and language options
v Authorization options
v Error processing options
v Transaction processing option

See Chapter 2, “Configuring Tivoli Storage Manager”, on page 7 for information on
how to create and modify your TSM System Preferences or TSM User Preferences
file.

Tivoli Storage Manager processes options in the following order (precedence):
1. Options defined on the server with server-enforced client options. The server

overrides client values.
2. Options defined on the server for a schedule using the options parameters.
3. Options entered locally in the options file.
4. Options received from the server with client options not enforced by the server.

The server does not override client values.
5. Default option values.

Communication options
You use communication options to specify how your client node communicates
with a Tivoli Storage Manager server.

Macintosh only supports the TCP/IP communication protocol. Use the
commmethod option to specify the TCP/IP communication protocol. For more
information, see “Commmethod” on page 70.

Ask your Tivoli Storage Manager administrator for assistance in setting your
communication options.
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TCP/IP options
To use the TCP/IP communication protocol, you must include the tcpserveraddress
option in your TSM System Preferences file. The other TCP/IP options have
default values which you can modify only if you want to change the default value.

Table 15. TCP/IP options

Option Description Page

tcpbuffsize Specifies the size, in kilobytes, of the Tivoli Storage
Manager internal TCP/IP communication buffer.

119

tcpport Specifies the TCP/IP port address for a Tivoli
Storage Manager server.

120

tcpserveraddress Specifies the TCP/IP address for a Tivoli Storage
Manager server.

121

tcpwindowsize Specifies the size, in kilobytes, of the TCP/IP
sliding window for your client node.

122

Server and Node options

Use the following options to specify the server to contact for backup-archive
services, and the client node for which to request backup-archive services.

Server options
Use the servername option in your TSM System Preferences file to begin a group of
options (stanza) used to connect to a Tivoli Storage Manager server. You can set up
multiple stanzas in the TSM System Preferences file to connect to different servers.
Each stanza must contain all options required to establish communication with a
server. The stanza can also contain other options for backup-archive operations.

If your TSM System Preferences file contains only one stanza - Your client node
contacts the server you specify in that stanza for all services.

If your TSM System Preferences file contains more than one stanza - You can specify a
default server with the defaultserver option. If you do not specify a default server,
by default Tivoli Storage Manager contacts the server you specify in the first
stanza of your TSM System Preferences file.

Place the defaultserver option at the beginning of your TSM System Preferences
file before any server stanzas.

Figure 1 on page 61 shows a sample TSM System Preferences file.
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Use the servername option in the TSM User Preferences file to specify a server to
contact for backup-archive services. This overrides the default server specified in
your TSM System Preferences file.

Node options
Table 16. Server and Node Options

Option Description Page

defaultserver The name of the Tivoli Storage Manager server to
contact for backup-archive services by default if
more than one server is defined in the TSM
System Preferences file.

76

nodename Use the nodename option in your TSM System
Preferences file within a server stanza to identify
your workstation to the server to establish
communications.

96

servername In the TSM System Preferences file, this option
specifies the name of a server. In the TSM User
Preferences file, this option specifies the Tivoli
Storage Manager server to contact for services.

116

virtualnodename The virtualnodename option specifies the node
name of your workstation when you want to
restore or retrieve files to a different workstation.

126

Backup and archive processing options
You can use the following options to control some aspects of backup and archive
processing.

Table 17. Backup and archive processing options

Option Description Page

autofsrename Specifies whether to rename an existing file space
on a Unicode-enabled server so a
Unicode-enabled file space can be created for the
current operation.

67

changingretries Specifies the number of retries when attempting
to back up or archive a file that is in use.

69

DEFAULTServer server2

SErvername server1
NODename node1
COMMMethod TCPip
TCPPort 1500
TCPServeraddress node.domain.company.com
PASSWORDAccess generate

SErvername server2
NODename node2
COMMMethod TCPip
TCPPort 1500
TCPServeraddress almvmd.almaden.ibm.com
PASSWORDAccess prompt

Figure 1. Sample TSM System Preferences file
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Table 17. Backup and archive processing options (continued)

Option Description Page

compressalways The compressalways option specifies whether to
continue compressing an object if it grows during
compression, or resend the object uncompressed.
Use this option with the compression option.

73

compression The compression option compresses files before
you send them to the server. Compressing your
files reduces data storage for backup versions
and archive copies of your files.

74

dirmc Specifies the management class to use for
directories. If you do not specify this option, the
client uses the management class in the active
policy set of your policy domain with the longest
retention period.

77

domain Specifies the volumes to include in your default
client domain for an incremental backup.

78

exclude
exclude.backup
exclude.file
exclude.file.backup

These options are equivalent. Use these options to
exclude a file or group of files from backup
services.

81

exclude.archive Excludes a file or a group of files that match the
pattern from archive services only.

81

exclude.compression Excludes files from compression processing if you
set the compression option to yes. This option
applies to backups and archives.

81

exclude.dir Excludes a directory, its files, and all its
subdirectories and their files from backup
processing.

81

exclude.fs Excludes file spaces matching a pattern. 81

guitreeviewafterbackup Specifies whether the client is returned to the
Backup, Restore, Archive, or Retrieve window
after a successful operation completes.

84

inclexcl Specifies the path and file name of an
include-exclude options file.

85

include
include.backup
include.file

These options are equivalent. Use these options to
include files or assign management classes for
backup processing.

87

include.archive Includes files or assigns management classes for
archive processing.

87

include.compression Includes files for compression processing if you
set the compression option to yes. This option
applies to backups and archives.

87

memoryefficientbackup Specifies a memory-saving backup algorithm for
incremental backups when used with the
incremental command.

95

subdir Specifies whether to include subdirectories of a
named directory.

117

tapeprompt Specifies whether you want Tivoli Storage
Manager to wait for a tape to mount if it is
required for a backup, archive, restore, or retrieve
process, or to be prompted for a choice.

118

62 IBM Tivoli Storage Manager for Macintosh: Backup-Archive Clients Installation and User’s Guide

||
|
|



Restore and retrieve processing options
The following options relate to restore and retrieve processing.

Table 18. Restore and retrieve processing options

Option Description Page

guitreeviewafterbackup Specifies whether the client is returned to the
Backup, Restore, Archive, or Retrieve window
after a successful operation completes.

84

localbackupset Specifies whether the Tivoli Storage Manager
GUI bypasses initial logon with the server to
restore a local backup set on a standalone
workstation.

91

replace Specifies whether to overwrite an existing file, or
to prompt you for your selection when you
restore or retrieve files.

108

subdir Specifies whether you want to include
subdirectories of a named directory.

117

tapeprompt Specifies whether you want Tivoli Storage
Manager to wait for a tape required for a restore
or retrieve to be mounted, or to prompt you for
your choice.

118

Scheduling options
You can use the following options to regulate central scheduling. Tivoli Storage
Manager uses scheduling options only when the Scheduler is running.

Table 19. Scheduling options

Option Description Page

maxcmdretries Specifies the maximum number of times the client
scheduler attempts to process a scheduled
command that fails.

94

postschedulecmd,
postnschedulecmd

Specifies a command to process after running a
schedule.

102

preschedulecmd,
prenschedulecmd

Specifies a command to process before running a
schedule.

104

queryschedperiod Specifies the number of hours the client scheduler
waits between unsuccessful attempts to contact the
server for scheduled work.

106

retryperiod Specifies the number of minutes the client
scheduler waits between attempts to process a
scheduled command that fails or between
unsuccessful attempts to report results to the
server.

111

schedcmddisabled Specifies whether to disable the scheduling of
generic commands specified by your Tivoli Storage
Manager administrator.

112

schedcompleteaction Specifies an action to take after a schedule has
been completed.

113

schedlogname Specifies the path and file name where you want
to store schedule log information.

114
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Table 19. Scheduling options (continued)

Option Description Page

schedlogretention Specifies the number of days to keep log file
entries in the schedule log, and whether to save
pruned entries.

115

Format and language options
You can use the following options to select different formats for date, time,
numbers, and for different languages if you have the appropriate client language
pack installed for that language.

Table 20. Format and language options

Option Description Page

dateformat Specifies the format for displaying dates. 75

language Specifies the language used for messages. 89

numberformat Specifies the format for displaying numbers. 97

timeformat Specifies the format for displaying time. 123

Command processing options
The following options apply when you use Tivoli Storage Manager commands.

Table 21. Command processing options

Option Description Page

matchallchar Specifies the character to use as a match-all
wildcard character.

92

matchonechar Specifies the character to use as a
match-one-character wildcard character.

93

quiet Limits the number of messages that display on
your screen during processing. This option can be
overidden by the server.

107

verbose Specifies that processing information should
display on your screen. The alternative is quiet.
This option can be overridden by the server.

125

Authorization options
These options control access to a Tivoli Storage Manager server.

Table 22. Authorization options

Option Description Page

password Specifies a Tivoli Storage Manager password. 98

passwordaccess Specifies whether you want to generate your
password automatically or set as a user
prompt.

99
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Table 22. Authorization options (continued)

Option Description Page

passworddir Specifies the directory in which you want to
store the automatically generated password for
your client node. The encryption key and
password are encrypted and stored in the
TSM.PWD file.

101

Error processing options
These options specify the name of the error log file and how Tivoli Storage
Manager treats the entries in the log file.

Table 23. Error processing options

Option Description Page

errorlogname Specifies the fully qualified path and file name of
the file where you want to store information about
errors that occur during processing.

79

errorlogretention Specifies how many days to maintain error log
entries before pruning, and whether to save the
pruned entries.

80

Transaction processing options
These options control how Tivoli Storage Manager processes transactions between
the client and server.

Table 24. Transaction processing options

Option Description Page

commrestartduration Specifies the maximum number of minutes you
want the client to try to reconnect to a Tivoli
Storage Manager server after a communication
error occurs.

71

commrestartinterval Specifies the number of seconds you want the
client to wait between attempts to reconnect to a
Tivoli Storage Manager server after a
communication error occurs.

72

largecommbuffers Specifies whether the client uses increased buffers
to transfer large amounts of data between the
client and the server.

90

resourceutilization Use the resourceutilization option in your TSM
System Preferences file within a server stanza to
regulate the level of resources the Tivoli Storage
Manager server and client can use during
processing.

109

Client options reference
The following sections contain detailed information about each of the Tivoli
Storage Manager processing options. Information for each option includes:
v A description of the option.
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v A syntax diagram of the option. The option name contains uppercase and
lowercase characters. The uppercase characters indicate the minimum
abbreviation you can use for the option name. See “Reading syntax diagrams”
on page viii for an explanation of these diagrams.

v Detailed descriptions of the option parameters. If the parameter is a constant (a
value that does not change), use the minimum abbreviation.

v Examples of using the option in the Preferences file.

Note: For options with a yes parameter, acceptable alternatives are 1, true, and on.
For options with a no parameter, acceptable alternatives are 0, false, and off.
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Autofsrename
The autofsrename option renames an existing file space on a server so that a
Unicode-enabled file space with the original name can be created for the current
operation.

When you specify autofsrename yes in your TSM System Preferences file, and the
server value of autofsrename is set to client, Tivoli Storage Manager generates a
unique name by appending _OLD to the file space name you specify in the current
operation. For example, Tivoli Storage Manager renames the file space Mac OS X
to Mac OS X_OLD. If the new file space name is too long, the suffix replaces the
last characters of the file space name, as follows:

"Mac OS X"

If the new file space name already exists on the server, Tivoli Storage Manager
renames the new file space ″Mac OS X_OLDx″, where x is a unique number.

Tivoli Storage Manager proceeds to create new Unicode-enabled file spaces that
contain only the data specified in the current operation. For example, if you
archive all of the .log files in the Mac OS X:logs folder, before the archive takes
place, the server renames the file space to ″Mac OS X_OLD″. The archive places
the data specified in the current operation into the Unicode-enabled file space
named ″Mac OS X″. The new Unicode-enabled file space now contains only the
:logs directory and the *.log files specified in the operation. Tivoli Storage Manager
stores all subsequent full and partial incremental, selective backup, and archive
data in the new Unicode-enabled file spaces.

Renamed file spaces remain on the server as stabilized file spaces. These file spaces
contain all the original data, which you can restore as long as they remain on the server.

Note: When an existing file space is renamed during Unicode conversion, any
access rules defined for the file space remain applicable to the original file
space. However, new access rules must be defined to apply to the new
Unicode file space, if necessary.

After installation perform a full incremental backup and rename all existing file
spaces that are not Unicode enabled and back up the files and directories within
them under the new Unicode-enabled file spaces. This operation requires increased
processing time and storage on the server.

File spaces that are not Unicode enabled can be viewed in the character set of the
locale from which Tivoli Storage Manager backed up the files. A workstation
running in a different locale may be unable to view or restore from these file
spaces. Unicode-enabled file spaces that are backed up in one locale are visible in
all other locales, provided that the workstation has the proper fonts installed. For
more information on migrating to Unicode-enabled file spaces, see “Migrating to
the Unicode-enabled client” on page 1.

To restore or retrieve from a file space that is not Unicode enabled, specify the
source on the server and the destination on the client.

Supported Clients
This option is valid for all Macintosh clients. The server can define the
autofsrename option and override the autofsrename setting on the client. The
Tivoli Storage Manager client API does not support this option.
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Preferences File
Place this option in the TSM System Preferences file.

Syntax

��
Prompt

AUTOFsrename
Yes
No

�!

Parameters
Yes Specifies that Tivoli Storage Manager automatically renames all file spaces

that are not Unicode enabled in the current backup or archive operation.

No Specifies that Tivoli Storage Manager does not rename file spaces that are not
Unicode enabled in the current backup or archive operation.

Prompt
Specifies that Tivoli Storage Manager prompts you whether to rename the file
spaces that are not Unicode enabled in the current operation. This is the
default.

Considerations:

1. This option applies only when the server sets the autofsrename option to
client.

2. When the client scheduler is running, the default behavior is to not prompt.
The next interactive session prompts you to rename the file space.

3. The client prompts one time per file space only. If you specify no at the prompt,
the client cannot rename the file spaces later. However, the Tivoli Storage
Manager administrator can rename the file spaces on the server.

4. When backing up files to a file space that is not Unicode enabled, the
Unicode-enabled client skips the files and directories with names containing
characters from a code page that is different from the current locale.

5. If files and directories with names containing characters from a code page other
than the current locale were previously backed up with a client that was not
Unicode enabled, they may be expired. The Unicode-enabled client expires
these files if you do not migrate the file space to a Unicode-enabled file space.
You can back up and archived these files to a Unicode-enabled file space.

Examples
TSM System Preferences:

autofsrename yes
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Changingretries
The changingretries option specifies how many additional times you want the
client to attempt to back up or archive a file that is in use.

Use this option only when serialization, an attribute in a management class copy
group, is shared static or shared dynamic.

With shared static serialization, if a file is open during an operation, the operation
repeats the number of times that you specify. If the file is open during each
attempt, the operation does not complete.

With shared dynamic serialization, if a file is open during an operation, the
operation repeats the number of times that you specify. The backup or archive
occurs during the last attempt whether the file is open or not.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� CHAngingretries numberretries �!

Parameters
numberretries

Specifies the number of times a backup or archive operation is attempted if the
file is in use. The range of values is zero through 4; the default is 4.

Examples
TSM System Preferences:

changingretries 3
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Commmethod
The commmethod option specifies the communication method you use to provide
connectivity for client-server communication.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� COMMMethod TCPip �!

Parameters
TCPip

The Transmission Control Protocol/Internet Protocol (TCP/IP) communication
method. This is the default.

Examples
TSM System Preferences:

commm tcpip
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Commrestartduration
The commrestartduration option specifies the maximum number of minutes you
want the client to try to reconnect to a Tivoli Storage Manager server after a
communication error occurs.

Note: A scheduled event will continue if the client reconnects with the server
before the commrestartduration value elapses, even if the event’s startup window
has elapsed.

You can use the commrestartduration option and the commrestartinterval in busy
or unstable network environments to decrease connection failures.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� COMMRESTARTDuration minutes �!

Parameters
minutes

The maximum number of minutes you want the client to attempt to
reconnect with a server after a communication failure occurs. The range of
values is zero through 9999; the default is 60.

Examples
TSM System Preferences:

commrestartduration 90
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Commrestartinterval
The commrestartinterval option specifies the number of seconds you want the
client to wait between attempts to reconnect to a Tivoli Storage Manager server
after a communication error occurs.

Note: Use this option only when commrestartduration is a value greater than zero.

You can use the commrestartduration option and the commrestartinterval in busy
or unstable network environments to decrease connection failures.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� COMMRESTARTInterval seconds �!

Parameters
seconds

The number of seconds you want the client to wait between attempts to
reconnect with a server after a communication failure occurs. The range of
values is zero through 65535; the default is 15.

Examples
TSM System Preferences:

commrestartinterval 30
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Compressalways
The compressalways option specifies whether to continue compressing an object if
it grows during compression, or resend the object uncompressed. Use this option
with the compression option.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
Yes

COMPRESSAlways
No

�!

Parameters
Yes File compression continues even if the file grows as a result of compression.

This is the default.

No Backup-archive client objects are resent uncompressed if they grow during
compression.

Examples
TSM User Preferences:

compressalways yes
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Compression
The compression option compresses files before you send them to the server.
Compressing your files reduces data storage for backup versions and archive
copies of your files. It can, however, affect Tivoli Storage Manager throughput. A
fast processor on a slow network connection benefits from compression, but a slow
processor on a fast network connection does not.

If you set the compressalways option to yes, compression continues even if the file
size increases. To stop compression if the file size grows, and resend the file
uncompressed, set the compressalways option to no.

If you set the compression option to yes, you can control compression processing in
the following ways:
v Use the exclude.compression option in your TSM System Preferences file to

exclude specific files or groups of files from compression processing. See
“Exclude options” on page 81 for more information.

v Use the include.compression option in your TSM System Preferences file to
include files within a broad group of excluded files for compression processing.
See “Include options” on page 87 for more information.

This option controls compression only if your administrator specifies that your
client node can compress files before sending them to the server.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

��
No

COMPRESSIon
Yes

�!

Parameters
No Files are not compressed before they are sent to the server. This is the default.

Yes Files are compressed before they are sent to the server.

Examples
TSM System Preferences:

compression yes
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Dateformat
The dateformat option specifies the format you want to use to display dates.

Note: When you change the date format and use the schedlogretention option to
prune the schedule log, Tivoli Storage Manager removes all entries in the
schedule log with a different date format when pruning the log. When you
change the date format and use the errorlogretention option to prune the
error log, Tivoli Storage Manager removes all entries in the error log with a
different date when pruning the log. When changing the date format, copy
the schedule log and error log if you want to preserve log entries that
contain a different date format.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� DATEformat format_number �!

Parameters
format_number

Displays the date using one of the following formats. Select the number that
corresponds to the date format you want to use:
1 MM/DD/YYYY
2 DD-MM-YYYY
3 YYYY-MM-DD
4 DD.MM.YYYY
5 YYYY.MM.DD

Examples
TSM User Preferences:

dateformat 3
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Defaultserver
Use the defaultserver option to specify the name of the Tivoli Storage Manager
server to contact for backup-archive services by default if more than one server is
defined in the TSM System Preferences file.

Preferences File
Place this option at the beginning of the TSM System Preferences file before any
server stanzas.

Syntax

�� DEFAULTServer servername �!

Parameters
servername

Specifies the name of the default server to which you back up or archive files.

Examples
TSM System Preferences:

defaults server_a
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Dirmc
The dirmc option specifies the management class you want to use for directories. If
you do not specify this option to associate a management class with directories, the
client program uses the management class in the active policy set of your policy
domain with the longest retention period. Select a management class for individual
directories that retains directories at least as long as it retains the files associated
with them.

If you specify a management class with this option, all directories specified in a
backup operation are bound to that management class.

The dirmc option specifies the management class of directories you back up and
does not effect archived directories. Archived directories are always bound to the
default management class.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� DIRMc mgmtclassname �!

Parameters
mgmtclassname

Specifies the name of the management class you want to associate with
directories. The client uses the management class name that you specify for all
directories that you back up. If you do not specify this option, the client
associates the management class with the longest retention period with
directories.

Examples
TSM System Preferences:

dirm managdir
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Domain
The domain option specifies the volumes that you want to include for incremental
backup in your client domain.

Notes:
1. The Tivoli Storage Manager client API does not support this option.
2. The server can also define this option.

Use the domain option in your TSM System Preferences file to define your default
client domain. Tivoli Storage Manager uses your default client domain when your
administrator defines a schedule to run an incremental backup for you, but does
not specify which volumes to process

If you do not use the domain option to specify volumes in your TSM System
Preferences file, Tivoli Storage Manager uses the all-local parameter as the default.

You can also exclude volumes by specifying the dash (-) operator before the
volumes. For example, in the following option Tivoli Storage Manager will process
all local volumes except for the home: volume:

domain ALL-LOCAL -home:

Note: You cannot use the (-) operator in front of a domain keyword such as
ALL-LOCAL.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� '
all-local

DOMain
domain
-domain

�!

Parameters
all-local

Backs up all local volumes. This is the default.

domain
Defines the volumes to include in your default client domain.

A volume name must be enclosed in quotes if it includes any spaces.

-domain
Defines the volumes to exclude in your default client domain.

Examples
TSM System Preferences:

domain all-local
domain all-local -home:
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Errorlogname
The errorlogname option specifies the fully qualified path and file name of the file
in which to store information about errors that occur during processing.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� ERRORLOGName filespec �!

Parameters
filespec

The fully qualified path and file name in which to store error log information.
If any part of the path you specify does not exist, Tivoli Storage Manager
attempts to create it.

The default file name is ’TSM Error Log’; it is placed in your current working
directory.

Examples
TSM System Preferences:

errorlogname "TSM Error Log"
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Errorlogretention
The errorlogretention option specifies how many days to maintain error log entries
before pruning, and whether to save the pruned entries. The error log is pruned
when the first error is written to the log after a Tivoli Storage Manager session is
started. If the only session you run is the client scheduler, and you run it
twenty-four hours a day, the error log might not be pruned according to your
expectations. Stop the session and start it again to prune the error log when the
next error is written.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

��
N D

ERRORLOGRetention
days S

�!

Parameters
N or days

Specifies how long to wait before pruning the error log.

N Do not prune the error log. This permits the error log to grow indefinitely.
This is the default.

days
The number of days to keep log file entries before pruning the log. The
range of values is zero through 9999.

D or S
Specifies whether to save the pruned entries. Enter a space or comma to
separate this parameter from the previous one.

D Discard the error log entries when you prune the log. This is the default.

S Save the error log entries when you prune the log.

The pruned entries are copied from the error log to TSM Error Pruned
Log.

Examples
TSM System Preferences:

errorlogretention 400 S
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Exclude options
The exclude options exclude objects from backup or archive services. For example,
you might want to exclude all temporary files, any local caches of network files, all
files that contain compiled object code that you can easily reproduce using other
methods, or your operating system files.

Notes:

1. With the exception of exclude.fs, when you exclude a file that was previously
included, existing backup versions become inactive during the next incremental
backup.

2. The server can define exclude options with the inclexcl option.

Exclude any system files that could corrupt the operating system when recovered.
You should also exclude the client directory containing the client files.

Attention: See “Excluding system files” on page 15 for a list of files that you
should always exclude.

Use wildcard characters to exclude a broad range of files. See “Including and
excluding groups of files” on page 15 for a list of wildcard characters that you can
use. Then, if necessary, use the include option to make exceptions.

To exclude an entire directory called any:test, enter the following:
exclude.dir any:test

To exclude subdirectories that begin with test under the any directory, enter the
following:

exclude.dir any:test*

Compression processing
If you want to exclude specific files or groups of files from compression processing
during a backup or archive operation, consider the following:
v You must set the compression option to yes to enable compression processing. If

you do not specify the compression option or you set the compression option to
no, Tivoli Storage Manager does not perform compression processing. See
“Compression” on page 74 for more information.
If you set the compression option to yes and no exclude.compression statements
exist, Tivoli Storage Manager considers all files for compression processing.

v Tivoli Storage Manager processes exclude.fs, exclude.dir, and other
include-exclude statements first. Tivoli Storage Manager then considers any
exclude.compression statements. For example, consider the following
include-exclude list:
exclude home:jones:proj1:*.*
exclude.compression home:jones:proj1:file.txt
include home:jones:proj1:file.txt

Tivoli Storage Manager examines the statements (reading from bottom to top)
and determines that the home:jones:proj1:file.txt file is a candidate for back up,
but is not a candidate for compression processing.

v Include-exclude compression processing is valid for backup and archive
processing only. The exclude.compression option does not affect whether files are
excluded from backup or archive processing, only whether they are excluded
from compression processing.
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v As with other include-exclude statements, you can use the inclexcl option to
specify a file which is in Unicode format which contains exclude.compression
statements specifying Unicode files. See “Inclexcl” on page 85 for more
information.

Preferences File
Place these options in the TSM System Preferences file within a server stanza.

Syntax

�� options pattern �!

exclude, exclude.backup, exclude.file, exclude.file.backup
These options are equivalent. Use these options to exclude a file or group of files
from backup services.

exclude.archive
Excludes a file or a group of files that match the pattern from archive services
only.

exclude.compression
Excludes files from compression processing if the compression option is set to
yes. This option applies to backups and archives.

exclude.dir
Excludes a directory, its files, and all its subdirectories and their files from
backup processing. For example, the statement exclude.dir test:dan:data1
excludes the test:dan:data1 directory, its files, and all its subdirectories and
their files.

exclude.fs
Excludes file spaces matching the pattern. The client does not consider the
specified file space for processing and the usual deleted-file expiration process
cannot occur. If you exclude a file space that was previously included, existing
backup versions remain on the server subject to retention rules specified in the
associated management class definition.

Parameters
pattern

Specifies the file or group of files that you want to exclude. End the pattern
with a file specification.

If the pattern begins with a single or double quote or contains any embedded
blanks or equal signs, you must surround the value in either single (’) or
double (″) quotation marks. The opening and closing quotation marks must be
the same type of quotation marks.

Examples
TSM System Preferences:

exclude ...:DeskTop
exclude HFS+:svt1:testdir:...:*
exclude.archive HFS+:svt1:testdir:...:*
exclude.fs HFS+:svt1:testdir:...:*
exclude.backup HFS+:svt1:testdir:...:*
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exclude.dir HFS+:svt1:testdir:...:*
exclude.file HFS+:svt1:testdir:...:*
exclude.compression home:jones:proj1:file.txt
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Guitreeviewafterbackup
The guitreeviewafterbackup option specifies whether the client returns to the
Backup, Restore, Archive, or Retrieve window after a successful operation
completes.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
No

GUITREEViewafterbackup
Yes

�!

Parameters
No Returns you to the Tivoli Storage Manager main window after a successful

operation completes. This is the default.

Yes Returns you to the Backup, Restore, Archive, or Retrieve window after a
successful operation completes.

Examples
TSM User Preferences:

guitreeviewafterbackup yes
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Inclexcl
The inclexcl option specifies the path and file name of an include-exclude options
file.

Multiple inclexcl statements are permitted. However, you must specify this option
for each include-exclude file.

Ensure that you store your include-exclude options file in a directory to which all
users have read access.

When processing occurs, the include-exclude statements within the include-exclude
file are placed in the list position occupied by the inclexcl option, in the same
order, and processed accordingly.

Considerations
The include-exclude file can be in Unicode or non-Unicode format. If you specify a
non-Unicode include-exclude file, the file name must be in the same code page as
the one that the client is running.

A Unicode include-exclude file provides the following benefits:
v Names with characters from another code page no longer have to be identified

with wildcard characters.
v File names and directories from any code page can be fully specified for the client

to process.

To create an include-exclude file in Unicode format, perform the following steps:
1. Open a text editor.
2. List your include and exclude statements. See Table 4 on page 14 for

include-exclude options you can use.
3. Click File and then click Save As. The Save As window is displayed.
4. Select the Save as Unicode checkbox, specify the file and target directory, and

save the file.
5. Place an inclexcl option specifying the include-exclude file you just created in

your TSM System Preferences file.

For more information about creating an include-exclude options file, see “Creating
an include-exclude list (optional)” on page 11.

Supported Clients
This option is valid for all the Macintosh OS X client only.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� INCLExcl filespec �!

Parameters
filespec

Specifies the path and file name of one include-exclude options file.
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Examples
TSM System Preferences:

inclexcl vol1:documents:backup.excl
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Include options
The include options specify one of the following:
v Objects within a broad group of excluded objects that you want to include for

backup and archive services.
v Objects to which you want to assign a specific management class and a

management class name.
v A management class to assign to all objects to which you do not explicitly assign

a management class.

If you do not assign a specific management class to objects, Tivoli Storage Manager
uses the default management class in the active policy set of your policy domain.

Notes:
1. The exclude.fs and exclude.dir statements override all include statements that

match the pattern.
2. The server can also define these options with the inclexcl option.

Compression processing
If you want to include specific files or groups of files for compression processing
during a backup or archive operation, consider the following:
v You must set the compression option to yes to enable compression processing. If

you do not specify the compression option or you set the compression option to
no, Tivoli Storage Manager does not perform compression processing. See
“Compression” on page 74 for more information.

v Tivoli Storage Manager processes exclude.fs, exclude.dir, and other
include-exclude statements first. Tivoli Storage Manager then considers any
include.compression statements. For example, consider the following
include-exclude list:
exclude home:jones:proj1:file.txt
include.compression home:jones:proj1:file.txt

Tivoli Storage Manager examines the exclude home:jones:proj1:file.txt
statement first and determines that home:jones:proj1:file.txt is excluded from
processing and is not a candidate for compression processing.

v Include-exclude compression processing is valid for backup and archive
processing only.

v As with other include-exclude statements, you can use the inclexcl option to
specify a file which is in Unicode format which contains include.compression
statements specifying Unicode files. See “Inclexcl” on page 85 for more
information.

See “Creating an include-exclude list (optional)” on page 11 for more information.

Preferences File
Place these options in the TSM System Preferences file within a server stanza.

Syntax

�� options pattern
mgmtclassname

�!
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include, include.backup, include.file
These options are equivalent. Use these options to include files or assign
management classes for backup processing.

include.archive
Includes files or assigns management classes for archive processing.

include.compression
Includes files for compression processing if you set the compression option to
yes. This option applies to backups and archives.

Parameters
pattern

Specifies the objects to include for backup or archive processing or to assign a
specific management class. End the pattern with a file specification.

If the pattern begins with a single or double quote or contains any embedded
blanks or equal signs, you must surround the value in either single (’) or
double (″) quotation marks. The opening and closing quotation marks must be
the same type of quotation marks.

mgmtclassname
Specifies the name of the management class to assign to the objects. If a
management class is not specified, the default management class is used.

Examples
TSM System Preferences:

include hfs+:svt1:testdir:*
include ...:Data:Test:Test*
include ...:System:...:* mgmtcls1
include ...:* managall
include.archive hfs+:svt1:testdir:*
include.compression home:jones:proj1:file.txt
include.backup home:proj:text:* mybackupclass
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Language
The language option specifies the national language in which to present client
messages.

You can use American English (ENU) with all clients. Currently, the Macintosh
client only supports American English (ENU).

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� LANGuage language �!

Parameters
language

Specifies the language you want to use.

Examples
TSM User Preferences:

language enu
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Largecommbuffers
The largecommbuffers option specifies whether the client uses increased buffers to
transfer large amounts of data between the client and the server. You can disable
this option when your workstation is running low on memory.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

��
No

LARGECOMmbuffers
Yes

�!

Parameters
No Specifies that increased buffers are not used to transfer large amounts of data

to the server. This is the default.

Yes Specifies that increased buffers are used to transfer large amounts of data to
the server.

Note: If you set the largecommbuffers option to yes in your TSM Preferences
file to enable large communication buffers, you may receive the following
error message when starting a Tivoli Storage Manager client:

ANS1030E System ran out of memory. Process ended.

For Mac OS 9, the fix for this problem is to raise the amount of memory the
application gets by selecting Get Info in the Finder, and increasing the
Preferred Size by at least 5MB. Consult your system documentation for help
on how to do this.

Examples
TSM System Preferences:

largecommbuffers yes
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Localbackupset
The localbackupset option specifies whether the Tivoli Storage Manager GUI
bypasses initial logon with the Tivoli Storage Manager server to restore a local
backup set on a standalone workstation. .

If you set the localbackupset option to yes, the GUI does not attempt initial logon
with the server. In this case, the GUI only enables the restore functionality.

If you set the localbackupset option to no (the default), the GUI attempts initial
logon with the server and enables all GUI functions.

Supported Clients
This option is valid for all Macintosh clients.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
No

LOCALbackupset
Yes

�!

Parameters
No Specifies that the GUI attempts initial logon with the server and enables all

functions. This is the default.

Yes Specifies that the GUI does not attempt initial logon with the server and
enables only the restore functionality.

Examples
TSM User Preferences:

localbackupset yes
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Matchallchar
The matchallchar option specifies the character to use as a match-all wildcard
character. For example, File* matches File1, FileA1, and File.

Preferences File
Place this option in the TSM System Preferences file within a server stanza before
any include or exclude statements.

Syntax

�� MATCHAllchar character �!

Parameters
character

Specifies a character to use as a match-all wildcard character. The default is an
asterisk (*). You can use any valid ASCII character for the matchallchar option
except Control+X or Control+Y. Do not use the same character for both the
matchallchar and the matchonechar option.

Examples
TSM System Preferences:

matchallchar *
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Matchonechar
The matchonechar option specifies the character to use as a match-one wildcard
character. For example, File? matches File1, but it does not match File or File10.

Preferences File
Place this option in the TSM System Preferences file within a server stanza before
any include or exclude statements.

Syntax

�� MATCHOnechar character �!

Parameters
character

Specifies a character to use as a match-one wildcard character. The default is a
question mark (?). You can use any valid ASCII character for the matchonechar
option, except Control+X or Control+Y. Do not use the same character for both
the matchallchar and the matchonechar option.

Examples
TSM System Preferences:

matchonechar #
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Maxcmdretries
The maxcmdretries option specifies the maximum number of times the client
scheduler (on your workstation) attempts to process a scheduled command that
fails. The command retry starts only if the client scheduler has not yet backed up a
file, never connected to the server, or failed before backing up a file. Use this
option only when the scheduler is running.

Your administrator can also set this option. If your administrator specifies a value
for this option, that value overrides what you specify in the TSM System
Preferences file after your client node successfully contacts the server.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� MAXCMDRetries maxcmdretries �!

Parameters
maxcmdretries

Specifies the number of times the client scheduler can attempt to process a
scheduled command that fails. The range of values is zero through 9999; the
default is 2.

Examples
TSM System Preferences:

maxcmdr 4
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Memoryefficientbackup
The memoryefficientbackup option specifies a memory-conserving algorithm for
processing incremental backups, that backs up one directory at a time, using less
memory. Use this option with the incremental command when your workstation is
memory constrained.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
Yes

MEMORYEFficientbackup
No

�!

Parameters
No Your client node uses the faster, more memory-intensive method when

processing incremental backups.

Yes Your client node uses the method that requires less memory when processing
incremental backups. This is the default.

Examples
TSM User Preferences:

memoryefficientbackup yes
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Nodename
Use the nodename option in your TSM System Preferences file within a server
stanza to identify your workstation to the server. You can use different node names
to identify multiple operating systems on your workstation.

If you do not specify this option in the TSM System Preferences file, Tivoli Storage
Manager prompts you for the node name when it starts.

When you use the nodename option, Tivoli Storage Manager prompts for the
password assigned to the node you specify, if a password is required.

If you want to restore or retrieve files from the server while you are working from
a different workstation, use the virtualnodename option. See “Virtualnodename” on
page 126 for more information.

When connecting to a server, the client must identity itself to the server. This login
identification is determined in the following manner:
v In the absence of a nodename entry in the TSM System Preferences file, or a

virtualnodename entry in the TSM User Preferences file, or a virtual node name
specified on a command line, the default login ID is the name that the hostname
command returns.

v If a nodename entry exists in the TSM System Preferences file, the nodename
entry overrides the name that the hostname command returns.

v If a virtualnodename entry exists in the TSM User Preferences file, or a virtual
node name is specified on a command line, it cannot be the same name as the
name returned by the hostname command. When the server accepts the virtual
node name, a password is required (if authentication is on), even if the
passwordaccess option is generate. When a connection to the server is
established, access is permitted to any file that is backed up using this login ID.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� NODename nodename �!

Parameters
nodename

Specifies a 1 to 64 character node name for which you want to request Tivoli
Storage Manager services. The default is the name of the workstation.

Permit the node name to default to the workstation name.

Examples
TSM System Preferences:

nodename cougar
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Numberformat
The numberformat option specifies the format you want to use to display numbers.

Use this option if you want to change the default number format for the language
of the message repository you are using.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� NUMberformat number �!

Parameters
number

Displays numbers using any one of the following formats. Specify the number
(1–6) that corresponds to the number format you want to use.
1 1,000.00
2 1,000,00
3 1 000,00
4 1 000.00
5 1.000,00
6 1’000,00

Examples
TSM User Preferences:

num 4
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Password
The password option specifies a Tivoli Storage Manager password. If you do not
specify this option and your administrator has set authentication to On, you are
prompted for a password when you start a Tivoli Storage Manager session.

Notes:

1. If the server prompts for a password, the password does not display as you
enter it.

2. If the Tivoli Storage Manager server name changes or Tivoli Storage Manager
clients are directed to a different Tivoli Storage Manager server, all clients must
re-authenticate with the server because the stored encrypted password must be
regenerated.

The password option is ignored when the passwordaccess option is set to generate.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� PASsword password �!

Parameters
password

Specifies a 1 to 63 character password. A password is not case-sensitive. Valid
characters include:

Characters
Description

A–Z Any letter, A through Z, uppercase or lowercase
0–9 Any number, 0 through 9
+ Plus
. Period
_ Underscore
- Hyphen
& Ampersand

Examples
TSM User Preferences:

password secretword
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Passwordaccess
The passwordaccess option specifies whether you want to generate your password
automatically or set as a user prompt. Your administrator can require a password
for your client node by enabling the authentication feature. Ask your administrator
if a password is required for your client node.

If a password is required, you can choose to:
v Set the password for your client node yourself and have Tivoli Storage Manager

prompt for it each time you request services.
v Let Tivoli Storage Manager automatically generate a new password for your

client node each time it expires, encrypt and store the password in a file, and
retrieve the password from that file when you request services. You are not
prompted for the password.

Use the passworddir option in your TSM System Preferences file to specify the
directory location in which to store the encrypted password file. The default
directory location depends on how the client was installed.

When the passwordaccess option is set to generate and you specify the password
option, the password option is ignored.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

��
prompt

PASSWORDAccess
generate

�!

Parameters
prompt

You are prompted for your workstation password each time a client connects
to the server. This is the default.

To keep your client node password secure, enter commands without the
password and wait for Tivoli Storage Manager to prompt you for the
password.

Each user must know the Tivoli Storage Manager password for your client
node. Any user who knows the password for your client node can gain access
to all backups and archives that originate from your client node. For example:
v If the user enters the node name and password for your client node from a

different client node, the user becomes a virtual root user.
v If you change the name of your client node (using the nodename option in

the TSM System Preferences file, and you specify the same node name in the
TSM User Preferences file, a user who enters the correct password becomes
a virtual root user. The same is true if a user specifies the same node name
using the nodename option with a command and enters the correct
password.

API applications must supply the password when a session is initiated. The
application is responsible for obtaining the password.
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generate
Encrypts and stores your password locally and generates a new password
when the old password expires.

A password prompt displays when registering a workstation with a server
using open registration or if your administrator changes your password
manually.

When logging in locally, users do not need to know the Tivoli Storage Manager
password for the client node. However, by using the nodename option at a
remote node, users can access files they own and files to which another user
grants access. If you change the name of your client node (using the nodename
option in the TSM System Preferences file, and you specify the same node
name in the TSM User Preferences file) Tivoli Storage Manager prompts the
users for the client node password. If a user enters the correct password, the
user becomes a virtual root user. The same is true if a user specifies the same
node name using the nodename option with a command.

Examples
TSM System Preferences:

passwordaccess generate
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Passworddir
The passworddir option specifies the directory location in which to store an
encrypted password file. The directory location depends upon where the client was
installed.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� PASSWORDDIR directoryname �!

Parameters
directoryname

Specifies the path in which to store the encrypted password file. The name of
the password file is TSM.PWD. If any part of the specified path does not exist,
Tivoli Storage Manager attempts to create it.

Examples
TSM System Preferences:

passworddir "HFS+"
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Postschedulecmd/Postnschedulecmd
The postschedulecmd option specifies a command that the client program processes
after it runs a schedule. The client program waits for the command to complete
before it continues with other processing.

If you do not want to wait, specify postnschedulecmd.

Notes:

1. Successful completion of the postschedulecmd command is considered a
prerequisite to running the scheduled operation. If the postschedulecmd
command does not complete with return code 0, the client will report that the
scheduled event completed with return code 8 (unless the scheduled operation
encounters a more severe error yielding a higher return code). If you do not
want the postschedulecmd command to be governed by this rule, you can
create a script or batch file that invokes the command and exits with return
code 0. Then configure postschedulecmd to invoke the script or batch file. The
return code for the postnschedulecmd command is not tracked, and does not
influence the return code of the scheduled event.

2. The server can also define the postschedulecmd option (and the
postnschedulecmd option).

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� POSTSchedulecmd
POSTNschedulecmd

″cmdstring″ �!

Parameters
″cmdstring″

Specifies the command to process. You can enter a command to be executed
after a schedule with this option. Use only one postschedulecmd option.

If the command string contains blanks, enclose the command string in double
quotes. If you placed double quotes within the command string, then enclose
the entire command string in single quotes.

Use a blank, or null, string for cmdstring if you want to prevent any commands
from running that the Tivoli Storage Manager server administrator uses for
postschedulecmd or preschedulecmd. If you specify a blank or null string on
either option, it prevents the administrator from using a command on both
options.

If your administrator uses a blank or null string on the postschedulecmd
option, you cannot run a post-schedule command.

The command string should specify an AppleScript to launch. If it is only a file
name, such as ″Database Script″, the client program searches for this file in the
Scripts folder inside the Tivoli Storage Manager folder. Otherwise, the
command string should contain the full path of the file, such as:

"La Pomme:Scripting:Database Script"
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Examples
TSM System Preferences:

postschedulecmd "restart database"

The command string is a valid command for restarting your database.
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Preschedulecmd/Prenschedulecmd
The preschedulecmd option specifies a command that the client program processes
before it runs a schedule. The client program waits for the command to complete
before it starts the schedule.

If you do not want it to wait, specify prenschedulecmd.

Notes:

1. Successful completion of the preschedulecmd command is considered to be a
prerequisite to running the scheduled operation. If the preschedulecmd
command does not complete with return code 0, the scheduled operation and
any postschedulecmd and postnschedulecmd commands will not run. The client
will report that the scheduled event failed, and the return code will be 12. If
you do not want the preschedulecmd command to be governed by this rule,
you can create a script or batch file that invokes the command and exits with
return code 0. Then configure preschedulecmd to invoke the script or batch file.
The return code for the prenschedulecmd command is not tracked, and does not
influence the return code of the scheduled event.

2. The server can also define the preschedulecmd option (and the prenschedulecmd
option).

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� PRESchedulecmd
PRENSchedulecmd

″cmdstring″ �!

Parameters
″cmdstring″

Specifies the command to process. Use only one preschedulecmd option. You
can enter a command to be executed before a schedule using this option.

If the command string contains blanks, enclose the command string in double
quotes. If you placed double quotes within the command string, then enclose
the entire command string in single quotes.

Use a blank or null string for cmdstring if you want to prevent any commands
from running that the Tivoli Storage Manager server administrator uses for
postschedulecmd and preschedulecmd. If you specify a blank or null string on
either option, it prevents the administrator from using a command on both
options.

If your administrator uses a blank or null string on the preschedulecmd option,
you cannot run a pre-schedule command.

The command string should specify an AppleScript to launch. If it is only a file
name, such as ″Database Script″, the client program searches for this file in the
Scripts folder inside the Tivoli Storage Manager folder. Otherwise, the
command string should contain the full path of the file, such as:

"La Pomme:Scripting:Database Script"
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Examples
TSM System Preferences:

preschedulecmd "quiesce database"

The command string is a valid command for quiescing your database.

This option is valid only on the initial command line. It is not valid in interactive
mode.
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Queryschedperiod
The queryschedperiod option specifies the number of hours you want the client
scheduler to wait between attempts to contact the server for scheduled work. This
option applies only when you set the schedmode option to polling. This option is
used only when the scheduler is running.

Your administrator can also set this option. If your administrator specifies a value
for this option, that value overrides the value set in your TSM System Preferences
file after your client node successfully contacts the server.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� QUERYSCHedperiod hours �!

Parameters
hours

Specifies the number of hours the client scheduler waits between attempts to
contact the server for scheduled work. The range of values is 1 through 9999;
the default is 12.

Examples
TSM System Preferences:

querysch 6
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Quiet
The quiet option limits the number of messages that display on your screen during
processing.

When you use the quiet option, error and processing information appears on your
screen, and messages are written to log files. If you do not specify quiet, the
default option, verbose is used.

Note: The server can also define the quiet option, overriding the client setting.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� QUIET �!

Parameters
There are no parameters for this option.

Examples
TSM User Preferences:

quiet
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Replace
The replace option specifies whether to overwrite existing files on your
workstation, or to prompt you for your selection when you restore or retrieve files.

Note: Replace prompting does not occur during a scheduled operation. If you set
the replace option to prompt, Tivoli Storage Manager skips files without
prompting during a scheduled operation.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
Prompt

REPlace
All
Yes
No

�!

Parameters
Prompt

You are prompted whether to overwrite a file that already exists on your
workstation. If the existing file is read-only, you are prompted whether to
overwrite it. This is the default.

All
All existing files are overwritten, including read-only files. If access to a file is
denied, you are prompted to skip or overwrite the file. No action is taken on
the file until there is a response to the prompt.

Yes
Any existing files are overwritten, except read-only files. If a file is read-only,
you are prompted to overwrite the file or skip it. No action is taken on the file
until there is a response to the prompt. If access to a file is denied, the file is
skipped.

No Existing files are not overwritten. No prompts will display.

Note: When restoring or retrieving files with the replace option set to no,
existing files will not be overwritten, but existing directories will. To leave
existing directories intact during a restore or retrieve operation, select the
Options button → All selected files and directories dropdown menu → Files
only option from the Tivoli Storage Manager GUI.

Examples
TSM User Preferences:

quiet
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Resourceutilization
Use the resourceutilization option in your TSM System Preferences file within a
server stanza to regulate the level of resources the Tivoli Storage Manager server
and client can use during processing.

Regulating backup and archive sessions
When you request a backup or archive, the client can use more than one session to
the server. The default is to use a maximum of two sessions; one to query the
server and one to send file data. The client can use only one server session if you
specify a resourceutilization setting of 1. The client is also restricted to a single
session if a user who is not an authorized user invokes a Macintosh client with
passwordaccess=generate specified.

A client can use more than the default number of sessions when connecting to a
server that is Version 3.7 or higher. For example, resourceutilization=10 permits up
to eight sessions with the server. Multiple sessions may be used for querying the
server and sending file data.

Multiple query sessions are used when you specify multiple volumes with a
backup or archive command. For example, if you enter:
inc filespaceA filespaceB

and you specify resourceutilization=5, the client may start a second session to
query files on file space B. Whether or not the second session starts depends on
how long it takes to query the server about files backed up on file space A. The
client may also try to read data from the file system and send it to the server on
multiple sessions.

Regulating restore sessions
When you request a restore, the default is to use a maximum of one session, based
on how many tapes the requested data is stored on, how many tape drives are
available, and the maximum number of mount points allowed for the node.

Notes:

1. If all of the files are on disk, only one session is used. There is no multi-session
for a pure disk storage pool restore. However, if you are performing a restore
in which the files reside on 4 tapes and some on disk, you could use up to 5
sessions during the restore.

2. The Tivoli Storage Manager server can set the maximum number of mount
points a node can use on the server using the MAXNUMMP parameter. If the
resourceutilization option value exceeds the value of the MAXNUMMP on the
server for a node, the backup can fail with an Unknown System Error message.

For example, if the data you want to restore is on 5 different tape volumes, the
maximum number of mount points is 5 for your node, and resourceutilization is
set to 3, then 3 sessions will be used for the restore. If you increase the
resourceutilization setting to 5, then 5 sessions will be used for the restore. There
is a 1 to 1 relationship to the number of restore sessions allowed and the
resourceutilization setting. Multiple restore sessions are only allowed for no query
restore operations.

Considerations
The following factors can affect the throughput of multiple sessions:
v The server’s ability to handle multiple client sessions. Is there sufficient memory,

multiple storage volumes, and CPU cycles to increase backup throughput?
v The client’s ability to drive multiple sessions (sufficient CPU, memory, etc.).
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v The configuration of the client storage subsystem. File systems that are striped
across multiple disks, using either software striping or RAID-5 can better handle
an increase in random read requests than a single drive file system. Additionally,
a single drive file system may not see performance improvement if it attempts to
handle many random concurrent read requests.

v Sufficient bandwidth in the network to support the increased traffic.

Potentially undesirable aspects of running multiple sessions include:
v The client could produce multiple accounting records.
v The server may not start enough concurrent sessions. To avoid this, the server

maxsessions parameter must be reviewed and possibly changed.
v A query node command may not summarize client activity.

Notes:
1. The Tivoli Storage Manager client API does not support this option.
2. The server can also define this option.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� RESOURceutilization number �!

Parameters
number

Specifies the level of resources the Tivoli Storage Manager server and client can
use during processing. The range of values that you can specify is 1 through
10.

Examples
TSM System Preferences:

resourceutilization 8
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Retryperiod
The retryperiod option specifies the number of minutes the client scheduler waits
between attempts to process a scheduled command that fails, or between
unsuccessful attempts to report results to the server. Use this option only when the
scheduler is running.

Your administrator can also set this option. If your administrator specifies a value
for this option, that value overrides the value in your TSM System Preferences file
after your client node successfully contacts the server.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� RETRYPeriod minutes �!

Parameters
minutes

Specifies the number of minutes the client scheduler waits between attempts to
contact the server, or to process a scheduled command that fails. The range of
values is 1 through 9999; the default is 20.

Examples
TSM System Preferences:

retryp 10
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Schedcmddisabled
The schedcmddisabled option specifies whether to disable the scheduling of
commands by the server action=command option on the define schedule server
command.

This option does not disable the preschedulecmd and postschedulecmd commands.
However, you can specify preschedulecmd or postschedulecmd with a blank or a
null string to disable the scheduling of these commands. Commands scheduled by
the server using the action=command option on the define schedule server
command may also be disabled in the same way.

Note: The server can also define this option.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

��
No

SCHEDCMDDisabled
Yes

�!

Parameters
Yes Specifies that Tivoli Storage Manager disables the scheduling of commands

by the server using the action=command option on the define schedule
server command.

No Specifies that Tivoli Storage Manager does not disable the scheduling of
commands by the server using the action=command option on the define
schedule server command. This is the default.

Examples
TSM System Preferences:

schedcmddisabled no
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Schedcompleteaction
The schedcompleteaction option specifies an action to take when a schedule
completes. This option is used only when the scheduler is running.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� SCHEDCOMpleteaction Quit
SHUTdown

�!

Parameters
Quit

The scheduler application quits when a schedule completes.

SHUTdown
Shuts down your workstation when a schedule completes. If there are other
applications opened with unsaved data, these applications might prompt the
user to save the data. This can prevent the workstation from shutting down
until the prompt is dismissed.

Examples
TSM System Preferences:

schedcompleteaction shutdown
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Schedlogname
The schedlogname option specifies the path and file name where you want to store
schedule log information. Use this option only when the scheduler is running.

Note: The Tivoli Storage Manager client API does not support this option.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� SCHEDLOGName filespec �!

Parameters
filespec

Specifies the path and file name where you want to store schedule log
information when processing scheduled work. If any part of the path you
specify does not exist, Tivoli Storage Manager attempts to create it.

If you specify a file name only, the file is stored in your default folder. The
default is the Tivoli Storage Manager application folder and a file name of
TSM Schedule Log. The TSM Schedule Log file cannot be a symbolic link.

Examples
TSM System Preferences:

schedlogn "HFS+:test"
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Schedlogretention
The schedlogretention option specifies the number of days to keep entries in the
schedule log, and whether to save the pruned entries. The schedule log is pruned
after a scheduled event completes.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� SCHEDLOGRetention
N

days

D

S
�!

Parameters
N or days

Specifies how long to wait before pruning the schedule log.

N Do not prune the log. This permits the log to grow indefinitely. This is the
default.

days
Specifies the number of days to keep log file entries before pruning. The
range of values is zero through 9999.

D or S
Specifies whether to save the pruned entries. Use a space or comma to separate
this parameter from the previous one.

D Discards the log entries when pruning the log. This is the default.

S Saves the log entries when pruning the log.

Tivoli Storage Manager copies the entries pruned from the log to TSM
Sched Pruned Log.

Examples
TSM System Preferences:

schedlogretention 30 S
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Servername
In your TSM System Preferences file, the servername option specifies the name you
want to use to identify a server and to begin a stanza containing options for that
server. You can name and specify options for more than one server.

The following example demonstrates how to specify options for two different
servers:

SErvername yakima
NODename node1
COMMMethod TCPip
TCPPort 1500
TCPServeraddress yakima.sanjose.ibm.com
PASSWORDAccess generate

SErvername server2
NODename node2
COMMMethod TCPip
TCPPort 1500
TCPServeraddress almvmd.almaden.ibm.com
PASSWORDAccess prompt

In your TSM User Preferences file, the servername option specifies which server, of
those named in your TSM System Preferences file, to contact for backup-archive
services. When specified in a client options file the servername option overrides the
default server specified in your TSM System Preferences file.

Note: If the Tivoli Storage Manager server name changes or Tivoli Storage
Manager clients are directed to a different Tivoli Storage Manager server, all
clients will need to have a new password initialized for the new server
name.

Preferences File
Place this option in the TSM System Preferences file (to begin a server stanza) or
the TSM User Preferences file.

Syntax

�� SErvername servername �!

Parameters
servername

In your TSM System Preferences file, specify the name you want to assign to a
particular server. In your TSM User Preferences file specify the name of the
server you want to contact for backup-archive services. A server name is not
case sensitive; it can have up to 64 characters.

Examples
TSM System Preferences or TSM User Preferences:

servername yakima
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Subdir
The subdir option specifies whether you want to include subdirectories of named
directories for processing during backup, archive, restore, retrieve, and query
operations.

For example, if you set the subdir option to yes when backing up a specific path
and file, Tivoli Storage Manager recursively backs up all subdirectories under that
path, and any instances of the specified file that exist under any of those
subdirectories.

Note: The server can also define this option.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
No

SUbdir
Yes

�!

Parameters
No Subdirectories are not processed. This is the default.

Yes Subdirectories are processed. Because the client program searches all
subdirectories of a directory that is being processed, processing can take
longer to complete. Specify Yes only when necessary.

Examples
TSM User Preferences:

subdir no
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Tapeprompt
The tapeprompt option specifies whether you want Tivoli Storage Manager to wait
for a tape to mount if it is required for a backup, archive, restore, or retrieve
process, or to be prompted for a choice.

In the Tivoli Storage Manager GUI, the Media Mount dialog can display the Not
Available value in the Device and Volume Label fields if you perform a standard
(also known as classic) restore or retrieve operation. This value means that this
information is only available for no query restore or retrieve operations; not a
standard restore or retrieve operation. The Device field displays the name of the
device on which to mount the media needed to process an object. The Volume
Label field displays the name of the volume needed to process an object. See “No
query restore” on page 33 for a discussion of standard and no query restore
operations.

Tape prompting does not occur during a scheduled operation regardless of the
setting for the tapeprompt option.

Note: The server can also define this option.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

��
No

TAPEPrompt
Yes

�!

Parameters
No You are not prompted for your choice. The server waits for the appropriate

tape to mount. This is the default.

Yes You are prompted when a tape is required to back up, archive, restore, or
retrieve data. At the prompt, you can wait for the appropriate tape to be
mounted, always wait for a tape to be mounted, skip a particular object, skip
all objects on a single tape, skip all objects on all tapes, or cancel the entire
operation.

Examples
TSM User Preferences:

tapeprompt yes
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Tcpbuffsize
The tcpbuffsize option specifies the size of the internal TCP/IP communication
buffer used to transfer data between the client node and server. Although it uses
more memory, a larger buffer can improve communication performance.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� TCPBuffsize size �!

Parameters
size

Specifies the size, in kilobytes, that you want to use for the internal TCP/IP
communication buffer. The range of values is 1 through 512; the default is 16.

Depending on the operating system communication settings, your system
might not accept all values in the range of 1 through 512.

Examples
TSM System Preferences:

tcpb 2
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Tcpport
The tcpport option specifies a TCP/IP port address for a Tivoli Storage Manager
server. You can obtain this address from your administrator.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� TCPPort port_address �!

Parameters
port_address

Specifies the TCP/IP port address that is used to communicate with a server.
The range of values is 1000 through 32767; the default is 1500.

Examples
TSM System Preferences:

tcpp 1501
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Tcpserveraddress
The tcpserveraddress option specifies the TCP/IP address for a Tivoli Storage
Manager server. You can obtain this port address from your administrator.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� TCPServeraddress server_address �!

Parameters
server_address

Specifies a 1 to 64 character TCP/IP address for a server.

Examples
TSM System Preferences:

tcps dsmchost.xyzcompany.vas.com
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Tcpwindowsize
Use the tcpwindowsize option to specify, in kilobytes, the size you want to use for
the TCP/IP sliding window for your client node. The sending host cannot send
more data until it receives an acknowledgment and a TCP receive window update.
Each TCP packet contains the advertised TCP receive window on the connection. A
larger window allows the sender to continue sending data and may improve
communication performance, especially on fast networks with high latency.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� TCPWindowsize window_size �!

Parameters
window_size

Specifies the size, in kilobytes, to use for your client node TCP/IP sliding
window. The range of values is 1 through 128; the default is 16.

Notes:

1. The TCP window acts as a buffer on the network. It is not related to the
tcpbuffsize option, or to the send and receive buffers allocated in client or
server memory.

2. A window size larger than the buffer space on the network adapter might
degrade throughput due to resending packets that were lost on the adapter.

3. Depending on the operating system communication settings, your system
might not accept all values in the range of values.

Examples
TSM System Preferences:

tcpwindowsize 1
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Timeformat
The timeformat option specifies the format in which you want to display system
time.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� TIMEformat format_number �!

Parameters
format_number

Displays time in one of the formats listed below. Select the format number that
corresponds to the format you want to use.
1 23:00:00 (This is the default)
2 23,00,00
3 23.00.00
4 12:00:00 A/P

Examples
TSM User Preferences:

timeformat 4
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Txnbytelimit
The txnbytelimit option specifies the number of kilobytes the client program
buffers before it sends a transaction to the server. A transaction is the unit of work
exchanged between the client and server. Because the client program can transfer
more than one file or directory between the client and server before it commits the
data to server storage, a transaction can contain more than one file or directory.
This is called a transaction group.

This option permits you to control the amount of data sent between the client and
server before the server commits the data and changes to the server database, thus
changing the speed with which the client performs work. The amount of data sent
applies when files are batched together during backup or when receiving files from
the server during a restore procedure.

The server administrator can limit the number of files or directories contained
within a transaction group using the txngroupmax option; the actual size of a
transaction can be less than your limit. Once this number is reached, the client
sends the files to the server even if the transaction byte limit is not reached.

Preferences File
Place this option in the TSM System Preferences file within a server stanza.

Syntax

�� TXNBytelimit number �!

Parameters
number

Specifies the number of kilobytes the client program can buffer together in a
transaction before it sends data to the server. The range of values is 300
through 2097152 (2 GB); the default is 2048.

Examples
TSM System Preferences:

txnb 2048
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Verbose
The verbose option specifies that you want processing information to display on
your screen. This is the default.

The information displays on your screen in the Scheduler Status window. This
option only applies when you are running the scheduler and Tivoli Storage
Manager is performing scheduled work.

Note: The server can also define this option.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� VErbose �!

Parameters
There are no parameters for this option.

Examples
TSM User Preferences:

verbose
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Virtualnodename
The virtualnodename option specifies the node name of your workstation when
you want to restore or retrieve files to a different workstation.

When you use the virtualnodename option in your TSM User Preferences file:
v You must specify the name you specified with the nodename option in your

TSM User Preferences file.
v Tivoli Storage Manager prompts for the password assigned to the node you

specify, if a password is required. If you enter the correct password, you have
access to all backups and archives that originated from the specified node.

When connecting to a server, the client must identity itself to the server. This login
identification is determined in the following ways:
v If the nodename and virtualnodename options are not specified, you are

prompted for a node name.
v If the virtualnodename option is specified, it cannot be the same name as the

name specified by the nodename option.

When the virtual node name is accepted by the server, a password is required
(assuming authentication is on), even if the passwordaccess option is generate.
Once a connection to the server is established, then access is permitted to any file
backed up using this login ID.

Preferences File
Place this option in the TSM User Preferences file.

Syntax

�� VIRTUALNodename nodename �!

Parameters
nodename

Specifies a 1- to 64-character name that identifies the node for which you want
to request Tivoli Storage Manager services. There is no default.

Examples
TSM User Preferences:

virtualnodename cougar

126 IBM Tivoli Storage Manager for Macintosh: Backup-Archive Clients Installation and User’s Guide



Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Notices References in this
publication to Tivoli Systems or IBM products, programs, or services do not imply
that they will be available in all countries in which Tivoli Systems or IBM operates.
Any reference to these products, programs, or services is not intended to imply
that only Tivoli Systems or IBM products, programs, or services can be used.
Subject to valid intellectual property or other legally protectable right of Tivoli
Systems or IBM, any functionally equivalent product, program, or service can be
used instead of the referenced product, program, or service. The evaluation and
verification of operation in conjunction with other products, except those expressly
designated by Tivoli Systems or IBM, are the responsibility of the user. Tivoli
Systems or IBM may have patents or pending patent applications covering subject
matter in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Information Enabling Requests
Dept. M13
5600 Cottle Road
San Jose CA 95193-0001
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States, other countries, or both:

AIX
IBM
IBMLink
Magstar
OS/390
OS/400
pSeries
RACF
Redbooks
RISC System/6000
RS/6000

Scalable POWERparallel Systems
SP2
S/390
System/390
Tivoli
Tivoli Enterprise Console
TME
VisualAge
z/OS
zSeries

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Microsoft, Windows, Windows 2000, Windows XP, and Windows Server 2003, and
the Windows logo are trademarks of Microsoft Corporation in the United States,
other countries, or both.
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Intel and Pentium are trademarks of Intel Corporation in the United States, other
countries, or both.

Jaz and Zip are trademarks or registered trademarks of Iomega Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Unicode is a trademark of Unicode, Inc.

Other company, product and service names may be trademarks or service marks of
others.
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Glossary

The terms in this glossary are defined as they pertain to the IBM Tivoli Storage
Manager library. If you do not find the term you need, refer to the IBM Software
Glossary on the Web at this address: www.ibm.com/ibm/terminology/. You can
also refer to IBM Dictionary of Computing, New York: McGraw-Hill, 1994.

This glossary may include terms and definitions from:
v The American National Standard Dictionary for Information Systems, ANSI

X3.172-1990, copyright (ANSI). You can purchase copies from the American
National Standards Institute, 11 West 42nd Street, New York, New York 10036.

v The Information Technology Vocabulary, developed by Subcommittee 1, Joint
Technical Committee 1, of the International Organization for Standardization and
the International Electrotechnical Commission (ISO/IEC JTC2/SC1).

A
absolute. A copy group mode value that indicates a file is considered for incremental backup even though the file
has not changed since the last time it was backed up. See mode. Contrast with modified.

access control list (ACL).

1. In computer security, a collection of all access rights for one object.

2. In computer security, a list associated with an object that identifies all the subjects that can access the object and
their access rights; for example, a list associated with a file that identifies users who can access the file and
identifies their access rights to that file.

ACL. access control list

active policy set. The policy set within a policy domain that contains the most recently activated policy. All client
nodes assigned to the current policy domain use this policy set. See policy set.

active version. The most recent backup copy of a file stored in Tivoli Storage Manager storage for a file that
currently exists on a file server or workstation. An active version remains active and exempt from deletion until:
v Replaced by a new backup version.
v Tivoli Storage Manager detects, during an incremental backup, that the user has deleted the original file from a file

server or workstation.

administrative client. A program that runs on a file server, workstation, or mainframe. This program lets
administrators monitor and control Tivoli Storage Manager servers using administrator commands. Contrast with
backup-archive client.

administrator. A user who is registered to the server as an administrator. Administrators may possess one or more
privilege classes. Administrators can use the administrative client to enter Tivoli Storage Manager server commands
and queries according to their privileges.

aggregate data transfer rate. Dividing the total number of bytes transferred by the elapsed processing time
calculates the data transfer rate.

archive. A function permitting users to copy one or more files to a long-term storage device. Archive copies can:
v Carry associated descriptive information
v Be compressed to minimize storage requirements
v Be retrieved by archive date, file name, or description

Contrast with retrieve.

archive copy. A file or group of files residing in an archive storage pool in Tivoli Storage Manager storage.
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archive copy group. A policy object containing attributes that control the generation, destination, and expiration of
archived files. The archive copy group belongs to a management class.

archive retention grace period. The number of days Tivoli Storage Manager retains an archived copy when the
server is unable to rebind the file to an appropriate management class.

authentication. The process of checking and authorizing a user’s password before permitting user access to the
Tivoli Storage Manager server. An administrator with system privilege can enable or disable authentication.

authorization rule. A specification permitting another user to either restore or retrieve a user’s files from Tivoli
Storage Manager storage.

Authorized User. A user who has administrative authority for the Tivoli Storage Manager client on a workstation.
This user changes passwords, performs open registrations, and deletes file spaces. An Authorized User is any user
running with a real user ID of 0 (root) or a user who owns an executable whose owner execution permission bit is
set to s. In the following example, the user tivoli is an Authorized User while running dsmc since the dsmc owner
execution permission bit is set to s:

-rwsr-xr-x 1 tivoli dsmdev 2880479 Nov 5 13:42 Tivoli Storage Manager

B
backup. A function permitting users to copy one or more files to a storage pool to protect against data loss.
Contrast with restore.

backup-archive client. A program that runs on a file server, PC, or workstation and provides a means for users to
back up, archive, restore, and retrieve files. Contrast with administrative client.

backup copy group. A policy object that contains attributes controlling the generation, destination, and expiration of
backup files. The backup copy group belongs to a management class.

backup retention grace period. The number of days Tivoli Storage Manager retains a backup version when the
server is unable to rebind the file to an appropriate management class.

backup set. A collection of active files in your file spaces that reside on the Tivoli Storage Manager server. The
Tivoli Storage Manager administrator creates the backup set and copies it onto portable media device that is
supported by the Tivoli Storage Manager server and client.

backup version. A backed up file, directory, or file space that resides in a backup storage pool in Tivoli Storage
Manager storage. The active version is the most recent backup version. See active version and inactive version.

binding. The process of associating a file with a management class name.

boot. To prepare a computer system for operation by loading an operating system.

C
central scheduling. A function permitting an administrator to schedule backup and archive operations from a
central location. Schedule operations on a periodic basis or on an explicit date.

client. A program running on a file server, PC, workstation, or terminal that requests services of another program
called the server. There are two types of Tivoli Storage Manager clients: administrative and backup-archive. See
administrative client and backup-archive client.

client domain. The set of drives, file systems, or volumes selected by a user for processing during a backup or
archive operation.

client node. A file server or workstation registered with the server on which the backup-archive client program is
installed.

client polling. A client and server communication technique where the client node queries the server for scheduled
work.
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client/server. A communications network architecture in which one or more programs (clients) request computing or
data services from another program (the server).

closed registration. A registration process in which a Tivoli Storage Manager administrator must register
workstations as client nodes with the server. Contrast with open registration.

command-click (Macintosh). Click on an item while pressing the Command key. In file and folder lists, this
deselects individual items embedded in a group of selected items.

command line interface. A type of user interface where commands are specified on the command line. Contrast
with graphical user interface.

communication method. The method by which a client and server exchange information. For Tivoli Storage
Manager backup-archive clients, the method can be TCP/IP. See Transmission Control Protocol/Internet Protocol.

communication protocol. A set of defined interfaces that permits computers to communicate with each other.

copy group. A policy object that contains attributes that control backup and archive file:
v Generation
v Destination
v Expiration.

Backup and archive copy groups belong to management classes. See frequency, destination, mode, retention, serialization,
and version.

D
default management class. A management class assigned to a policy set. This class is used to govern backed up or
archived files when a user does not explicitly associate a file with a specific management class through the
include-exclude list.

destination. A copy group attribute that specifies the storage pool in which to back up or archive a file. At
installation, Tivoli Storage Manager provides two storage destinations named backuppool and archivepool.

domain. See policy domain or client domain.

drag. Move the mouse while holding down the mouse button, thus moving the selected object.

drag-and-drop. Move (drag) an object on top of another object and release the mouse button, thus relocating the
object.

dsm.opt file. See options file. . Also called client options file.

dynamic. A copy group serialization value that specifies Tivoli Storage Manager accept the first attempt to back up
or archive an object, regardless of any changes made during backup or archive processing. See serialization. Contrast
with shared dynamic, shared static, and static.

E
error log. A text file written on disk that contains Tivoli Storage Manager processing error messages. The Tivoli
Storage Manager server detects and saves these errors.

exclude. To identify files in an include-exclude list that you do not want to include in a specific client operation,
such as backup or archive.

exabyte (EB). (1) For processor storage, real and virtual storage, and channel volume, 1,152,921,504,606,846,976
bytes. (2) For disk storage capacity and communications volume, 1,000,000,000,000,000,000 bytes.

expiration. The process in which files are identified for deletion because their expiration date or retention period is
passed. Backups or archives are marked for deletion based on the criteria defined in the backup or archive copy
group.
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expiring file. A migrated or premigrated file that is marked for expiration and removal from Tivoli Storage
Manager storage. If a stub file or an original copy of a premigrated file is deleted from a local file system, or if the
original copy of a premigrated file is updated, the corresponding migrated or premigrated file is marked for
expiration the next time reconciliation is run. It expires and is removed from Tivoli Storage Manager storage after the
number of days specified with the migfileexpiration option have elapsed.

F
file server. A dedicated computer and its peripheral storage devices connected to a local area network that stores
both programs and files shared by users on the network.

file space. A logical space on the Tivoli Storage Manager server that contains a group of files. In Tivoli Storage
Manager, users can restore, retrieve, or delete file spaces from Tivoli Storage Manager storage. A file space for
systems:
v Windows— file spaces for removable media are identified by volume label. Fixed drive file spaces are identified

by Universal Naming Convention (UNC) name.
v UNIX — Logical space that contains a group of files backed up or archived from the same file system, or part of a

file system defined with the virtualmountpoint option in the client system options file.

frequency. A copy group attribute that specifies the minimum interval, in days, between incremental backups.

fuzzy backup. A backup version of a file that might not accurately reflect what is currently in the file because the
file was backed up at the same time as it was being modified.

fuzzy copy. An archive copy of a file that might not accurately reflect what is currently in the file because Tivoli
Storage Manager archived the file while the file was being modified.

G
generate password. Processing that stores a new password in an encrypted password file when the old password
expires. Automatic generation of a password prevents password prompting. Password generation can be set in the
options file (passwordaccess option). See options file.

gigabyte (GB). (1) One billion (109) bytes. (2) When referring to memory capacity, 1 073 741 824 in decimal notation.

graphical user interface (GUI). A graphical user interface offers pictoral rather than text-based access to a computer.
A graphical user interface includes:
v A combination of graphics and icons
v Use of a mouse or pointing device
v Menu bars, dropdown lists, and overlapping windows

Contrast with command line interface. See windowed interface.

GUI. Graphical user interface.

H
hierarchical storage management client. A program that runs on a workstation or file server to provide space
management services. The hierarchical storage management client automatically migrates eligible files to Tivoli
Storage Manager storage to maintain specific levels of free space on local file systems. Automatic recalls are made for
migrated files when they are accessed. Users are also permitted to migrate and recall specific files.

HSM. Hierarchical Storage Management.

I
inactive version. A copy of a backup file in Tivoli Storage Manager storage that either is not the most recent
version, or the corresponding original file was deleted from the client file system. Inactive backup versions are
eligible for expiration according to the management class assigned to the file.
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include-exclude file. A file containing statements to determine the files to back up and the associated management
classes to use for backup or archive. See include-exclude list.

include-exclude list. A list of include and exclude options that include or exclude selected files for backup. An
exclude option identifies files that should not be backed up. An include option identifies files that are exempt from
the exclusion rules or assigns a management class to a file or a group of files for backup or archive services. The
include-exclude list is defined in one or more include-exclude files or in the client options file. . See options file.

incremental backup. A function that permits user to back up new or changed files or directories from a client
domain or from specified directories or files. These directories or files are not excluded in the include-exclude list and
meet the requirements for frequency, mode, and serialization as defined by a backup copy group of the management
class assigned to each file. Contrast with selective backup.

IPL. Initial Program Load. See boot and reboot.

L
LAN. Local area network.

Local Area Network (LAN). A variable-sized communications network placed in one location. LAN connects
servers, PCs, workstations, a network operating system, access methods, and communications software and links.

logical unit number (LUN). A logical unit number (LUN) is a unique identifier used on a SCSI bus that enables it
to differentiate between up to eight separate devices (each of which is a logical unit). Each LUN is a unique number
that identifies a specific logical unit, which may be a hard disk, tape drive, or other device which understands the
SCSI protocol.

M
management class. A policy object that is a named collection of copy groups. A management class is associated with
a file to specify how the server should manage backup versions or archive copies of workstation files. See binding
and copy group.

mode. A copy group attribute that specifies whether a backup file should be created for a file that was not modified
since the last time the file was backed up. See absolute and modified.

modified. A backup copy group attribute indicating a file is considered for backup only if the file has been changed
since the last backup. A file is considered changed if the date, size, owner, or permissions have changed. See absolute
and mode.

N
network data transfer rate. The data transfer rate calculated by dividing the total number of bytes transferred by
the data transfer time. For example, the time spent transferring data over the network.

node. See client node.

node name. A unique name used to identify a workstation, file server, or PC to the server.

non-Unicode file space. Non-Unicode file spaces and file names are limited to the character set of the current locale
when the files were backed up.

O
open registration. A registration process in which users can register their own workstations or PCs as client nodes
with the server. Contrast with closed registration.

options file. A file that contains processing options.

v dsm.opt

v TSM User Preferences file
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For the Macintosh client only: Identifies Tivoli Storage Manager servers to contact, specifies communication
methods, defines scheduling options, selects backup, archive, restore, and retrieve options.

v TSM System Preferences file

For the Macintosh client only: Contains stanzas describing Tivoli Storage Manager servers to contact for services.
These stanzas also specify communication methods, backup and archive options, and scheduling options.

owner. The owner of backup-archive files sent from a multi-user client node, such as AIX.

P
pattern-matching character. See wildcard character.

plug-in. A self-contained software component that modifies (adds or changes) function in a particular software
system. When you add a plug-in to a software system, the foundation of the original software system remains intact.

policy domain. A policy object that contains one or more policy sets. Client nodes are associated with a policy
domain. See policy set, management class, and copy group.

policy set. A policy object that contains a group of management class definitions that exist for a policy domain. At
any one time, there can be many policy sets within a policy domain, but only one policy set can be active. See active
policy set and management class.

progress indicator. A control used to inform a user about the progress of a process.

R
reboot. To restart the operating system.

registration. The process of identifying a client node or administrator to the server by specifying a user ID,
password, and contact information. For client nodes, a policy domain, compression status, and deletion privileges are
also specified.

restore. A function that permits users to copy a version of a backup file from the storage pool to a workstation or
file server. The backup copy in the storage pool is not affected. Contrast with backup.

retention. The amount of time, in days, that inactive backed up or archived files are retained in the storage pool
before they are deleted. The following copy group attributes define retention: retain extra versions, retain only
version, retain version.

retrieve. A function permitting users to copy an archived file from the storage pool to the workstation or file server.
The archive copy in the storage pool is not affected. Contrast with archive.

S
scheduling mode. The type of scheduling operation for the client-server node. Tivoli Storage Manager supports two
scheduling modes: client-polling and server-prompted.

scroll. Move through a list of items in a window by operating the scrollbars with the mouse cursor.

select. Choose an item from a list or group of items.

selective backup. A function permitting users to back up specified files. These files are not excluded in the
include-exclude list and meet the requirement for serialization in the backup copy group of the management class
assigned to each file. Contrast with incremental backup.

serialization. A copy group attribute that specifies whether a file can be modified during a backup or archive
operation. See static, dynamic, shared static, and shared dynamic.

server. A program running on a mainframe, workstation, or file server that provides shared services such as backup
and archive to other various (often remote) programs (called clients).
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server-prompted scheduling. A client-server communication technique where the server contacts the client node
when tasks need to be done.

session. A period of time in which a user can communicate with a server to perform backup, archive, restore, or
retrieve requests.

shared dynamic. A Tivoli Storage Manager copy group serialization mode. This mode specifies if a file changes
during backup or archive and continues to change after a number of retries. The last retry commits the file to the
Tivoli Storage Manager server whether or not the file changed during backup or archive. Contrast with dynamic,
shared static, and static.

shared static. A copy group serialization value specifying that a file must not be modified during a backup or
archive operation. Tivoli Storage Manager attempts to retry the operation a number of times. If the file is in use
during each attempt, the file is not backed up or archived. See serialization. Contrast with dynamic, shared dynamic, and
static.

share point. A drive or directory on Windows 2000, XP, and .NET whose files are available for shared access across
a network. The share point name is part of a UNC name. See Universal Naming Convention (UNC) name.

shift-click. Click on an item while pressing the Shift key.

space management. The process of keeping sufficient free storage space available on a local file system for new data
and making the most efficient and economical use of distributed storage resources.

stabilized file space. A file space that exists on the server but not on the client. This situation can arise in at least
two instances:
1. A drive is removed from a client workstation
2. A file space is renamed on the server

Stabilized file spaces remain on the server until deleted by the user or administrator. Files and directories can be
restored and retrieved from a stabilized file space. However, it is not possible to back up or archive data to a
stabilized file space.

stanza. In the AIX OS, a stanza is a group of lines in a file that together have a common function or define a part of
the system. The Tivoli Storage Manager Client System Options file (dsm.sys) contains a stanza for each server to
which the client can connect. Each stanza begins with the servername option and ends at the next servername option
or the end of file, whichever comes first. Each stanza must include communications options.

static. A copy group serialization value specifying that a file must not be modified during a backup or archive
operation. If the file is in use during the first attempt, Tivoli Storage Manager will not back up or archive the file. See
serialization. Contrast with dynamic, shared dynamic, and shared static.

storage pool. A named set of storage volumes used as the destination of backup, archive, or migrated copies.

T
TCA. Trusted Communications Agent

TCP/IP. Transmission Control Protocol/Internet Protocol.

timeout. A time event involving:
v An event that happens at the end of a predetermined period of time that began at the happening of another

specified event.
v A time interval allotted for certain operations to happen. For example, response to polling or addressing before

system operation is interrupted and must be restarted.
v A terminal feature that logs off a user if an entry is not made within a specified period of time.

Tivoli Storage Manager. A client-server licensed program product that provides storage management and data
access services to customers in a multivendor computer environment.

Transmission Control Protocol/Internet Protocol (TCP/IP). A standard set of communication protocols that supports
peer-to-peer connectivity of functions for both local and wide-area networks.
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TSM System Preferences file. An editable file that contains communication, authorization, central scheduling,
backup, and archive options.

TSM User Preferences file. A file, used on Macintosh clients, that contains processing options. A sample of this file
is provided during the initial installation and setup of Tivoli Storage Manager. A copy of the sample defaults file can
be created to set up precise processing options.

V
version. Storage management policy may allow back-level copies of backed up objects to be kept at the server
whenever an object is newly backed up. The most recent backed up copy is called the ″active″ version. Earlier copies
are ″inactive″ versions. The following backup copy group attributes define version criteria: versions data exists, and
versions data deleted.

W
wildcard character. An asterisk (*) or question mark (?) character used to represent multiple (*) or single (?)
characters when searching for various combinations of characters in alphanumeric and symbolic names.

windowed interface. A type of user interface that is either a graphical user interface or a text-based interface. The
text-based interface maintains a close affinity to the graphical user interface, including action bars and their
associated pull-down menus and windows. See graphical user interface.

workstation. A programmable high-level workstation (usually on a network) with its own processing hardware such
as a high-performance personal computer. In a local area network, a personal computer that acts as a single user or
client. A workstation can also be used as a server.

world wide name. A unique 48 or 64 bit number assigned by a recognized naming authority (often via block
assignment to a manufacturer) that identifies a connection or a set of connections to the network. Abbreviated WWN.
A WWN is assigned for the life of a connection (device). Most networking technologies (e.g., Ethernet, FDDI, etc.) use
a world wide name convention.
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Index

A
absolute mode 53
access privileges

file sharing 32
active files

displaying 34
archive

archiving files an directories 42
binding management class to 56
compressing files 74
copy mode 53
deleting 43
displaying processing status 42
estimating processing time 42
exclude objects from 81
grace period retention 50
hard links 41
how managed 42, 49
include files for 87
managing file growth during compression 73
maximum file size for 41
performing 42
purpose 25
regulate resources server and client use during

processing 109
retrieving 43
specifying number of attempts to archive open files 69
specifying whether to include subdirectories for 117
specifying whether to wait for tape to mount if it is

required 118
status window 42
summary of options 61
system administrator ID and password required 1

archive copy group 50
attributes 51

authorization
summary of options 64

authorizing
changing authorizations 38
users to restore or retrieve files 38

autofsrename option 67
automating backup services

options for 45
overview 45
process commands after back up 102
process commands before back up 104
start in standalone mode 45
starting in daemon mode 45

B
backup

active backup version 34
advanced considerations 31
binding management class to files 56
comparison: incremental, incremental-by-date 28
compressing files 74
copy mode 53
displaying processing status 31
estimating processing time 30

backup (continued)
exclude objects from 81
excluding domains 78
files, assigning management class 54
filtering files 31
fuzzy 53
grace period retention 50
hard links 30
how Tivoli Storage Manager manages 29
inactive backup version 34
include files for 87
include-exclude processing for 13
incremental

client domain 78
folders, overview 27

incremental-by-date 27
folders, processing overview 27

incremental, of a domain 31
incremental, specify memory-conserving algorithm for 95
managing 49
managing file growth during compression 73
maximum file size 30
new or changed files 26
opened files 32
overview 25, 26
planning 25
purpose 25
regulate resources server and client use during

processing 109
restore 33
running, by date 31
running, incremental 31
running, selective 31
searching files 31
selective

overview 28
specifying number of attempts to backup open files 69
specifying whether to include subdirectories for 117
specifying whether to wait for tape to mount if it is

required 118
summary of options 61
system administrator ID and password required 1
using include-exclude list 28
using multiple sessions 31
volume name 31

backup copy group 50
attributes 51

backup set
enabling GUI for local restore 35
enabling GUI for local restore of 91
restore 35

bottom up processing
include-exclude list 17

C
central scheduling

summary of options 63
changingretries option 69
client

registering with server 11
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client (continued)
setting password 11
specify size for the TCP/IP sliding window for client

node 122
client components 4
client options

exclude
exclude.archive 13
exclude.backup 13
exclude.dir 13
exclude.file 13
exclude.file.backup 13
exclude.fs 13

guitreeviewafterbackup 84
client scheduler

daemon mode 45
displaying completed work 46
options for 45
overview 45
standalone mode 46
start in standalone mode 45
starting automatically 22
starting in daemon mode 45

client-server communication
identify your workstation to the server 96
increased buffers to transfer large amounts of data 90
specify size for the TCP/IP sliding window for client

node 122
specifying default server 76
specifying method 70
specifying name of server to contact for services 116
specifying number of kilobytes client buffers before

sending transaction to server 124
specifying reconnection attempts after failure 71
specifying reconnection interval after failure 72
specifying size of internal TCP/IP communication

buffer 119
specifying TCP/IP address of Tivoli Storage Manager

server 121
client-server communicaton

specifying TCP/IP port address of Tivoli Storage Manager
server 120

closed registration
permissions 11
using 11

command line
displaying processing status 31
performing point-in-time restore 38

command processing, summary of options 64
commmethod option 70
commrestartduration option 71
commrestartinterval option 72
communication method

TCP/IP 4
communication methods

summary 59
compressalways option 73
compression option 74
compression processing 81, 87

excluding files from 81
include files for 87

configuring Tivoli Storage Manager
optional tasks 7
required tasks 7

copy destination attribute 53
copy frequency attribute 51
copy group name attribute 51

copy groups 49
archive 50
backup 50

copy mode attribute
absolute 53
modified 53

copy serialization attribute 52
copy type attribute 51
customer support

contacting xi

D
daemon mode

starting 45
using 45

date format
specifying 75

dateformat option 75
default

management class 49
policy domain 49

default domain
excluding domains from backup 78

default domain, setting 31
defaultserver option 76
deleting

authorizations 38
restore/retrieve volumes 39

desktop
overlapping objects 40
rebuilding 40

directories
assigning management class for 77
excluding from backup processing 81

dirmc option 77
disaster recovery 39
disk space requirements 4
disk, restoring 39
displaying

active backup versions 34
archive processing status 42
inactive backup versions 34
online help 23

domain
include for incremental backup 78

domain option 78
dsmsched.log file 46
dynamic and shared serialization 52

E
environment prerequisites

Macintosh client 4
error log

pruning 80
specifying path and file name 79

error processing, summary of options 65
errorlogname option 79
errorlogretention option 80
estimate function

for archive processing 42
for backup/restore processing 30

exclude options 81
exclude.archive 13
exclude.backup 13
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exclude options (continued)
exclude.dir 13
exclude.file 13
exclude.file.backup 13
exclude.fs 13
processing 17
wildcard characters 15, 16

excluding files
system files 15
using wildcard characters 16
wildcard characters 15

F
file sharing

access privileges 32
file space

names 31
file spaces

excluding from backup processing 81
file systems

supported 29
files

archive, deleting 43
archive, how managed 42
archive, retrieving 43
archiving 42
backing up changed 26
backing up hard-linked 30
backing up new 26
backing up open 32
backup, how managed 29
binding management classes to 56
compressing during archive or backup 74
creating multiple User Preferences files 19
definition of changed 26
excluding groups 15, 16
include-exclude

creating in Unicode format 13, 85
include-exclude, creating 13, 85
including groups 15, 16
managing growth during compression 73
maximum file size for archive and retrieve 41
maximum file size for backup and restore 30
maximum length of file names 10
overlapping 40
processing include-exclude 17
renaming file spaces that are not Unicode to Unicode

enabled 67
restore, point-in-time 37
restoring

another user’s 38
to another workstation 39

restoring hard-linked 30
retrieving

another user’s 38
to another workstation 39

selecting-deselecting all 23
sorting lists 23

filtering
files for backup 31
files for restore 35

firewall
establishing communications through 120

folders
incremental backup processing overview 27
processing during incremental-by-date 27

format and language
summary of options 64

full incremental
comparing with incremental-by-date 28
description 26
when to use 28

fuzzy backup 53

G
graphical user interface

changing password 22
displaying active and inactive files 23
displaying online help 23
displaying processing status 31
enabling for local backup set restore 91
enabling local backup set 35
ending a session 23
starting a session 21
using to sort file lists 23

GUI
ending a session 23
performing point-in-time restore 37
starting a session 21

guitreeviewafterbackup option 84

H
hard links

archive and retrieve 41
backing up 30
restoring 30

hardware requirements 4
help

displaying online 23
online forum 23
service and technical support 23

I
inactive files

displaying 34
inclexcl option 85
include option

management class 54
processing 17
wildcard characters 15, 16

include options 87
include-exclude list

creating 11
overview 28
size restriction 15, 17

include-exclude options file
specifying path and file name of 85
Unicode-enabled file spaces 85
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overview 13
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by date, running 31
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overview 26
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incremental backup (continued)
running 31
selective, running 31
specify memory-conserving algorithm for 95
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description 27
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processing overview 27
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installation requirements
Macintosh client 4

J
Java GUI

configuration restrictions 22

L
language option 89
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specifying whether to update during backup or
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local backup set
enabling GUI for local restore 35

localbackupset option 91
long file name support 10

M
Macintosh client
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disk space requirements 4
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hardware requirements 4
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operating system requirements 4
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management classes
assigning to directories 77
assigning to files 54
assigning to folders 55
binding to files 56
default 49
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how Tivoli Storage Manager uses 29, 42
overriding for archived files 55
overriding the default 54
processing 54
questions to consider 54
selecting for files 54
selecting for folders 55
specifying with include option 54
using management class, example 54

matchallchar option 92
matchonechar option 93
maxcmdretries option 94
memory requirements 4
memoryefficientbackup option 95

messages
displaying on screen 125
specifying language type 89
stop displaying 107

migrating from earlier versions of the product 1
migrating to Unicode 1
migration 1
modified mode 53
multiple sessions

backup objects, using 31

N
no query restore 33
node option, summary 60
nodename option 39, 96
number format

specifying 97
numberformat option 97

O
online help

displaying 23
online forum 23
service and technical support 23

online Help forum 23
open file, backing up 32
open registration

permissions 11
using 11

operating system requirements 4
options

archive, summary 61
authorization, summary 64
autofsrename 67
backup, summary 61
central scheduling, summary 63
changingretries 69
command processing, summary 64
commmethod 70
commrestartduration 71
commrestartinterval 72
communication, summary 59
compressalways 73
compression 74
dateformat 75
defaultserver 76
dirmc 77
domain 78
errorlogname 79
errorlogretention 80
exclude

exclude.archive 13, 81
exclude.backup 13, 81
exclude.dir 13, 81
exclude.file 13, 81
exclude.file.backup 13, 81
exclude.fs 13, 81

format and language, summary 64
guitreeviewafterbackup 84
inclexcl 85
include 87

management class, specifying 54
include.archive 87
include.backup 87
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options (continued)
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maxcmdretries 94
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nodename 96
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password 98
passwordaccess 99
passworddir 101
postnschedulecmd 102
postschedulecmd 102
prenschedulecmd 104
preschedulecmd 104
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quiet 107
replace 108
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restore and retrieve, summary 63
retryperiod 111
schedcmddisabled 112
schedcompleteaction 113
schedlogname 114
schedlogretention 115
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tapeprompt 118
tcpbuffsize 119
tcpport 120
tcpserveraddress 121
tcpwindowsize 122
timeformat 123
transaction processing, summary 65
txnbytelimit 124
verbose 125
virtualnodename 126
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P
parameters

yes and no, alternatives 66
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overview 26
types 26

password
changing 22
number of characters 22
setting 98
setting for client 11
specifying directory location to store encrypted password

file 101
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prompt 99
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password option 98
passwordaccess option 99
passworddir option 101
performance

transaction options 65
transaction processing 124

point-in-time restore 37
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policy sets
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portable media
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Preferences editor
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Preferences file

maximum file length 10
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setting domain option 31
setting options 10
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processing options
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backup and archive 61
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node option 60
restore and retrieve 63
setting 10
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archive 42

processing time
estimating for archive 42

Q
query
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quiet option 107

R
rebinding files to a different management class 56
rebuilding the desktop 40
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client with server 11
using closed registration 11
using open registration 11

replace option 108
resourceutilization option 109
restartable restore 33
restore

active backup version 34
advanced considerations 38
another user’s files 38
authorizing another user 38
backup sets

from local device 35
from server 35
overview 35

deleting restore/retrieve volumes 39
desktop objects overlapping 40
disk 39
filtering files 35
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restore (continued)
from portable media

overview 35
Get Info 40
hard links 30
inactive backup version 34
local backup set via GUI 35, 91
maximum file size 30
no query 33
overview 33
point-in-time 37
point-in-time, using command line 38
point-in-time, using GUI 37
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processing 109
running 35
searching files 35
specifying whether to include subdirectories for 117
specifying whether to prompt before overwriting existing

files 108
specifying whether to wait for tape to mount if it is

required 118
summary of options 63
system administrator ID and password required 1
to another workstation 39
to different workstation 126

restore/retrieve volumes
deleting 39

retain extra versions attribute 52
retain only versions attribute 52
retain versions attribute 54
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archive 50, 56
backup 50, 56

retrieve
another user’s files 38
authorizing another user 38
deleting restore/retrieve volumes 39
hard links 41
maximum file size for 41
performing 43
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files 108
specifying whether to wait for tape to mount if it is

required 118
summary of options 63
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S
schedcmddisabled option 112
schedcompleteaction option 113
schedlogname option 114
schedlogretention option 115
schedule log

specifying number of days to keep entries and whether to
save pruned entries 115

specifying path and file name to store schedule log
information 114

scheduled (automated) backups
options for 45
overview 45

scheduled (automated) backups (continued)
process commands after back up 102
process commands before back up 104
start in daemon mode 45
start in standalone mode 45

scheduled services
disabling scheduled commands 112
displaying completed work 46

scheduler
options for 45
overview 45
specifying an action to take when a schedule

completes 113
specifying number of hours between contacts to server for

scheduled work 106
specifying number of minutes between attempts to process

scheduled commands 111
start in standalone mode 45
starting in daemon mode 45

scheduler information
completed work 46
scheduled work 46

scheduler log
log file 46
schedlogname option 46
schedlogretention option 46
understanding the 46

searching
files for backup 31
files for restore 35

selective backup
overview 28
running 31

serialization
copy serialization

dynamic 52
shared static 52
static 52

server
identify to begin a stanza containing options for 116
specifying name of server to contact for services 116
specifying TCP/IP address of Tivoli Storage Manager

server 121
specifying TCP/IP port address for 120

server and node options
summary 60

servername option 116
service and technical support 23
shared dynamic serialization 52, 69
shared static serialization 52, 69
software requirements 4
sorting

lists of files 23
standalone mode

running 46
starting 46

standard management class
copy destination 53
copy frequency 51
copy group name 51
copy mode

absolute 53
modified 53

copy serialization 52
copy type 51
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retain extra versions 52
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standard management class (continued)
retain only version 52
retain versions 54
versions data deleted

active versions 52
inactive versions 52

versions data exists 52
standard policy domain 49
starting

automatically 22
static serialization 52
static, shared serialization 52
storage management policies 49

copy groups 49
default management class 49
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management classes 49
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default 49
standard 49

policy sets
active policy set 49

subdir option 117
system administrator ID and password
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system files

excluding, recommended 15
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tapeprompt option 118
TCP/IP communication method

options 60
tcpbuffsize option 119
tcpserveraddress option 121
tcpwindowsize option 122
time format

specifying 123
timeformat option 123
Tivoli products and documentation

feedback survey xi
ordering xi
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client components 4
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configuring 7
disk space requirements 4
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hardware requirements 4
installation requirements 4
introducing 1
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overview 1
running
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transaction processing 124
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maximuml length of file names in 10

TSM System Preferences file (continued)
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specifying include-exclude options 11

TSM System Preferences-Sample file
copying to TSM System Preferences 7

TSM User Preferences file
creating and modifying 8
creating multiple 19
default location of 8, 30
maximum length of path and file names in 10
maximuml length of file names in 10
options for 8
quiet 107
required options for 8

TSM User Preferences-Sample file
copying to TSM User Preferences 8

txnbytelimit option 124

U
Unicode 1

renaming file spaces that are not Unicode to Unicode
enabled 67

Unicode migration 1

V
verbose option 125
versions data
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view menu, to sort file lists 23
virtualnodename option 126
volume label

duplicate names 32
volume name 31
volume naming precautions 32

W
wildcard characters
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matchonechar option 93
to include or exclude groups of files 16
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